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Preface

Safety first! Before you attempt to use your MTS equipment in your test system,
read and understand the Safety manual. Like an automobile, your test
system is very useful—but if misused, it is capable of deadly force. You
should not be afraid of your test system, but you should always
maintain a healthy respect for it.

Improper installation, operation, or maintenance of MTS equipment in
your test system can result in hazardous conditions that can cause
severe personal injury or death, and damage to your equipment and
specimen. Again, read and understand the Safety manual before you
continue. It is very important that you remain aware of hazards that
apply to your test system.

Contents  About Your Manuals 10
Conventions 12

Technical Support 14
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About Your Manuals

About Your Manuals

10

Preface

Summary

This manual provides detailed information about the installation,
cabling, and set-up of the MTS FlexTest SE Controller, including all
controller, computer (optional), sensor, I/O, and hydraulic
connections. This manual also provides basic information about
calibrating sensor/conditioner pairs, initial system tuning, and adjusting
servovalves.

This manual includes the following chapters.

Chapter 1, “Introduction”—This chapter introduces a MTS FlexTest SE
Controller, and includes a table of the basic specifications of the
controller and the associated electronic components.

Chapter 2, “Installation”—This chapter covers the installation of the
MTS FlexTest SE Controller, including connections and mounting.

Chapter 3, “Cabling”—This chapter contains detailed cabling
information, including pin-out assignments of all the connectors.

Chapter 4, “Servovalve Controls"—This chapter describes servovalve
adjustments to optimize the interface between the controller and the
servovalve.

Chapter 5, “Sensors”—This chapter describes sensor signals,
connections, and cabling. Shunt calibration for DC sensors is also
described.

Chapter 6, “Calibration”—This chapter describes how to calibrate the
sensors connected to your system.

Chapter 7, “Tuning”—This chapter describes system tuning basics.

Appendix A, “Hydraulic Configurations"—This appendix describes
how to connect the Model 493.02 Chassis to a variety of MTS hydraulic
configurations.

Appendix B, “Model 493.07 HPU Converter’—This appendix describes
the Model 493.07 HPU Converter including connectors and jumper
configurations.

Appendix C, “Service Tools”—This appendix describes the FlexTest SE
Service Tools application.
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About Your Manuals

Access the If you have a PC-supervised Controller, you can access an electronic
electronic manual  version of this manual (after you install your MTS software) from the
PC desktop, as follows:

iﬂﬁlartl Programs > FlexTest SE > Online Documentation

If you have a stand-alone Controller, an electronic version of this
manual is available on the 793 System Software CD that accompanies
your Controller.

Other MTS manuals  If your purchase includes other MTS equipment, you will receive
additional MTS manuals in paper or electronic form.

If you have purchased a test system, it may include an M7S System
Documentation CD. This CD contains an electronic copy of all of the
MTS manuals that pertain to your test system, including controller
manuals, hydraulic and mechanical component manuals, assembly
drawings and parts lists, and operation and preventive maintenance
manuals.
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Conventions

Conventions

The following paragraphs describe some of the conventions that are
used in your MTS manuals.

Hazard conventions  Hazard notices are embedded in this manual and contain safety
information that is specific to the task to be performed. Hazard notices
immediately precede the step or procedure that may lead to an
associated hazard. Read all hazard notices carefully and follow the
directions that are given. Three different levels of hazard notices may
appear in your manuals. Following are examples of all three levels.

Note  For general safety information, see the Safety manual included with
your system.

Danger notices Danger notices indicate the presence of a hazard which will cause
severe personal injury, death, or substantial property damage if the
danger is ignored. For example:

A DANGER High intensity light and dangerous radiation are emitted by class 3B

lasers.

Viewing a class 3b laser directly or viewing it using optical instruments
will cause immediate and severe injury.

Avoid eye or skin exposure to the laser beam. Ensure that all power to the
laser is off before attempting any maintenance, service, or adjustment
procedure.

Warning notices ~ Warning notices indicate the presence of a hazard which can cause
severe personal injury, death, or substantial property damage if the
warning is ignored. For example:

A WARNING Hazardous fumes can accumulate in the test chamber as a result of
testing.
Breathing hazardous fumes can cause nausea, fainting, or death.
Ensure the chamber is properly ventilated before you open the chamber door
or put your head or hands into the chamber. To do this, ensure the

temperature controller is off and allow sufficient time for the ventilation
system to completely exchange the atmosphere within the chamber.

12 Preface Model 493.02 Controller Service



Caution notices

A CAUTION

Other conventions

Notes

Special terms

[llustrations

Electronic manual
conventions

Hypertext links

Conventions

Caution notices indicate the presence of a hazard which will or can
cause minor personal injury, cause minor equipment damage, or
endanger test integrity if the caution is ignored. For example:

This specimen can develop sharp edges as a result of testing.

Handling the specimen with unprotected hands can result in cuts and
slivers.

Always wear protective gloves when you handle the specimen.

Other conventions used in your manuals are described below:

Notes provide additional information about operating your system or
highlight easily overlooked items. For example:

Note  Resources that are put back on the hardware lists show up at the
end of the list.

The first occurrence of special terms is shown in italics.

Mlustrations appear in this manual to clarify text. It is important for you
to be aware that these illustrations are examples only and do not
necessarily represent your actual system configuration, test application,
or software.

This manual is available as an electronic document in the Portable
Document File (PDF) format. It can be viewed on any computer that
has Adobe Acrobat Reader installed.

The electronic document has many hypertext links displayed in a blue
font. All blue words in the body text, along with all contents entries
and index page numbers are hypertext links. When you click a
hypertext link, the application jumps to the corresponding topic.
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Technical Support

Technical Support

Start with your
manuals

Technical support
numbers

MTS web site
Www.mts.com

E-mail:

Telephone

Fax

Before you
contact MTS

Know your site number

14

and system number

Preface

The manuals supplied by MTS provide most of the information you
will need to use and maintain your equipment. If your equipment
includes MTS software, you should look for README files for
additional product information.

If you cannot find answers to your technical questions from these
sources, you can use the internet, telephone, or fax to contact MTS for
assistance. You can also fill out the Problem Submittal Form that is
available on the MTS web site and in the back of many MTS manuals
that are distributed in paper form.

MTS provides a full range of support services after your system is
installed. If you have any questions about a system or product, contact
MTS in one of the following ways.

The MTS web site gives you access to our technical support staff by
means of a Problem Submittal Form and a Technical Support link.

e  Problem Submittal Form:
www.mts.com > Contact MTS > Problem Submittal Form

e  Technical Support:
www.mts.com > Contact MTS > Technical Support

info@mts.com

HELPLine 800-328-2255
Weekdays 7:00 A.M. to 6:00 P.M.,
Central Time

952-937-4515

Please include an MTS contact name if possible.

MTS can help you more efficiently if you have the following
information available when you contact us for support.

The site number contains your company number and identifies your
equipment type (material testing, simulation, and so forth). The
number is usually written on a label on your MTS equipment before
the system leaves MTS. If you do not have or do not know your MTS
site number, contact your MTS sales engineer.

Model 493.02 Controller Service



Know information from
prior technical
assistance

Identify the problem

Know relevant computer
information

Technical Support

Example site number: 571167

When you have more than one MTS system, the system number
identifies which system you are calling about. You can find your job
number in the papers sent to you when you ordered your system.

Example system number: US1.42460

If you have contacted MTS about this problem before, we can recall
your file. You will need to tell us the:

e MTS notification number
e Name of the person who helped you

Describe the problem you are experiencing and know the answers to
the following questions.

e How long has the problem been occurring?
e Can you reproduce the problem?

e Were any hardware or software changes made to the system
before the problem started?

e What are the model and serial numbers of the suspect equipment?

If you are experiencing a computer problem, have the following
information available.

e  Manufacturer’s name and model number

e  Operating software type and service patch information. Examples:
—  Windows XP Service Pack 1 (SP1)
—  Windows 2000 Service Pack 3 (SP3)
—  Windows NT 4.0 Service Pack 7 (SP7)

e Amount of system memory. Example: 640 MB of RAM.

e Amount of free space on the hard drive in which the application
resides. Example: 11.2 GB free space, or 72% free space.

e Current status of hard-drive fragmentation. Example: 3% total
fragmentation.
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Technical Support

Know relevant software
information

If you contact MTS
by phone

|dentify system type

Be prepared to
troubleshoot

16 Preface

For MTS software application problems, have the following
information available.

e The software application’s name, version number, build number,
and if available, software patch number. This information is
displayed briefly when you launch the application, and can
typically be found in the “About” selection in the “Help” menu.

Example: Station Manager, Version 3.3A, Build 1190, Patch 4

e The same information for other MTS software included with your
system

e Names of other non-MTS applications that are running on your
computer, such as screen savers, keyboard enhancers, print
spoolers, and so forth

Your call will be registered by a HELPLine agent if you are calling
within the United States or Canada. Before connecting you with a
technical support specialist, your agent will ask you for your site
number, name, company, company address, and the phone number
where you can normally be reached.

To assist your HELPLine agent with connecting you to the most
qualified technical support specialist available, identify your system as
one of the following types:

e  Electromechanical materials test system

e  Hydromechanical materials test system

e Vehicles test system

e Vehicles component test system

e Aero test system

Prepare yourself for troubleshooting while on the phone.

e (Call from a telephone close to the system so that you can try
implementing suggestions made over the phone.

e Have the original operating and application software media
available.

e If you are not familiar with all aspects of the equipment operation,
have an experienced user nearby to assist you.
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Technical Support

Write down relevant Prepare yourself in case we need to call you back.

information ]
e Remember to ask for the notification number.
e  Record the name of the person who helped you.
e Write down any specific instructions to be followed, such as data
recording or performance monitoring.
After you call MTS logs and tracks all calls to ensure that you receive assistance and

that action is taken regarding your problem or request. If you have
questions about the status of your problem or have additional
information to report, please contact MTS again.

Problem Submittal In addition to the Problem Submittal Form on the MTS web site, there
Form in MTS manuals s also a paper version of this form (postage paid) in the back of many
MTS manuals. Use this form to forward problems you are experiencing
with your MTS equipment, whether it be software, hardware, manuals,
or service. This form includes check boxes that allow you to select
when you expect us to respond to your input. We guarantee a timely
response—your feedback is important to us.
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Technical Support
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Chapter 1

Introduction

Overview  This chapter provides an overview of the MTS Model 493.02 FlexTest
SE Controller. It describes the basic functions and components
included in the Controller’s standard and automated configurations,
and includes a table of specifications.

Contents  Stand-Alone Configuration 20
Basic Functions 22

Automated Configuration 23
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Stand-Alone Configuration

Stand-Alone Configuration

The Controller is a fully digital, single-channel, Proportional, Integral,
Derivative, Feedforward (PIDF) servocontroller. It provides complete
control of one servohydraulic channel or station in an MTS test system.

Front Panel  Operations are controlled through the Controller’s front panel. An
easy-to-read color display shows the status of the parameter currently
being adjusted or monitored. A simple scroll-through menu provides
quick access to any parameter or function. All parameters are entered
through a keypad or adjusted by a single multi-turn knob. The current
settings are saved in a flash disk and are automatically recalled at start
up.

In addition to providing the means to adjust and monitor the test
parameters, the front panel also provides program control, system
hydraulic pressure control, and an Emergency Stop button that shuts
down the system hydraulics in an emergency situation. BNC monitor
connectors are also provided to allow you to connect easily to external
readout devices.
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Stand-Alone Configuration

Back Panel Except for two front panel BNC connectors, all cabling is accessed
through the Controller’s back panel. It is not necessary to remove the
chassis cover to access jumpers or switches.
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Plug-In Modules In the standard configuration, the Controller’s VME chassis contains
three plug-in modules:

e A Model 498.96-4 Processor
e A Model 493.40 I/O Carrier module

e A Model 493.42 System I/O Module
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Stand-Alone Configuration

Basic Functions

Interlocks The Controller provides interlocks for adjustable upper/lower limit,
underpeak, error detection for each sensor conditioner installed, and
others. These interlocks can be daisy-chained for multiple controller
configurations.

Function Generation A function generator (with a built-in cycle counter) in the Controller
provides basic sine, square, triangle, and ramp command waveforms.

For tests requiring complex waveforms, the Controller provides an
external command input to receive externally generated commands.

The function generator waveform can be output to another MTS
FlexTest SE Controller (or any external device) for synchronization.

Hydraulic Pressure The Controller provides complete control of the test system hydraulics.
Control It can be used to control a hydraulic power supply and a hydraulic
service manifold to apply low and high hydraulic pressure to the test
system. In multiple Controller configurations, the Controller provides
first-on/last-off control of the hydraulic power supply in addition to
control of a local hydraulic service manifold.
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Automated Configuration

Automated Configuration

Automated
procedures

Model 793.00 System
software

In the automated configuration, the Controller has added capabilities—
it can acquire data, perform automated testing, apply complex control
compensation techniques to the servoloop, and execute sophisticated
test procedures that include complex triggering mechanisms.

The automated configuration includes the Controller, a personal
computer, and the Model 793.00 System Software bundle. It may also
include optional MTS software for additional capability.

The “Automated” paths and procedures described in this manual
assume the FlexTest SE Controller is equipped with the PC-Supervision
option, and that Exclusive Control is assigned to Station Manager. For
more information about Station Manager, see the Model 793.00 System
Software manual that accompanies your system.

The Model 793.00 System Software bundle consists of the following
standard applications:

e Station Builder"—This application allows you to allocate
controller resources, such as valve drivers and conditioners, to
create station configuration files.

e Station Manager —This application works with the Controller to
maintain station servo control, and allows you to perform typical
test operations, such as:

—  Monitor station interlocks and control hydraulic or
electromechanical station power.

—  Optimize and monitor the various analog and digital signals
sent to and from your controller.

—  Run, hold, and stop tests.

—  Create parameter sets that define the operational
characteristics, such as sensor ranges and conditioner gains,
of the station resources in your station configuration files.

e Basic TestWare®—This application allows you to create simple
monotonic and cyclic tests and to acquire data.

e Station Desktop Organizer— This utility allows you to manage
the windows and displays associated with Series 793 software
applications.

Model 493.02 Controller Service Introduction 23
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Automated Configuration

Series 793 software The following products are available as options with the Model 793.00
options  System Software bundle:

e Model 793.10 MultiPurpose TestWare® (MPT)—A sophisticated
test design application. This application allows you to build test
procedures by defining and linking modular test activities together
and assigning triggering relationships between each activity.

e Model 793.11 Profile Editor —A sophisticated arbitrary
waveform design application. This application allows you to
create arbitrary waveforms that can be played-out with the
MultiPurpose TestWare application.

Rack mounting  The Controller can be mounted in an equipment rack. When doing so
requirements  allow a minimum of 2 in. (5.1 cm) on either side of the Controller for
air flow. There are no spacing requirements for the top or bottom of
the Controller. If the equipment rack is equipped with doors, allow
adequate clearance for the front and rear of the Controller. The rear of
the Controller requires a minimum clearance of 6 in. (15.24 cm) to
accommodate cables.
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Chapter 2

Installation

This section describes how to install the MTS FlexTest SE Chassis and
connect it to your SYStCl’l’l components.
Contents Installing the Plug-in Modules 26
VMEbus Modules 27
Chassis Installation Options 30
Connecting Electrical Power 32

Handle Kit Installation 36
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Installing the Plug-in Modules

Installing the Plug-in Modules

This section describes how to install the plug-in modules into the
chassis. The modules plug into a backplane connector and are secured
to the chassis with a screw at the top and at the bottom of the module
faceplate.

A\ CAUTION The plug-in modules contain static-sensitive components.

Improper handling of the module can cause component damage.
Be sure to follow these precautions when handling modules:
e Turn off electrical power before installing or removing a module.

e Use a static ground strap to ground yourself to the chassis
ground before touching the chassis or a module.

e Keep unused modules in conductive bags. Also be sure you are
grounded when removing a module from a conductive bag.

e Handle modules with their front panel or circuit card edges. Do
not touch any circuit card components, pins, or circuit connection
points.

____________________________________________________________________________________________|
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Installing the Plug-in Modules

VMEbus Modules

The VMEbus compatible modules should be installed in chassis slots
according to the following guidelines.

e The processor module is installed in slot 1
e The I/O carrier module is installed in slot 2.

e The System I/O module is installed in slots 4 and 5.
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Installing the Plug-in Modules

VMEbus Modules

SLot MobuLE NAME FuncTioN

Slot 1 PowerPC® Provides PIDF processing for the Controller and management
of the other plug-in modules in the stand-alone configuration.
Provides an interface between the Controller and an external
computer in the automated configuration.

Slot 2 Model 493. 40 I/0 Carrier Supports up to four daughter boards that can be used for
sensor conditioning, driving a servovalve, and in the
automated configuration, providing A/D and/or D/A channels.

Slot 3 Blank in standard Addition carrier chassis that can house up to four daughter

configurations. boards for expanded sensor conditioning and A/D and D/A
channels

May be used for additional

Model 493.40 I/0 Carrier Note This is not a stnadard option. It is available only for

(factory installed option for PC-supervised systems and must be configured at

PC-supervised systems) the factory. For more information, contact MTS.

Slots 4,5 Model 493.42 System 1/0 Provides box-in and box-out connections for daisy chaining
multiple Controllers, analog and digital /O, E-Stop, and HSM
and HPU control.

Model 493.40 I/0 Carrier Daughter Boards (part 1 of 2)
MODEL MobDuULE NAME FUNCTION

493.14 Valve Driver Produces the control signal for a Series 252 Servovalve.

493.15 3-Stage Valve Driver Produces the control signal for a Series 256 or 257
Servovalve.

493.25 Universal Conditioner Processes the signals from either an AC or DC-type sensors.

493.45 A/D Converts up to six external analog signals to digital signals for
use by the controller.

493.46 D/A Converts up to six internal digital signals to analog signals for

use by external devices.

28
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Installing the Plug-in Modules

Model 493.40 I/0 Carrier Daughter Boards (part 2 of 2)

MODEL MobuLE NAME FUuNCTION

493.47 Encoder Processes the signals from an encoder or a Temposonics |1l
transducer with an SS| interface.

493.48 Acceleration Conditioner Processes the signals from an accelerometer. Each
Acceleration Conditioner daughter board can support up to
three accelerometers. Before installing this board, specific
jumpers must be set on the I/O Carrier module. See
“Accelerometer Connections” on page 55 for more
information on jumper settings.
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Chassis Installation Options

Chassis Installation Options

The chassis can be fitted with the optional handle kit for table-top use
in the stand-alone configuration (shown below) and the automated
configuration, and it can be installed without the handle-kit in a
standard MTS equipment rack.
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Console installation The rack-mounted chassis can be installed in any Model 490.8x
console. Install the console with the FlexTest SE Rack Mounting kit

(part number 100-063-209).
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Chassis Installation Options

The Rack Mounting kit provides the hardware (L-shaped brackets) to
support the chassis and mounting screws to secure the chassis to the
console rack.

Rack Mount Option

The Controller chassis is
designed to fit into a standard
electronics rack.
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Chassis Installation Options

Connecting Electrical Power

Electrical connections must be made by qualified personnel and
conform to local codes and regulations. An electrical service panel to
provide the electrical power feed (line voltage) to the chassis is not
necessary, but may be required by local electrical codes.

Note Local electrical codes supersede any information found here.

Grounding  The chassis will not function correctly if it is NLAA
not grounded as shown. Be sure your 5 @l ==
power source is also properly grounded. v el
The chassis includes two grounds: a chassis
ground and a signal ground. The two
grounding lugs are connected together with
an external shorting bar when the chassis is manufactured.

Signal Chassis
Ground  Ground

e  For the console configuration, remove the shorting bar from the
ground lugs and connect the chassis ground to the console rail.

e For a stand-alone configuration, always connect the shorting bar
to both ground lugs.

Grounding the Chassis

@
®
®
® o 2
® o
[ MO e

System ground cable
(P/N377661-02)

connected to other ~——» O
components.

Chassis ground is

connected through the
power cord connector. :H
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Chassis Installation Options

Rack Mount Configuration

Chassis ground cable
(P/N 377661-02) connecte
to the vertical conductive
rail.

Signal common cable
(P/N 377661-01) connected -

to the power panel. g@ @

System ground cable o
(P/N 054023-xx) connected
to the test frame or other———® O

components. T =

The AC power ground is through the power cord. The power cord
must be plugged into both the chassis and the power source for proper
grounding.

____________________________________________________________________________________________|
A CAUTION Proper grounding is required for safe operation.

It is also required to meet EMC emission and susceptibility requirements.
. ________________________________________________________________________________________]

Power  All equipment related to the chassis should be connected on the same
fused power circuit.

e The power supply can accept single-phase voltages within 90-264
V AC at frequencies between 47-63 Hz.

e The maximum continuous power usage is approximately 300 W.
The current draw depends on the local voltage supply. A 15 amp
line will be adequate for the chassis and the computer.
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Chassis Installation Options

e The power supply automatically selects the proper voltage range
and line frequency.

e The power supply is protected with an external circuit breaker in
the On/Off switch that trips at a 5 ampere overload. An internal
fuse in the power supply is not user accessible or repairable.

AC power disconnect  Turn off the AC power switch. Remove the AC power cord from the
unit. This will remove all AC power from the 493.02 chassis.

Note Be sure to locate the chassis so you have adequate access to
disconnect the power cord from the chassis.

Stand-Alone Configuration

:

4 | gL

oI |

E Line
- Voltage
Outlet Strip
w/ circuit breaker

Automated Configuration

[T JTO"E JH%@U’@ = ’
=1
i»/\ A o e
Voltage
Outlet Strip Outlet Strip
(printer, etc) wy/ circuit breaker

=
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Chassis Installation Options

Rack Mounted Configuration

Outlet Strip

o}
vertical outlet strip

Power Panel -

uonejjelsu|
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Handle Kit Installation

Handle Kit Installation

The Controller may be equipped with an optional handle kit.

The following procedure provides assembly and installation
instructions for the handle kit (MTS part number 100-061-494). The
following table and figure show the handle kit assembly components
described in the procedure.

Handle Kit Parts

ITEM DESCRIPTION QUANTITY
1 Support arm 2
2 Handle side leg 2
3 Clip 2
4 Washer 4
5 Screw 2
6 Spring 2
7 Button 2
8 Ratchet 2
9 Ratchet housing 2
10 Lock washer 2
1" Handle screw 2
12 Handle 1
13 Cover 2

=
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Handle Kit Installation

12 (handle-not shown)

Handle Kit

1. Place one support arm (1) into one handle side leg (2), as shown
in the handle kit assembly figure.

2. Set one of the clips (3) in place over the slender, straight portion
of the support arm (1), just behind the circular end of the support
arm.

3. Insert two washers (4) and a screw (5) through the mounting hole
in the handle side leg (2).

4. Insert a spring (6) and a button (7) into the handle side leg
mounting hole, over the screw (5) and washers (4).

5. Press the button (7) into the handle side leg, as far as you can and
push a ratchet (8) over the button (7) leg detentes, until it snaps
into place over the first set of detentes. Make certain the burred or
sharper edges of the ratchet are pointing toward the handle side
leg.

S
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Handle Kit Installation

38

10.

11.

12.

Hold a ratchet housing (9) in place over the ratchet (8) and press
the posts on the back side of the ratchet housing (9) into the
mounting holes on the side panel of the Controller.

Insert a Phillips screwdriver through the hole in the button (7) and
lightly tighten the screw (5).

Assemble the remaining handle kit components to the other
handle side leg (2) according to steps 1 through 7 and mount the
side leg to the mounting holes on the opposite side of the
Controller.

Insert a lock washer (10) and handle screw (11) through the
mounting hole at the end of one handle side leg (2) and lightly
tighten to handle (12). Repeat this step for the other handle side
leg, then secure both screws (11). (The mounting screw for the
first handle side leg may have to be loosened slightly to allow the
second handle side leg to be mounted.)

Snap cover (13) in place over the handle screw (11) and lock
washer (10).

Secure mounting screws (5) on each side of the Controller.

Press in both buttons (7) and rotate the handle assembly. The
assembly should rotate up and down easily. When the buttons (7)
are released, the handle should lock into a detente position and
remain there. If the handle does not move easily, or if it does not
lock into a detente position, an error may have been made during
the assembly. Take a small straight blade screw driver and
carefully remove the covers (13), loosen all screws and remove
the handle assembly from the Controller. Reassemble the handle
side leg assemblies according to steps 1 through 7.

Model 493.02 Controller Service



Chapter 3

Cabling

This section describes the cable connections to the MTS FlexTest SE
Chassis.

Note fFor information on connecting power cables, see “Connecting
Electrical Power” on page 32.
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CE EMC Compliant Cabling

CE EMC Compliant Cabling

CE EMC compliant cabling is required for all systems shipped to
Europe. All cabling specifications in this chapter conform to the
European CE EMC requirements.

Cable fabrication  All of the cables listed on the Cable Selector drawing are CE EMC
compliant when used in an MTS system. Where possible, use standard
cables listed on the System Cable/Jumper Plug 493 Package Selection
drawing (PN 700-000-656). If it is not possible to use standard cables or
you are constructing custom cables, select cables, backshells, and
connection shields as described in the cable specification for each
connector. See the appropriate rear panel connector for fabrication
information.

Low-frequency 1t is possible that grounding both ends of the overall shield can
ground loops  produce a low frequency ground loop current. If you experience an
unacceptable low-frequency noise level, try the following in the order
given:

e  Connect the system (chassis) ground of the external device
directly to the controller chassis.

e Disconnect the overall shield from the metallized back shell at the
external device and add a capacitor (approximately 0.01 pf) to
that end of the cable between the shield and the metallized
backshell .*

e Disconnect the overall shield from the metallized back shell at the
external device.*

* This action may compromise EC EMC compliance.
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CE EMC Compliant Cabling

Stand-Alone Cabling Overview

=

Force Sensor
525442-xx Actuator
Manifold
(HSM)
561264-xx
o
Servovalve .
397083-xx
LVDT|  464403-xx Intlk
Jumper Plug
100-057-245 HPU
- 397137-xx
E-Stop
Jumper Plug
Box out | 100-007-947
Jumper Plug -
100-057-246
® L F 5 ®
. e idp {r D) /o :
B .
® = , & y L g Qa
. P i) e
© £ g O o c ® . ®
me>—ou o\ AN
® e o | @ ((\‘\@ =
@ 100-240 VAC
® 500 p 50-60 Hz, 12-6A
T LT TIRRIC_ el | €03
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CE EMC Compliant Cabling

Automated Cabling Overview

519968-xx

Workstation

Force Sensor

Cable with Transducer

ID module
525425-xx

Cable from

Transducer ID module

525442-xx

E-Stop
556342-xx

Box Out
Jumper Plug
100057240 I

Actuator
Manifold
(HSM)

561264-xx

Servovalve
397083-xx

LvDT

Cable with Transducer
ID module

525431-xx

Cable from
Transducer ID module
525442-xx

Intlk
Jumper Plug
100-057-245

HPU

397137-xx

9]
@)

Al

8 ® @6

428 HSM

e
-

—8
E .
? |®

®
®

MYME
2100

1S
S] o/ @‘@ =
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®
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CE EMC Compliant Cabling

Multiple Controller Connections

Connect two or more FlexTest SE controllers in a master-slave
configuration as shown below. The indicated cables on each controller
must be connected before the controllers are turned on.

5 ® ®
®
Master ®
®
® : :
S
563160-xx
®
®
Slave 1
®
- ° e
©
Box Out 563160-xx
Jumper Plug
100-057-246
5 ® ®
.
Slave 2 ® P ®
® N
- FeoE
S O
® ®
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CE EMC Compliant Cabling

Power up sequence  Turn on the master controller first and allow its software to fully boot
before turning on the slave controllers. The slaves must be turned on
in their chain-designated order; Slave 1 before Slave 2. Failure to
observe this power up order will result in interlocks and will require
you to restart all controllers.

Remove power from the controller chain in reverse order; powering
down the end-of-run slave controller first.

Interlock function  Power must be applied to all Controllers in the chain for proper
interlock operation. If power is not applied to any one of the
Controllers, you will not be able to clear an interlock condition in any
of the Controllers.

Also, if one of the Box In cables becomes disconnected from a slave
controller or a cable is connected to Box In on the master controller,
an interlock is set which cannot be reset until all controllers are
restarted.
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Cable Part Numbers

Cable Part Numbers

System cables

FlexTest SE Cables (part 1 of 2)

The following is a list of the most common cables, see the System
Cable/Jumper Plug 493 Package Selection drawing (MTS part number
700-000-656) for the most current and additional cable part numbers.

CABLE DESCRIPTION PART MODULE JUMPER
NumBER” CONNECTOR  pygt

Servovalve 252.xx single 397083-XX 493.40 J4-J7 N/A
Servovalve 252.xx dual 397084-XX 493.40 J4-J7 N/A
Servovalve 256.xx 3-stage N/A

Valve 554396-XX 493.40 J4-J7

Valve LVDT 397086-XX 493.40 J4-J7

Calibration Cable Package 100-026--213 493.40 J3
Y Adapter—Servovalve/Valve LVDT 397105-01 493.40 J4-J7 N/A
(required for 256.xx or 257.xx servovalves)
Workstation Link (Ethernet cable) 519968-XX 10/100% N/A
System ground (table top) 054023-XX N/A
System ground (rack mount) 397092-XX gnd lug
Hydraulic Power Supply (HPU) (see “Hydraulic 397137-XX 493.42 J25 039-713-301
Configurations” on page 221 for more
information)
Hydraulic Service Manifold (HSM) 397015-XX 493.42 J28 N/A
Emergency Stop (E-STOP) 493.42 J29 100-007-947
Interlock (Intlk) Per System 493.42 J43 100-057-245
Auxiliary Power (Aux Pwr) Per System 493.42 J48 N/A

Model 493.02 Controller Service
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Cable Part Numbers

FlexTest SE Cables (part 2 of 2)

CABLE DESCRIPTION PART MODULE JUMPER
NuUMBER" CONNECTOR  pLyg'!

Box In 563160-xx 493.42 J51 N/A

Box Out 563160-xx 493.42 J52 100-057-246
Digital Input (Dig In) Per System 493.42 J54 N/A

Digital Output (Dig Out) Per System 493.42 Jb5 N/A

Analog In (Anlg In) Per System 493.42 N/A

Analog Out (Anlg Out) Per System 493.42 N/A

*

numbers represent custom cable lengths.
T Jumper plugs are required if a cable is not installed.

t The connector is the 10/100 BaseT connector on the power PC module.

-XX specifies cable length. =01 through —09 represent 10-50 ft. in 5 ft. increments. Higher

Sensor cables  See “Sensor Cable Part Numbers” on page 87 for a detailed list of

sensor cables.

For the most current part numbers, see the System Cable/Jumper Plug
493 Package Selection drawing (PN 700-000-656).

46
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Model 493.40 I/O Carrier Connections

Model 493.40 I/0 Carrier Connections

The Model 493.40 I/O Carrier module can include up to four daughter
boards. Each installed daughter board is assigned a specific I/O Carrier
module front panel connector (J4-J7 I/0).

Transducer connections require that a conditioner daughter board is
installed in the I/O Carrier module. The following conditioners can be
installed:

—  Model 493.25 Digital Universal Conditioner

—  Model 493.47 Encoder

—  Model 493.48 Acceleration Conditioner

See “Transducer Connections” on page 83 for more details.

e Valve connections require a valve driver daughter board be
installed in the I/O Carrier module. The following valve drivers
can be installed:

—  Model 493.14 Valve Driver
—  Model 493.15 3-Stage Valve Driver

e Analog I/O connections require an A/D or D/A daughter board be
installed in the I/O Carrier module. The following analog daughter
boards can be installed:

—  Model 493.45 A/D Converter
—  Model 493.46 D/A Converter

Automated Option  If the MTS FlexTest SE Controller is equipped with the automated
option, it includes a PC, MTS Series 793 software and various types of
files, including a hardware interface file Chwi) file. The .hwi file
defines each type of electronic module in the chassis (and associated
daughter boards), and maps each module location for the Series 793
software. The .hwi file and the physical locations for each type of
module and associated daughter boards must match. Also, the I/O
Carrier module address setting (on the module) must match the .hwi
file address.
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Model 493.40 1/O Carrier Connections

Valve Connections

The following types of valve connections are supported:

e Single or dual Series 252 Servovalve(s) can be controlled with a
Model 493.14 Valve Driver daughter board.

e A Series 256 Servovalve can be controlled with a Model 493.15
3 Stage Valve Driver daughter board.

e A Series 257 Servovalve can be controlled with a Model 493.15
3 Stage Valve Driver daughter board and a Model 448.16C Power
Driver chassis.

Cable specification

15 contact type D male EMI connector
e  Backshell-EMI metallized plastic

e Cable type—4 conductor w/foil shield and drain (100935-48 or
equivalent) with the drain wire connected to metallized plastic
backshell at the chassis.

e For 256 and 257 servovalves, the valve LVDT uses the same type
of connectors as the actuator LVDT.

e Servovalve/valve LVDT Y cable required for 256.xx servovalves
(397105-XX)
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Model 493.40 I/O Carrier Connections

252 servovalve The Series 252 Servovalve is a 2-stage servovalve. The Model 493.14
connections Valve Driver supports single or dual valve configurations. The
following figure shows the connections at the valve driver and the
connections between the valve and the valve driver. See “Cable Part
Numbers” on page 45 to connect the valve to the I/O Carrier module.
See also the servovalve manual for single and dual valve configuration
wiring information.

Model 493.14 Valve Driver

From J4 -J7 To
I/O Carrier Servovalve

1
2
3
4
5
6
7
8

—» 9 + Valve Command
10

— 1 - Valve Command

—» 12 + Valve 2 Command

—»| 13 | -Valve 2 Command
14
15

Controller
Test
Command  |Control Valve ,,,,,,C,Qmm@@,,
> Mode Driver

Actuator LVDT
Feedback
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Model 493.40 1/O Carrier Connections

256 servovalve The Series 256 Servovalve is a 3-stage servovalve. The Model 493.15
connections Valve Driver supports the inner loop signals. The following figure
shows the connections between the valve driver and the valve. See
“Cable Part Numbers” on page 45 to connect the valve to the I/O
Carrier module. See also the servovalve manual for single and dual
valve configuration wiring information.

Model 493.15 Valve Driver

To/From Ja - J7 To/From

I/O Carrier Servovalve
— + Excitation
— - Excitation
- + Feedback
- Feedback

Signal Ground

© 00 N O a0 A~ WON =

— + Valve Command
10

— M - Valve Command
12
13
14
15

Controller Valve LVDT

Feedback Inner Loop

Test

Command ~ |Control
« | Mode
>

Command

Valve ___|_Lommana, >

Driver

Actuator LVDT ~ Outer Loop
Feedback
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Model 493.40 I/O Carrier Connections

257 valve connections The Series 257 Servovalve is a 3-stage servovalve that requires a power
driver. The Model 493.15 Valve Driver supports the inner loop signals.
The following figure shows the connections between the valve driver
and the valve. See “Cable Part Numbers” on page 45 to connect the
valve to the I/O Carrier module. See also the servovalve manual for
single and dual valve configuration wiring information

Model 493.15 Valve Driver

To/From Ja -J7 To/From

|/O Carrier Servovalve
— + Excitation
— - Excitation
- + Feedback
- Feedback

Signal Ground

©W 00 N O G A W N =

— + Valve Command
10
— M - Valve Command
12
13
14
15
Controller | ValvelVDT ] Inner Loop
Feedback
Test o Command > 448.16
Command ~ [Control Tt Féoyver ************* > i
> Mode river VT
A (stability)
Loop
Actuator LVDT
Feedback Outer Loop
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Model 493.40 1/O Carrier Connections

Analog /0 Connections

The Model 493.45 A/D and Model 493.46 D/A daughter boards are
installed in the Model 493.40 I/O Carrier front panel module.

Note The external analog source can be a stand-alone function generator,
another controller, or a computer controlled analog output.

Analog inputs  The analog-to-digital daughter cards accommodate up to six analog
input signals.

e Each A/D input signal must be To From
within £10 volts. AD  Ja-J7 493.75A/D
. Module
e Use pin 3 or 6 to prevent -
problems with floating grounds <+— 1 * Inout 1
between devices. <+ 2 -] P
3 Analog
~ __ Ground
«— 4 |+
Input 2
<«— 5 | -]
6 Analog
~ __ Ground
<« 7 +
Input 3
<«— 8 | |
9 Input 4
<+ 10 -
< n + Input 5
<+— 12 —
<« 13 | t
Input 6
<+— 14 il
15
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Model 493.40 I/O Carrier Connections

D/A Connections Digital-to-analog daughter cards support up to six program or readout
signals to external devices.

e Each D/A signal is an analog

output within +10 volts. From To
D/A J4a-J7  External
e  Fach readout signal is from a 16 Device
bit digital to analog converter. 1 T
Output 1
e  Fach output is a £10 V analog 2 =
output. 3
—> 4 |
Output 2
5 ——
.
—| 7 T
Output 3
6 8 —
3 Output 4
» M | +]Output 5
o112 | -
—> 13 | *|
Output 6
< 1 ¥ |
15

Cable specification  The cable specifications apply to both the analog inputs and analog
outputs.

The cable from the front panel of the I/O Carrier module has the
following specification:

e 15 contact type D male EMI connector.
e  Backshell-EMI metallized plastic.

e Cable type—up to 6 shielded twisted pairs, each with the drain
wire connected to the signal source.
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Model 493.40 1/O Carrier Connections

Encoder Connections

Each encoder requires installation of a Model 493.47 Encoder Interface
daughter board on the Model 493.40 I/O Carrier board. The I/O Carrier
connector is based on the location of the daughter board installed on
the board of the I/O Carrier module. See “Determine installed location”

on page 186
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Model 493.40 I/O Carrier Connections

Accelerometer Connections

An accelerometer requires the Model 493.48 Acceleration daughter
board installed in a Model 493.40 1I/O Carrier module.

e  Each Model 493.48 Acceleration daughter board supports up to
three accelerometers.

1/0 Carrier jumper  Before installing a Model 493.48 Acceleration Conditioner daughter

Model 493.02 Controller Service
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seftings  board in a Model 493.40 I/O Carrier module, specific jumpers must be
set. Jumper settings depend on the number and configuration of your
system accelerometers.
In the example shown below, the Acceleration Conditioner supports
three accelerometers. The indicated three jumpers must be set on the
I/O Carrier module.
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Model 493.40 1/O Carrier Connections

Workstation Connection

The workstation computer is connected to the MVME PowerPC®
module installed in the VMEbus of the chassis. It is an Ethernet 10/100
Base-T connection. The workstation computer must have an Ethernet
compatible connector.

®

e 1T s — 3

3
9

A\ CAUTION The symbol shown here indicates that you must not

connect telecommunications equipment to the @
equipment showing this symbol.

Several modules have connectors that look similar to a phone connector.
Special cables are required. Installing telecommunications equipment cables
can cause equipment damage to the electrical components of the chassis or
to your telecommunications system.
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Model 493.40 I/O Carrier Connections

Service Connection

1/0 Carrier service  The J3 Service connector on the Model 493.40 1/O Carrier module
provides the monitor output from each of the four I/O option cards
installed. It is an 8-pin RJ-45 connector.

From To
Daughter Y3 External
Boards Device
—>| 1 Slot 1 Monitor
< 2 Slot 1 Ground
—>»| 3 Slot 2 Monitor
< ] 4 Slot 2 Ground
—>p»| 5 Slot 3 Monitor
<& ] 6 Slot 3 Ground
—>| 7 Slot 4 Monitor
< | 8 Slot 4 Ground

Important  The signals at the J3 Service connector are provided for
service and troubleshooting only. These signals are defined by
the /O option daughter boards that are installed on a
respective Model 493.40 I/O Carrier module. Some of these
signals may be uncalibrated. Before use, take appropriate
steps to determine the characteristics of these signals.
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Model 493.42 System |/O Connections

Model 493.42 System I/0 Connections

The Model 493.42 System I/O module is a dual-wide VME-based slave
board used in the MTS FlexTest SE Controller.

e Provides box-in and box-out, analog and digital /O, E-Stop, and
HSM and HPU control.

e Contains three general purpose digital input channels and three
general purpose digital output channels.

e Interfaces the controller with a hydraulic power unit.

e Interfaces the controller with a hydraulic service manifold and
other devices.

e  Provides one BNC channel for analog output signals. The output
signals are within £10 V DC.

e  Provides one BNC channel of analog input. The input signals must
be within £10 V DC.
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J25 Hydraulic Power Unit Connection

Model 493.42 System I/O Connections

A CAUTION

Cable specification

Jumper plug required

Connector J25 HPU controls the hydraulic power unit (HPU).

e The connector provides 24 V logic signals to control the HPU.

e The connector may be connected directly to a Model 505 or 24
PLC HPU or to a Model 493.07 HPU Converter Box, which allows
any MTS HPU to be connected to the chassis with the following
exceptions:

- 506.52 - .92 HPUs (24 volt, PLC compatible)
—  All Series 505 HPUs

The converter box is used with other configurations, see
“Hydraulic Configurations” on page 221 for more information.

. ________________________________________________________________________________________]
Control voltages for hydraulic power units vary between models.

The HPU interface between the Model 493.42 System 1/0 board and an
HPU is 24 volt logic signals. Connecting J25 to a non-compliant HPU
can damage the module.

DO NOT connect 24 V DC relay circuitry or 115 V AC circuitry to connector
J25 on the Model 493.42 System |I/O board.

The J25 HPU and J51 Box In connectors are 15 pin type D male
connectors.

e 15 contact type D female EMI connector.

e Cable—24 AWG, 10 conductor with braided shield with drain wire
connected to metallized plastic backshell to the chassis.

If connector J25 HPU is not used, you must install a jumper plug to
maintain the integrity of the interlocks. Use jumper plug 39-713-301E
or jumper pins: 1-7, 2-3-5, 6-9, 8-10-11-12, 6-9.
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Model 493.42 System |/O Connections

To/From J25 To/From
Chassis HPU

HPSOn |~ X ¢ <
Sense 9

! ST

: 3 10

j s ' OverTemp
= : 1
Low Level
12
HPS 24 Vdc
C+24
* 1 vdc
CRM
Start Start
o 2 _I> 1CR Relay g
Lo
> 3 —|>—{
R T : Motor
' ' Relay
i 4 [ | High
' ' g Hi Pressure
o ! 4 SOL Solenoid *
<4——— 5 ——0 +24Vdc
E-stop ""3 6 @HPSRIS:\;\OCK

Controller 24Vde o———» 7

< L

HPS Defeat Voltage
(not connected in HPS)
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J28 Hydraulic Service Manifold Connector

Model 493.42 System I/O Connections

+24V

Connector J28 HSM controls the pressure of a hydraulic service
manifold. The controller software can configure the connector for
solenoid or proportional control of a 24 volt hydraulic service
manifold.

From Chassis J28 To HSM
lo
|% 1 Low Pressure

Solenoid

W 2 DC Common
- Proportional ! Solenoid or

-1 3 Shield Proportional
||h| = Valve

| |jo—> 4 High Pressure
+ Proportional

Cable specification

Proportional output

e P28 is a 4-contact CPC male connector (AMP Incorporated).
e Cable for on/off HSMs—18 AWG/2 conductor.
e Cable for high/low HSMs—18 AWG/4 conductor.

The proportional output is configured with the controller software.

e The output signal can be ramped from 20 mA (minimum) to 700
mA (maximum) which corresponds with 50 psi (0.4 MPa) and
3000 psi (21 MPa). By default, low pressure is factory set at 750 psi
and high pressure is set at 3000 psi.

e The ramp rate from zero to high pressure can be set to two or four
seconds. The ramp rate from high pressure to zero can be set to
zero, two or four seconds.

e The ramp rate is constant (set to the two or four second rate). The
amount of time to reach low pressure depends on the low
pressure setting.

Model 493.02 Controller Service 61



Model 493.42 System |/O Connections

J29 Emergency Stop Connections

Connector J29 E-STOP provides an output to external devices when
an emergency stop signal is generated. This connector may also be
used with an external E-stop.

J29 Connector Pin Assignments

Pin NAME FUNCTION
1 Xhead 24V Fused +24V
2 Xhead intlk com 24V common
3 Program interlock low (xhead Low side of opto-isolator, jumpered to common
interlock low)
4 Program interlock high High side of opto-coupler, pulled up to 24V (opto on = intlk)
(xhead interlock high)
5 Local E stop Local E stop loop (connected to pin 7)
6 N/C No connection
7 Local E stop Local E stop loop (connected to pin 5)
8 HPU E stop E stop loop from HPU (connect to pin 13)
9 N/C No connection
10 N/C No connection
1 N/C No connection
12 Xhead power +24V crosshead unlock power output (from HSM high relay
contact)
13 HPU E stop E stop loop from HPU (connect to pin 8)
14 xhead power return 24V common for crosshead unlock power output
15 N/C
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Cable specification e 15 contact type D male EMI connector.
e  Backshell-EMI metallized plastic.

e Cable-24 AWG 4 connector with braided shield, with the braid
connected to a metallized plastic backshell at the chassis and to
ground at the emergency stop station.

Jumper plug required  1f connector J29 is not used, you must install a jumper plug to
maintain the integrity of the interlocks. Use jumper plug 100-007-947B
or jumper pins: 3-4, 5-7, 8-13.

Model 493.02 Controller Service 63
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J43 Interlock

Connector J43 Interlock contains one optically isolated interlock
input and one relay contact interlock output.

Note The intlk out relay (Pin 6) is normally energized when no interlocks
are active. So even though Pin 6 is a NO (normally open) relay
contact, it is actually normally closed when no interlocks are active.
Similarly, the intlk out relay (Pin 8) is normally closed when no
interlocks are active, so even though Pin 8 is a NC (normally closed)
relay, it is actually normally open when no interlocks are active.

J43 Connector Pin Assignments

Pin NAME FUNCTION
1 intlk in 24V 24V through 6.6K resistor
2 intlk in high High side of opto-isolator (opto off=intlk)
3 intlk in low Low side of opto-isolator
4 intlk in comm 24V common
5 N/C No connection
6 intlk out NO Normally open relay contact
7 intlk out COM Common relay contact
8 intlk out NC Normally closed relay contact
9 N/C No connection

Cable specification e 9 contact type D male EMI connector.
e Backshell-EMI metallized plastic.

e  Cable-shielded twisted pairs (24 AWG minimum) with drain
wire(s) connected to the metallized backshell at the chassis.

Power Channel inputs can be 3 volts (minimum) and 26 volts (maximum)
characteristics  from an external voltage source.

Jumper plug required  1f connector J43 is not used, you must install a jumper plug to

maintain the integrity of the interlocks. Use jumper plug 100-057-245,
or jumper pins: 1-2, 3-4.
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J49 Auxiliary Power

Model 493.42 System I/O Connections

Connector J49 Aux Pwr provides +5 V DC, £15 V DC, and 24 V DC
from the chassis internal power supply to drive external high level
conditioners, proximity switches, solenoids, and so forth.

e The outputs are fused at 0.75 A to protect the power supply from
an external short.

e The fuses can be reset by shutting off power and waiting a few
minutes (the fuses automatically reset when cooled) then
reapplying power.

From
Chassis

J49 To
External Devices

F7

+15 Vdc o—dlpt
Analog
Ground %;

Fa

15V DC O d\p

F9

+24VDCO—C\ O

24V
Common % e

+5VDC O S\ O

5V
Ground

Cable specification e 9 contact type D male EMI connector

e Backshell-EMI metallized plastic

e  Cable-shielded twisted pairs (22 AWG minimum) with drain
wire(s) connected to the metallized backshell at the chassis.
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J51 Box In

Connector J51 Box In allows the MTS FlexTest SE controller to receive
clock, hydraulic, and interlock signals from another MTS FlexTest SE

controller.

J51 Connector Pin Assignments

PIN NAME FUNCTION

1 +clk in +External clock input

2 hyd high in Hydraulic high input

3 reset in Interlock reset request input

4 signal return Signal return for optically isolated inputs
5 /intlk in Hydraulic interlock input

6 hyd low in Hydraulic low input

7 signal return Signal return for optically isolated inputs
8 master/slave in Master -/Slave select input

9 -clkin - External clock input

10 hyd hi return out Hydraulic high return output

1 reset return out Interlock reset return output

12 ground Signal ground

13 /intlk return out Hydraulic interlock return output

14 hyd low return out Hydraulic low return output

15 ground Signal ground

66

Model 493.02 Controller Service
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J52 Box Out

Connector J52 Box Out allows the MTS FlexTest SE controller to send
clock, hydraulic, and interlock signals to another MTS FlexTest SE
controller.

J52 Connector Pin Assighments

PIN NAME FUNCTION

1 +clk in +External clock output

2 hyd high out Hydraulic high output

3 reset out Interlock reset request output

4 ground Signal ground

5 /intlk out Hydraulic interlock output

6 hyd low out Hydraulic low output

7 ground Signal ground

8 N/C No connection

9 - clk out - External clock output

10 hyd hi return in Hydraulic high return input

1 reset return in Interlock reset return input

12 signal return Signal return for optically isolated inputs
13 /intlk return in Hydraulic interlock return input

14 hyd low return in Hydraulic low return input

15 signal return Signal return for optically isolated inputs

Jumper plug required If connector J52 Box Out is not used, you must install a jumper plug
to maintain the integrity of the interlocks. Use jumper plug 100-057-246
or jumper pins: 2-10, 3-11, 4-12, 5-13, 6-14, 7-15.
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J54 Digital Inputs

Connector J54 Dig In accommodates up to three digital signals from
external devices. You can use digital input signals to trigger test events
with your controller applications.

e All of the inputs are optically isolated.

e Channel inputs can be 3 volts (minimum) and 26 volts (maximum)
from an external voltage source.

J54 Connector Pin Assighments

PiN NAME FUNCTION
1 dig in 24V 24V through 6.6K resistor
2 digin 1 high High side of opto-isolator (opto on = logic 1)
3 digin 1 low Low side of opto-isolator
4 dig in 2 high High side of opto-isolator (opto on = logic 1)
5 dig in 2 low Low side of opto-isolator
6 dig in 3 high High side of opto-isolator (opto on = logic 1)
7 dig in 3 low Low side of opto-isolator
8 dig in com 24V common
9 dig in com 24V common

68

Cable specification

The cabling information shown assumes a single cable destination
(with an overall shield). In other applications, the cable may have
more than one destination. For these applications an overall shield is
not practical and non-EMI connectors and back shells are permissible.

e 9 pin contact type D male EMI connector
e Back shell-EMI metallized plastic

e  Cable-shielded twisted pairs as required (24 AWG minimum) with
drain wire(s) connected to the metallized backshell at the chassis.
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Model 493.42 System I/O Connections

J55 Digital OQutputs

Connector J55 Dig Out provides three general purpose digital outputs
that can send digital logic signals to external switches or logic devices.

e The digital output relays are rated for a maximum of 1 Amp max,
30 V DC/AC max.

e The outputs are optically isolated.

J55 Connector Pin Assignments

PN NAME FUNCTION
1 dig out 1 digital out 1 relay contact
2 dig out 1 digital out 1 relay contact
3 dig out 2 digital out 2 relay contact
4 dig out 2 digital out 2 relay contact
5 N/C No connection
6 dig out 3 Digital out 3 relay contact
7 dig out 3 Digital out 3 relay contact
8 +24V out fused +24V
9 24V common 24V common

Cable specification

The cabling information shown assumes a single cable destination
(with an overall shield). In other applications, the cable may have
more than one destination. For these applications an overall shield is
not practical and non-EMI connectors and back shells are permissible.

e 9 pin contact type D male EMI connector
e  Back shell-EMI metallized plastic

e Cable-shielded twisted pairs as required (24 AWG minimum) with
drain wire(s) connected to the metallized backshell at the chassis.
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Chapter 4

Servovalve Controls

Contents

Hydraulic systems

Adjustment
prerequisites

When to adjust

Servovalve adjustments optimize the interface between the controller
and the servovalve.

Setting the Servovalve Polarity 73

Getting Things Ready 74

Adjusting Valve Balance 75

Dither 76

Tuning the Inner loop 77

Inner Loop Signals 79

Hydraulic systems use servovalves to control the actuator. The
following complement of valves have different Drive panels:
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e 252 Valve—represents the MTS Series 252 Servovalve.

e Dual 252 Valve—represents two MTS Series 252 Servovalves
mounted to the actuator manifold.

e 256/257 Valve— represents the MTS Series 256 and Series 257
Servovalves. Although these valves are different, they use the
same adjustments. These servovalves have inner control loops.

You should run a small program to warm up the system hydraulic fluid
and servovalve before you adjust the valve balance, dither, or inner
loop.

Refer to “How to Warm Up the Station Hydraulics” in Chapter 2,
Common Tasks of the FlexTest SE User’s manual for a detailed
procedure.

You make servovalve adjustments to optimize the valve response to
your program commands.

Normally, servovalves are balanced and tuned at the factory, and then
optimized by the MTS service engineer who installs your system.
However, if you change or replace a hydraulic component or notice
erratic servovalve response during a test, you may need to readjust
your servovalve settings.
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Use the following paragraphs to determine when to perform each
servovalve adjustment.

Note During system installation, perform all of the adjustments in this
section.

Initial adjustments  Perform initial adjustments when initially installing the system or
replacing a hydraulic component. These adjustments, such as setting
servovalve polarity, are only needed once and should not require
readjustment.

See “Setting the Servovalve Polarity” on page 73.

Valve balance ~ While running a test on a properly tuned system, you observe that the
controlling sensor’s peak and valley amplitudes are unequal. When
you have completed a mechanical valve adjustment, always adjust the
valve balance.

See “Adjusting Valve Balance” on page 75.
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Dither  Adjust the dither while running a test on a properly tuned system, you
observe either of the following:

e A sinusoidal test waveform is distorted at its maximum and
minimum points (peak and valley values change). This will
normally be more observable during a test that has either a low-
frequency or a low-amplitude test waveform. This indicates that
dither amplitude is insufficient.

e An unusual sound (hammering, squealing, or pounding) coming
from the test system. This indicates that dither amplitude is
excessive.

See “Adjusting dither amplitude” on page 76.

Inner loop tuning Perform inner loop tuning when initially installing a system or fine
tuning a system that employs a 3-stage valve driver.

See “Tuning the Inner loop” on page 77.
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Setting the Servovalve Polarity

Setting the Servovalve Polarity

Important

Procedure

Servovalve polarity determines the direction the servovalve moves the
actuator in response to a positive command. It can be set to normal or
invert.

Typically, a servovalve set to normal polarity extends the actuator in
response to a positive command. Conversely, a servovalve with an
inverted polarity retracts the actuator in response to a positive actuator
command.

Before you can set servovalve polarity, you must determine if the
current servovalve polarity follows the normal convention.

Please note the following:

e  The polarity of the servovalve must be checked before sensor
calibration begins and before hydraulic pressure is applied for the
first time.

e The polarity of any servovalve is generally set when the valve is
installed.

The combination of the conditioner polarity and the servovalve
polarity affects the final output signal. The conditioner polarities
should be set before the servovalve polarity because they do not need
hydraulics to be turned on. In general, you will set the conditioner and
servovalve polarity the same.

This procedure allows you to determine servovalve polarity by
observing actuator movements while applying a positive Setpoint
command to the actuator.

Refer to “How to Set Servovalve Polarity” in Chapter 2, Common Tasks
of the FlexTest SE User’s manual for a detailed procedure.
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Getting Things Ready

Getting Things Ready

If you plan to perform any of the procedures described later in this
chapter, be sure that you get the hydraulic fluid up to temperature.

Be sure that both the hydraulic fluid and the servovalve are at
operating temperature. Remove any specimen and run the system in
displacement control for at least 30 minutes using an 80% full-scale
length command at about 0.1 Hz.

Refer to “How to Warm Up Station Hydraulics” in Chapter 2, Common
Tasks of the FlexTest SE User’s manual for a detailed procedure.
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Adjusting Valve Balan

Adjusting Valve Balance

ce

Prerequisites

Procedure

The valve balance adjustment electrically compensates for minor
mechanical imbalance in the servovalve.

Your servovalve is typically balanced during installation at its
midstroke position. The signal values in your station parameter set
reflect that initial servovalve balance procedure.

For optimal performance, you should balance your servovalve again
after you position your actuator to the test start position.

The following must be true. If not, go to “Getting Things Ready” on
page 74.

e The hydraulic fluid and the servovalve are at operating
temperature.

e Command compensators are turned off.

Refer to “How to Balance the Servovalve” in Chapter 2, Common Tasks

of the FlexTest SE User’s manual for a detailed valve balancing
procedure.
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Dither

Dither

76

Dither adjustment
prerequisites

Adjusting dither
amplitude

Dither is a low-amplitude, high-frequency sine wave that your
controller applies to your servovalve’s spool. Dither keeps your
servovalve’s spool in motion so it operates smoothly and does not silt
up or stick to its cylinder walls. It is especially useful for tests that use
small amplitude commands or run at low frequencies.

Dither
(exaggerated)

Test Waveform

Dither amplitude was set during installation. The signal values in your
station parameter set reflect that initial dither amplitude procedure, and
are probably adequate for your test.

The following are signs of an improper dither adjustment:

e Dither amplitude is too low—While running a sinusoidal test on
a properly tuned system, you notice that the waveform distorts at
its maximum and minimum points. This will normally be more
apparent during a test that has either a low frequency or a low
amplitude test waveform.

e Dither amplitude is too high—You hear unusual sounds, such
as hammering, squealing, or pounding coming from the test
system.

The following must be true. If not, go to “Getting Things Ready” on
page 74.

e  The hydraulic fluid and the servovalve are at operating
temperature.

e Command compensators are turned off.

Refer to “How to Adjust Dither ” in Chapter 2, Common Tasks of the
FlexTest SE User’s manual for a detailed dither amplitude adjustment
procedure.
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Tuning the Inn

Tuning the Inner loop

er loop

The innerloop (proportional)
gain and rate (derivative)
adjustments are the same
types of adjustments as the
proportional and derivative gain
adjustments of the outerloop
tuning controls.

Important

Procedure

Perform inner loop tuning when initially installing a system or fine-
tuning a system that employs 3-stage valve drivers. The inner loop
proportional gain and rate derivative adjustments are the same types of
adjustments as used with the PIDF tuning controls.

Note During initial system installation, inner loop gain and rate
adjustments must be performed before tuning the servo outer loop.
For fine tuning, an initial inner loop gain adjustment may be needed

if the outer loop is sluggish.

The inner control loop is similar to a displacement control mode for
the outer loop. The Model 493.15 Three-Stage Valve Driver module
includes the electronics necessary to support the inner control loop.

Feedback

Outer
Loop

,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,

\/

Hydraulic
Power
Supply

Signal

Program

Command

493.15 Valve
Driver

Always tune the inner loop without the hydraulics applied to the
actuator. Perform the inner loop gain adjustments with hydraulic
pressure removed from the main spool while maintaining pressure at
the pilot stage. This prevents interaction between the inner and outer
loops.

For a detailed inner loop tuning procedure, refer to “How to Tune
Three-Stage Servovalves” in Chapter 2, Common Tasks of the FlexTest
SE User’s manual.
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Tuning the Inner loop

Zero the Spool Position Signal
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A\ WARNING

78

This task matches the electronic null of the spool position signal with
the mechanical null position of the servovalve pilot spool.

During inner loop tuning, it may be necessary to complete this
procedure if the spool position signal voltage is not approximately
equal (though opposite polarity) at opposite endcaps of a servovalve.

1. Set the Valve Balance to zero.
Stand-Alone— Path: Setup > Output(3-stage) > Valve Balance

Automated— On the Drive panel, click the Valve tab, then set
the Valve Balance to zero.

2. Ensure that the Offset control is set to zero.

Stand-Alone— Path: Setup > Disp > Offset/Zero > Manual
Offset

Automated— Click the Conditioner tab on the Drive panel,
then check the Offset setting.

3. Apply hydraulic pressure.
. ________________________________________________________________________________________]
Do not remove the LVDT adjustment locknut or assembly when
adjusting the servovalve LVDT spool position.

If it is removed, hydraulic fluid will spray from the servovalve at full pressure.
You should refer to the servovalve product manual to identify the main stage
LVDT spool adjustment.

. ________________________________________________________________________________________]

4. Loosen (but do not remove) the LVDT locknut.

5. Adjust the LVDT in or out of the servovalve to provide a zero
spool position signal.

6. Tighten the locknut while holding the LVDT in position.
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Tuning the Inner loop

Inner Loop Signals
To monitor inner loop signals on the FlexTest SE Controller:

1. Connect a service calibration cable package (MTS part number
100-026-213) to connector J3 Service on the I/O carrier module.

2. Connect a DVM or oscilloscope to the appropriate BNC Output
Channel on the service cable, depending on which slot the valve
driver occupies in the I/O Carrier module.

You can also set up the FlexTest SE scope or meters to monitor
inner loop signals.

Note  Only the Spool Position signal is available to the FlexTest SE
meters or scope.
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Tuning the Inner loop
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Chapter 5

Sensors

This chapter describes sensor signals, connections, and cabling. Shunt
calibration for DC sensors is also described.

Contents  Sensor Signals 82
Transducer Connections 83
Sensor Cables 86
Shunt Calibration 89
Shunt Calibration/Bridge Completion 92
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Sensor Signals

Sensor Signals

82

Full-Range DUC
Conditioner

With the Station Builder program, you can allocate station resources
(conditioners) to sensors connected to your test system. Once a
conditioner is linked to a sensor, the sensor signal (feedback) can be
used as a control mode and/or for data acquisition. Available sensor
signals vary with the type of controller in your system.

The FlexTest™ SE controller supports the following types of sensor signals:

e AC conditioner signals are conditioned by a Digital Universal
Conditioner (DUC) daughter board plugged into the I/O Carrier
module on the Controller’'s VME chassis. The DUC must be
configured for the AC mode. An LVDT requires AC conditioning.

e DC conditioner signals are conditioned by a Digital Universal
Conditioner (DUC) daughter board plugged into the I/O Carrier
module on the Controller’'s VME chassis. The DUC must be
configured for the DC mode. A force transducer (load cell)
requires DC conditioning.

The Model 493.25 DUC module used with your FlexTest SE controller
is a full-range conditioner that provides one calibrated range for each
Sensor.
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Transducer Connections

Transducer Connections

Transducer connections require a conditioner daughter board be
installed in the I/O Carrier module. The following conditioners can be
installed:

e Model 493.25 Digital Universal Conditioner
e  Model 493.47 Encoder
e Model 493.48 Acceleration Conditioner

Each Model 493.40 1/O Carrier module can include up to four daughter
boards. Each installed daughter board is assigned a specific I/O Carrier
module front panel connector (J4-J7 I/0). These connections can be
used for any type of sensor (provided the appropriate daughter board
is installed).

A hardware interface file (hwi) defines each type of module (and their
associated daughter boards) and maps each module location for the
system software. The .hwi file and the physical locations for each type
of module and associated daughter boards must match.

Excitation and
feedback signals

To/From
are passed Conditioner J4 -J7
through to the
transducer. —» 1 + Excitation |
—> 2 - Excitation To/From
ﬁ 3 Guard Transducer
<+ 4 + Feedback
<4— b - Feedback |
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Transducer Connections

LVDT connections An LVDT requires an AC conditioning daughter board.

¢ -
Inner 3 A K A((:L%/GDQI'S)OF
Guard j
Bl LI N T c
+FB | 4 B
EX| 2 C
+EX | 1 D

Temposonics Il A Temposonics II transducer requires a DC conditioning daughter
connections board.

™ _1_7
—
+EX| 1 3 1 o _F E 1w (\ ‘(j‘ ols
EX| 2 H -y N E2, Lh 5| Exc
I X - b . FROM o
P L 3" TEMPOSONICS I
e RETURN
L B U I - el A I ol TRANSDUCER
+FDBK| 4 i T | ™ 4 [ T R FDBK
-FDBK| 5 Ly [ s Loty cl-
] SE N T
X P Ll E
| [
| PR ) I ) L
| [
[ |
REMOTE I L
caL |9 i - 9
| [
SIGGND| 6 £ H L 6 ||
| |
CLK| 8f—— T 814
DATATO ID |11 ;} — - 1 ] circuit
L Ly [
DATA FROM ID |14 r‘ I > I T 14
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Transducer Connections

Temposonics llI A Temposonics III transducer requires a DC conditioning daughter
connections  board.

TO +24V | 9
493.74
AUXPOWER | cOM | 8

DRAIN _L

—<_ D

5 [+24Vv

// 6 |com
2
1

+
Data
- FROM
TEMPOSONICS IlI

/ / al+ } ot SENSOR
4 -

=T
N S P

+
TO Data {
493.40 CARRIER MODULE -
(TEMPOSONICS IlI
DAUGHTER BOARD) +
Clock {

OUTER BRAID

'y
d

Force/strain sensor Force and strain sensors require a DC conditioning daughter board.

connections
GND[ ¢
Inner
Guard 3
-FB| 5 C DC Sensor
+FB | 4 B
-EX | 2 D
4EX | 1 - - A
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Transducer Connections

Sensor Cables

Specifications

86

A typical system is provided with a standard set of sensor cables as
specified on the System Cable/Jumper Plug 493 Package Selection
drawing (PN 700-000-656). Refer to this drawing for the most current
part numbers. Standard sensor cables do not have ID modules.

Sensor cables with an ID module built into them are available as an
option. Sensor cables with ID modules use a system cable to bridge
the sensor cable to the appropriate connector on the rear panel of the
chassis.

e 15 contact type D male EMI connector
e Backshell-EMI metallized plastic

e  Cable type—For all applications including CE EMC Compliance,
use MTS cable material 505301-01 (two 22 AWG twisted pairs with
inner and outer braided shield for the excitation and feedback
signals, plus a twisted quad for the ID signals, and a single wire
for the shunt calibration signal). Shield connections can vary from
sensor to sensor.

e If purchased as an option, each sensor includes one cable with a
transducer ID module and a system extension cable. A system
cable is required between the transducer ID cable and the Model
493.02 Controller’s VME chassis.
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Transducer Connections

Sensor Cable Part Numbers

Sensor cables  See the System Cable/Jumper Plug 493 Package Selection drawing (PN
without ID Module 700-000-656) for the most current sensor cable part numbers.

CABLE DESCRIPTION CABLE MODULE
CONNECTOR
ADT 120° 562348-XX 493.40 J4-J7
300° 562531-XX 493.40 J4-J7
Extensometer 633 capacitive 516495-XX 493.40 J4-J7
Force Transducer w/PT connector 464402-XX 493.40 J4-J7
w/MS connector 464406-XX 493.40 J4-J7
w/PC 562529-XX 493.40 J4-J7
LVDT 464403-XX 493.40 J4-J7
AP control 479276-XX 493.40 J4-J7
Pressure Control (Sensotec) 562530-XX 493.40 J4-J7
Strain w/Amphenol connector 562336-XX 493.40 J4-J7
w/PT connector 501200-XX 493.40 J4-J7
Temposonics 491532-XX 493.40 J4-J7
Temposonics Il (low power conditioner) 562532-XX 493.40 J4-J7
Temposonics Il 563167-XX 493.40 J4-J7
RVDT w/MS connector 512028-XX 493.40 J4-J7
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Transducer Connections

Sensor cables with ID See the System Cable/Jumper Plug 493 Package Selection drawing (PN
Module 700-000-656) for the most sensor cable current part numbers.

Each sensor includes a cable with an ID module built into it. Use a
system cable to bridge the sensor cable to the rear panel of the
controller chassis.

CABLE DESCRIPTION ID MODULE W/CABLE  SysTEm CABLE! MODULE
CONNECTOR
ADT 120° 525435-XX 561258-XX 493.40 J4-J7
300° 524436-XX 561259-XX 493.40 J4-J7
Extensometer 633 capacitive 525434-XX 525443-XX 493.40 J4-J7
Force Transducer w/PT connector 525425-XX 525442-XX 493.40 J4-J7
w/PC connector 525426-XX 525442-XX 493.40 J4-J7
w/MS connector 525427-XX 525442-XX 493.40 J4-J7
LVDT 525431-XX 525442-XX 493.40 J4-J7
AP control 525432-XX 525442-XX 493.40 J4-J7
Pressure Control (Sensotec) 525433-XX 525442-XX 493.40 J4-J7
Strain w/Amphenol connector 525429-XX 525442-XX 493.40 J4-J7
w/PT connector 525430-XX 525442-XX 493.40 J4-J7
Temposonics 525437-XX 561260-XX 493.40 J4-J7
Temposonics Il (low power conditioner) 525438-XX 525442-XX 493.40 J4-J7
RVDT w/MS connector 527508-XX 525442-XX 493.40 J4-J7

1. -XX specifies cable length. —01 through —09 represent 10-50 ft. in 5 ft. increments. Higher
numbers represent custom cable lengths.
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Shunt Calibration

Shunt Calibration

You can verify the calibration accuracy of a DC sensor/conditioner pair
through shunt calibration. Shunt calibration works by shunting a
precision resistor across one arm of the sensor’s bridge.

A current shunt calibration value, taken before a test, should be
compared to the shunt calibration reference value recorded when the
sensor was last calibrated. If the reference value and the current value
differ too greatly, the sensor/conditioner pair should be recalibrated to
establish a new shunt reference value.

Note Itis possible to adjust excitation to compensate for small to
moderate changes in the shunt calibration value.

When to use shunt  You should perform a shunt calibration (establish a new shunt
calibration reference value) when the following occur:

e  You start a new test.

e You move a sensor to a different DC conditioner.

e You swap a DC conditioner module.

e You recalibrate a DC sensor.

e You change the sensor cable (resistance may differ).

Note  Shunt calibration can not be used to compensate for different length
cables.

Note  You cannot check shunt calibration of a sensor being used with the
active control mode when hydraulic pressure is on.

Note  Shunt calibration does not compensate for changes in the sensor
sensitivity over time.

How to perform a Each resistive bridge type transducer (DC sensor) uses a shunt resistor
shunt calibration to check the calibration accuracy of the sensor/conditioner
combination. Each DC conditioner supports a shunt resistor.

Perform a shunt calibration to establish a new shunt reference value
for a DC sensor/conditioner pair as follows:

1. Turn off hydraulic power

2. Remove the load standard.
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3. Turn on hydraulic power.
4. Zero the DC sensor output.
Stand-Alone:
Path: Setup > Force > Offset/Zero > Manual Offset
Adjust the Manual Offset for a 0 kN output. The sensor output
must be 0.000 kN for a proper shunt calibration.
Automated:
Adjust the Manual Cmd slider on the Manual Command
window for a 0 kN output. The sensor output must be 0.000 kN
for a proper shunt calibration.
5. Change the control mode to displacement.
Stand-Alone— Path: Status > Control Mode > Disp.
Automated— Change Control mode on the Manual Command
window to a Displacement control mode.
Shunt calibration cannot be performed on a sensor when it is in
control of the servo loop.
6. Determine the shunt calibration resistor from the following table:
BRIDGE SENSITIVITY RANGE RESISTOR
RESISTANCE (% FULL SCALE)  VALUE
350 Q 2mV/V 100% 49.9 k
50% 100 k
20% 249 k
10% 499 k
350 Q 1mV/V 100% 100 k
50% 200 k
20% 499 k
10% 1000 k
700 Q 2mV/V 100% 100 k
50% 200 k
20% 499 k
10% 1000 k
700 Q 1mV/V 100% 200 k
50% 402 k
20% 1000 k
10% 2000 k
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7. Install the shunt calibration resistor as follows:

Select the appropriate shunt calibration resistor.

m g O W

Bend the resistor leads 90° for a 0.3 inch separation.

Cut the resistor leads 0.12 inch from the bend.

Shunt Calibration

Insert the resistor into the connector solder cups and solder.

Complete and attach a shunt calibration label as specified on

the 493.40/41 Carrier I/O Shunt Calibration Kit (MTS PN 100-

028-185).

F.  Install the shunt calibration resistor/connector assembly into

the appropriate SHUNT CAL connector slot on the front

panel of the appropriate I/O Carrier Module.

/__\;/_
SHUNT CAL

1| —NWN— | +—

2| —ANN— | ]

3 —AA— | a—

4 | —\Wv— |

/_H\_,__/“

10 Option Slot 1 Shunt Cal. Resistor Location
/0 Option Slot 2 Shunt Cal. Resistor Location

/0 Option Slot 3 Shunt Cal. Resistor Location

10 Option Slot 4 Shunt Cal. Resistor Location

8. Verify that force is still zero.

While it is unlikely, it is possible for the force signal to change
when the control mode changes. If it does, select Auto Offset to
zero the force output.

9. Perform a shunt calibration.

Refer to “How to Perform a Shunt Calibration” in Chapter 2,
Common Tasks of the FlexTest SE User’s manual for a detailed

procedure.
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Shunt Calibration/Bridge Completion

1/0 Carrier Module

92

Shunt calibration
connector

On a typical system, shunt calibration and bridge completion resistor
installation is completed on the I/O Carrier module.

If you have purchased optional sensor cables with transducer ID
modules, shunt calibration and bridge resistors are installed on these

modules.

The 1I/O Carrier module has a shunt calibration connector on its front
panel that allows up to four shunt resistors (1 per slot) to be plugged
in. The SHUNT CAL connector is labeled to indicate which slot the
shunt calibration resistor is tied to.

Each shunt calibration resistor is soldered to a 2-pin holder (MTS part
number 114338-26). This holder plugs into the front panel connector
shown below. Refer to the 493.40/41 Carrier I/O Shunt Calibration Kit
(MTS part number 100-028-185) for more detailed information on kit
components and installation.

/\_/

SHUNT CAL
1| —"AN—
2| —AN—
3| —AnN—
4| AN

“— /0 Option Slot 1 Shunt Cal. Resistor Location
#——1/0 Option Slot 2 Shunt Cal. Resistor Location

“— /0 Option Slot 3 Shunt Cal. Resistor Location

“— /0 Option Slot 4 Shunt Cal. Resistor Location
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Bridge completion Each of the four I/O option card slots on the I/O Carrier module
circuits provides support for up to three bridge completion resistors as well as
a shunt calibration resistor. The bridge completion resistors can be
installed into sockets on the I/O Carrier printed wiring board. The
shunt calibration resistor sockets are accessible from the I/O Carrier

front panel.

The following figures show three typical bridge configurations for a
DC conditioner installed on an I/O Carrier module.

4 Wire Full Bridge
Bridge /O Carrier Conditioner

+FER
+FB 0

+EXS

+EX

Ron I}

Rshunt
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3 Wire Quarter Bridge

Gauge /O Carrier Conditioner
+FBR
0
F8 o
?
«EXS
EX E
Rg :1 : ‘*/\
RO
-EX
EXS I
FB é
FER f—‘
RCAL T
Rshunt
7 Wire Full Bridge
Bridge 1[0 Carrier Conditioner
<FBR
O
FEB 0
3
EXS
0
+EX
O
-EX O
-EXS
3
FB d)
FER GJD—“
RCAL —|—
Rshumt
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Chapter 6

Calibration

Contents

Prerequisite

Initial calibration

Model 493.02 Controller Service 95

This chapter describes how to calibrate the sensors connected to your
system. All sensors require calibration to ensure that their outputs
accurately represent the physical condition they sense (e.g., force or
displacement). When you calibrate a sensor you are calibrating the test
system to properly interpret the sensor signal.

Sensors included with your test system are usually factory-calibrated,
and the corresponding sensor calibration files are included with your
system software. If you change a sensor or add a new sensor to your
system, you must calibrate the new sensor/conditioner pair against a
standard to ensure the sensor’s accuracy.

You must calibrate all sensors before they can be used to support
control modes or auxiliary data channels.

Before You Begin 97

Calibrating an LVDT 99
Calibrating a Force Sensor 128
Calibrating an Extensometer 174

You must have a configuration file that includes the sensor(s) you wish
to calibrate.

If you are calibrating a sensor for the first time, you may find it
necessary to:

e  Perform an initial tuning of the sensor channel before calibration.

e Perform the procedure twice.
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Abbreviated procedures The abbreviated procedure provides an overview of the calibration
procedure for those who are experienced at calibrating sensors. The
abbreviated procedure lists the tasks and steps of the calibration
procedure. Each task and step includes the page number of the
detailed procedure where the task/step is fully explained.

Detailed procedures The detailed procedures follow the abbreviated procedures. They
provide an enhanced sequence of the calibration procedure for those
who are inexperienced at calibrating sensors. Each detailed procedure
is a step-by-step procedure arranged by tasks. Each task is a group of
detailed steps that accomplish a portion of the procedure. Some steps
include examples or helpful information.

Note  Procedures for "Automated Controllers” assumes the FlexTest SE
Controller is equipped with the PC-Supervision option, and that
Exclusive Control is assigned to Station Manager. For more
information about Station Manager, see the Model 793.00 System
Software manual that accompanies your system.
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Before You Begin

Before You Begin

System warm-up

Signal polarity

Model 493.02 Controller Service 97

Before you start sensor calibration, be sure the following are true:

e The sensors are properly connected to the controller
(see “Stand-Alone Cabling Overview” on page 41).

e A configuration file has been created that includes the hardware
resources associated with the sensors you want to calibrate.

e You have completed an initial, nominal tuning of the sensor
channel you are calibrating. This is especially important if you
have not calibrated the sensor before.

e  The hydraulics are warmed up (see System warm-up below).
e Conditioner Gain is set to 1 (3-stage servovalves only).
e You know your signal polarity (see Signal polarity below).

Be sure that both the hydraulic fluid and the servovalve are at
operating temperature before calibration. Remove any specimen and
run the system in displacement control for at least 30 minutes using a
80% full-scale length command at about 0.1 Hz.

Refer to “How to Warm Up Station Hydraulics” in the Chapter 2,
Common Tasks of the FlexTest SE User’s manual for a detailed
procedure.

Some test systems are configured to extend the actuator in response to
a positive command, while other test systems are configured to retract
the actuator in response to a positive command. Conditioner polarity
determines feedback polarity.

You must know how your test system is configured so you can
determine the appropriate polarity for the values used in this chapter.
The valve polarity is established first (see “Setting the Servovalve
Polarity” on page 73).
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Full-range
conditioners

The FlexTest SE controller uses a full-range conditioner. Consider the
following when calibrating sensors that use full-range conditioners,
such as the 493.25 DUC:

e  Full-range conditioners allow a gain/linearization calibration
option which require you to set up a linearized data table during
sensor calibration.

e  When using linearized data, you must retain copies of the initial
calibration report (containing non-linearized data) and the
calibration report after applying linearization.

e When calibrating sensors that use a full-range conditioner,
Electrical Zero Lock on the Offset/Zero menu must be set to
Lock. Readjustment of electrical zero after calibration will change
the point at which linearization takes place, disturbing other
calibration settings (especially delta K).
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Calibrating an LVDT

Prerequisites

What you will need

Important Notes

Calibration Types

Model 493.02 Controller Service 99

An LVDT is calibrated with a dial indicator or some other displacement
measuring device. Displacement is usually calibrated such that the
maximum extension and retraction represent +100% of the full-scale
capacity of the LVDT, with mid-displacement set at zero. Displacement
can also be calibrated to any range within the full-scale capacity of the
sensor. Also, ranges do not have to be centered on zero.

Be sure the items described in “Before You Begin” on page 97 are true.
An LVDT requires a digital universal conditioner (DUC) in AC mode to
process the feedback signal. You must know which conditioner is
connected to the LVDT.

Note If you are recalibrating a sensor, use the existing calibration values
as a starting point.

You will need a dial indicator gage (or for longer displacements a
measuring device such as a long ruler, laser, or optical detector) to
calibrate an LVDT. All calibration tools should also be calibrated to an
industry standard.

Note This calibration procedure calibrates the conditioner for an actuator
displacement of +10 cm. You will need to adjust the procedure to
accommodate your actuator displacement.

During calibration, Manual Offset should always be set to zero.

e  Ensure that Electrical Zero Lock on the Offset/Zero submenu is
set to Lock. After completing LVDT calibration, readjustment of
electrical zero will change the point at which linearization takes
place, disturbing other calibration settings (especially delta k).

e  Procedures for “Automated Controllers” assumes the FlexTest SE
Controller is equipped with the PC-Supervision option, and that
Exclusive Control is assigned to Station Manager. For more
information about Station Manager, see the Model 793.00 System
Software manual that accompanies your system.

The FlexTest SE controller’s full-range conditioner allows you to
choose Gain/Delta K or Gain/Linearization calibration for LVDTSs.

The other calibration types, mv/v Pos Tension and mv/v Pos Comp are
typically not used for LVDT calibration.
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Calibrating an LVDT

Pre-calibration tuning  Use the following procedure for initial tuning of the LVDT sensor
channel prior to calibration. Pre-tuning is especially important if the
LVDT has never been calibrated.

1. Select the Calibration access level.
Stand-Alone— Path: Config > Access Level > Calibration

Automated— On the Station Manager toolbar, select
Calibration in the User Level access box

2. Configure a meter to monitor displacement feedback.
Stand-Alone— Path: Meters > Meter 1 > Signal >Disp.

Automated— From the Display menu on the Station Manager
window, select Meters, and then set up to monitor displacement
feedback.

3. On the Inputs panel (Automated Systems Only), enter
Fullscale Min/Max values that conform with your sensor
specifications.

Typically, you should set the fullscale min/max values according
to the dynamic stroke rating of your actuator. The DYN STROKE
rating is usually printed on a nameplate on the side of the
actuator. For example, if the dynamic stroke rating of your
actuator is 102 mm, you should set your full-scale min to -51 mm
and your full-scale max to +51 mm.

4. Display the Calibration submenu or tab, then set and adjust
parameters.

Stand-Alone— Path: Setup > Disp > Calibration

Automated— Click the Channel Input Signals icon to open the
Inputs panel, and then click the Calibration tab

A. Enter fullscale Minimum/Maximum values that conform
with your sensor specifications (Stand-Alone systems only).

Set Excitation to 10 volts.
Adjust Post-amp Gain for a 5 volt readout on the meter.

Adjust Phase for the maximum output voltage on the meter.

= o0 O W

Adjust Post-amp Gain for a 9.5 volt readout on the meter.
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Calibrating an LVDT

. Set conditioner polarity to Normal (default) so that a positive

command extends the actuator.

Stand-Alone — Path: Setup > Disp > Calibration > Polarity >
Normal

Automated — On the Calibration tab, select Normal for
conditioner Polarity.

. Check to ensure that the polarity of the servovalve signal is set

correctly. See “Setting the Servovalve Polarity” on page 73.
Stand-Alone — Path: Setup > Output > Polarity

Automated — Click the Channel Drive icon to open the
Channel Drive panel, then click the Valve tab.

Check the valve polarity setting. If you do not know what polarity
to use for your servovalve, select Normal (default).

. Set P Gain to 0.5

Stand-Alone — Path: Tuning > P Gain

Automated — From Station Setup, click the Channel Tuning
icon, click the Adjustments tab, and then set P Gain.

. Ensure that displacement control mode is selected.

Stand-Alone — Path: Status > Control Mode > Disp.

Automated — Check Control Mode on the Station Manager
Function Generator panel.

. Ensure that the Span is set for 100%.

Stand-Alone — Path: Status > Span

Automated — Check the Master Span setting on the Station
Controls panel
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10.

Check hydraulic and program interlock indicators.

Stand-Alone — If the Hydraulic Interlock or Program
Interlock indicator is lit on the front panel, determine the cause,
correct it, and then click Reset.

Automated — If the Interlock or Program indicator is lit on the
Station Controls panel, determine the cause, correct it, and then
click Reset or Reset/Override.

If either interlock indicator lights again, you will need to
determine the cause of the interlock and correct it before
proceeding.

____________________________________________________________________________________________|
Do not place any part of your body in the path of a moving actuator.

A crush zone exists between the actuator and any equipment in the
path of its movement. Imnmediate and unexpected actuator response is
possible when you apply hydraulic pressure to your system. If
servovalve polarity and/or conditioner polarity are set incorrectly, the
actuator may move with full force.

Stay clear of the actuators when applying hydraulic pressure.
|

11.

12.

Apply power to the hydraulic service manifold (HSM).
Stand-Alone — Click the HSM Low button, and then HSM High.

Automated — In the power selection box, click the Power Low
button, and then Power High

Check the movement of the actuator.

Perform this step to verify that the actuator moves as you want.

Stand-Alone— Enable the front panel Dial, and then use the Dial
to increase the Setpoint adjustment for a positive command.

Automated — Open the Manual Command window, and then
click on the Enable Manual Command check box to enable
manual command. Increase the Manual Cmd adjustment for a
positive command.

Note The following conditions assume you want a positive command to

extend the actuator.
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Actuator fully retracted A. If the actuator is fully retracted and applying a positive
or extended Setpoint or Manual Cmd does not extend it, zero the
command, remove hydraulic pressure, and change the
servovalve polarity. Then retry this test. If it still does not
move, return to Step 7 and increase the gain setting.

e If the actuator is fully extended and applying a negative
Setpoint or Manual Cmd does not retract it, zero the
command, remove hydraulic pressure, and change the
servovalve polarity. Then retry this test. If it still does not
move, return to Step 7 and increase the gain setting.

Actuator not fully If the actuator does not move at all, return to Step 7 and
retracted or extended increase the gain setting.

e If the actuator retracts, the servovalve polarity is correct.

e If the actuator extends, the servovalve polarity must be
reversed. Check the Polarity setting and change it (from
Normal to Inverted or vice versa).

B. Check the movement of the actuator. Use the Dial to adjust
Setpoint or the slider to adjust Manual Cmd to extend and
retract the actuator.

13. Display the Function Generator application

Stand-Alone — Click FG on the front panel menu to display the
Function Generator menu.

Automated — In the Station Manager navigation pane, click the
Function Generator icon to display the Function Generator
panel.

14. Set up the Function Generator with the following settings:

CONTROL SETTING

Control Mode Displacement

Compensator None

Target Setpoint 0

Amplitude 5% of full scale mn

Frequency 1 Hz S
=,

Wave Shape square =
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15.

16.
17.

18.

Set up scope parameters to display the channel’s command and
feedback signals.

Stand-Alone — Select Scope on the front panel.

Automated — In the Station Manager toolbar, click the Scope
button to display the Scope window.

Click Program Run to start the function generator.

Increase P Gain while observing the displacement feedback
signal.

Stand-Alone — Path: Tuning > P Gain

Automated — On the Tuning panel Adjustments tab, increase P
Gain

Initial tuning is achieved when the displacement feedback signal
approximates the square wave as shown below:

N

Gain Too Low Optimum Gain Gain Too High
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Abbreviated Procedure

Online readers All procedure entries are hypertext links.
Click on any entry to jump to the corresponding page.

The following abbreviated procedure outlines a displacement sensor
(LVDT) calibration process. More detailed calibration information is
available on the pages listed.

Task 1, “Get things ready,” on page 106

Task 2, “Turn on hydraulic pressure,” on page 108
Task 3, “Verify the conditioner polarity,” on page 109
Task 4, “Set the phase,” on page 110

Task 5, “Set the zero and offset,” on page 111

Task 6, “Gain/Delta K Calibration,” on page 114
Task 7, “Gain/Linearization Calibration,” on page 119

Task 8, “Save the calibration,” on page 127
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Task1 Get things ready

Perform the following before you start sensor calibration.

1. Locate relevant documentation.

¢ You need information about the sensor such as the serial
number, model number, excitation voltage,
displacement, etc. This information can be found on the
appropriate Calibration Data sheet included with your
system, or the Final Inspection card included with all
MTS sensors.

*  You need calibration identification numbers for any
calibration tools that will be used for this calibration
procedure (e.g., the dial indicator used for LVDT
calibration). The calibration information is usually on a
sticker attached to the equipment.

e You need the appropriate DUC Conditioner serial
number.

2. Select the Calibration access level.
Stand-Alone— Path: Config > Access Level > Calibration

Automated— In the Station Manager window toolbar, select
Calibration

3. Set up a signal monitor.

You will be monitoring the sensor output when making
adjustments throughout this procedure. You can monitor the
sensor output in the same units that you are using for the
calibration.

You can use an external DVM to monitor sensor output from a
BNC connector located on the FT SE Controller front panel.

You can also use the Meters window to monitor sensor output.

For Automated systems, you can also use the Station Signals
panel to monitor sensor output. On the Station Manager Display
menu, select Station Setup. In the navigation pane, select Station
Signals to display the Station Signals panel to monitor current
values for user-defined signals.
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Calibrating an LVDT

For more information on using the Station Signals panel, refer to
“About the Station Signals Panel” in Chapter 3, Station Manager of
the Model 793.00 System Software manual.

4. Select the desired calibration type.
Stand-Alone— Path: Setup > Disp > Calibration > Cal Type

Automated — On the Station Setup Inputs panel Calibration
tab, use Cal Type for your selection

5. On the Calibration submenu or tab, set the following initial
conditioner calibration values:

CONTROL SETTING
Polarity Normal
Pre-Amp Gain 1.0
Post-Amp Gain 1.5
Excitation 10 volts
Phase 45°
Delta K 1
(Gain/Delta K

calibration only)

Fine Zero 0
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Task2  Turn on hydraulic pressure

This task activates the hydraulic pressure.

____________________________________________________________________________________________|
A\ WARNING Do not place any part of your body in the path of a moving actuator.

A crush zone exists between the actuator and any equipment in the
path of its movement. Inmediate and unexpected actuator response is
possible when you apply hydraulic pressure to your system.

Stay clear of the actuators when applying hydraulic pressure.
. ________________________________________________________________________________________]

1. Ensure that displacement control mode is selected.
Stand-Alone — Path: Status > Control Mode > Disp.

Automated — Check Control Mode on the Station Manager
Function Generator panel.

2. Ensure that the Span is set for 100%.
Stand-Alone — Path: Status > Span

Automated — Check the Master Span setting on the Station
Controls panel

3. Check hydraulic and program interlock indicators.

Stand-Alone — If the Hydraulic Interlock or Program
Interlock indicator is lit on the front panel, determine the cause,
correct it, and then click Reset.

Automated — If the Interlock or Program indicator is lit on the
Station Controls panel, determine the cause, correct it, and then
click Reset or Reset/Override.

If either interlock indicator lights again, you will need to
determine the cause of the interlock and correct it before
proceeding.

4. In the power selection box, click the Low button, and then High
for the HPU. If an HPU is not listed, start the HPU at the pump.

5. If an HSM is present, click the Low button, and then High for the
HSM.
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Task3  Verify the conditioner polarity

This task checks the polarity of the conditioner. Different types of test
systems are configured with different conditioner polarities. The
polarity of the conditioner, the polarity of the valve driver, and the
orientation of system cabling all play a role in controlling the actuator
and determining how signals are displayed. This procedure assumes
the servovalve polarity is set to Normal on the Station Setup Drive
panel Valve tab.

1. Check the sensor connection.
Be sure the displacement sensor is properly connected.
2. Apply a positive actuator command.

Stand-Alone— Enable the front panel Dial, and then use the Dial
to increase the Setpoint adjustment for a positive command.

Automated — Open the Manual Command window, and then
click on the Enable Manual Command check box to enable
manual command. Increase the Manual Cmd adjustment for a
positive command.

3. Monitor the displacement feedback.

If the signal value is positive for actuator extension, the
conditioner polarity is correct. If desired, you can change the
conditioner polarity to make the signal value negative for actuator
extension.
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Task4 Setthe phase

This task determines the proper phase adjustment. The phase
adjustment matches the phase of the AC feedback signal to the 10 kHz
demodulation excitation signal.

1. Fully retract the actuator.

Stand-Alone— Using the front panel Dial, adjust the Setpoint to
fully retract the actuator. Path: Status > Setpoint

Automated— Adjust the Manual Cmd slider control on the
Manual Command window to fully retract the actuator.

2. Remove hydraulic pressure.
3. Adjust phase for the maximum conditioner output.

Monitor the appropriate AC conditioner feedback signal. Adjust
Phase to achieve a maximum value.

Stand-Alone—Path: Setup > Disp > Calibration > Phase

Automated—Adjust the Phase control on the Calibration tab to
achieve a maximum value. For automated systems, use the
Station Signals panel to monitor the appropriate AC conditioner
feedback signal

Note  When adjusting phase, the LVDT feedback may exceed 10 volts. You
may need to lower conditioner gain before continuing phase
adjustment.
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Task5 Set the zero and offset

Establishing zero requires the actuator to be set at mid-displacement
when you calibrate the LVDT for equal amounts of actuator extension
and retraction.

Suppose you have an actuator with £10 cm displacement—which
actually has a 20 cm displacement. Setting zero at mid-displacement
produces a displacement of +10 cm (this is the most common
approach). However, you can set zero anywhere within the full scale
of the sensor, such as with the actuator fully extended or retracted to
produce a displacement range of 0 mm - 20 mm.

Before beginning, ensure the following are true:

e The Fine Zero adjustment is set to 0.
Stand-Alone—Path: Setup > Disp > Calibration > Fine Zero
Automated—Adjust Fine Zero on the Calibration tab.

e The Manual Offset is set to 0.

Stand-Alone—Path: Setup > Disp > Offset/Zero > Manual
Offset

Automated—Adjust Manual Offset on the Offset/Zero tab.
e The Electrical Zero adjustment is set to 0.

Stand-Alone—Path: Setup > Disp > Offset/Zero > Electrical
Zero

Automated—Adjust Electrical Zero on the Offset/Zero tab
1. Mount the displacement measuring device.

Mount the measuring device to measure the distance between the
end of the actuator’s piston rod and a stationary point such as the
actuator’s upper endcap. There are a variety of ways to measure
actuator displacement:

e  Dial Indicator
e  Tape Measure/Ruler

e  Optical Detector
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e Encoder

I ——

e You may need to place the dial
indicator on a block to measure the
mid-displacement position.

I e Be sure to zero the dial indicator after
you position it properly.

2. Ensure that displacement control mode is selected.
Stand-Alone — Path: Status > Control Mode > Disp.

Automated — Check Control Mode on the Station Manager
Function Generator panel.

3. Evaluate the mid-displacement position for the actuator.
Stand-Alone:
A. Enable the front panel Dial.

B. Use the Dial to increase the Setpoint adjustment for a
positive command.

Path: Status > Setpoint

C. Adjust the Setpoint to fully extend the actuator and note the
displacement signal value.

D. Adjust the Setpoint to fully retract the actuator and note the
displacement signal value.
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Automated:

A.  Move the Manual Cmd slider to apply a positive command
(extend the actuator).

B. Adjust the Manual Cmd slider to fully extend the actuator
and note the displacement signal value in the Station Signals
panel.

C. Adjust the Manual Cmd slider to fully retract the actuator and

note the displacement signal value in the Station Signals
panel.

The noted displacement signal values should be within 1% of each
other.

If these displacement signals are not within 1%, you can evaluate
the following procedures to establish the zero reference:

Use the Fine Zero adjustment to shift the sensor
conditioner’s zero reference position.

Stand-Alone— Path: Setup > Disp > Calibration > Fine
Zero

Automated— Adjust Fine Zero on the Calibration tab.

In some cases, a mechanical adjustment may be necessary to
center the LVDT (for instructions, see the actuator product
manual).
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Calibrating an LVDT

Task 6

Gain/Delta K Calibration

14

Calibrate actuator
retraction

Gain controls

If you using Gain/Delta-K for your calibration type, complete the
following procedure. If not, complete Task 7 Gain/Linearization
Calibration on page 119

LVDTs can be N
calibrated so that a
positive output
represents actuator
extension and a
negative output
represents actuator
retraction, or vice
versa.

Indicated output

mechanical input g
You calibrate the
negative side of the
output with gain and
the positive side of
the output with Delta
K.

Delta K compensates
for differences in symmetry between the positive and negative outputs.

You should calibrate actuator extension at 80% of the full scale range.

Pre-Amp gain is a selectable gain amplifier with predefined values.
Since changes in Pre-Amp gain can cause spikes in the feedback
signal, Pre-Amp gain can only be adjusted when hydraulics are off.

Post-Amp gain is a finer, operator-defined gain control that can be
adjusted when hydraulics are on.

The Total Gain value is calculated by multiplying the Pre-Amp and
Post-Amp gain values. If the total desired gain amount is known (from
a calibration sheet), you can enter the amount in the Total Gain box
and the software will calculate the Pre-Amp and Post-Amp gain
values automatically.

When you are calibrating an AC conditioner, use the Post-Amp gain
control to increase gain. If more gain is needed, you must disable
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hydraulics and increase the Pre-Amp gain. You can then turn on
hydraulics and continue to adjust the Post-Amp gain.

Note This procedure assumes a positive command extends the actuator
and a negative command retracts the actuator. If not, use the
opposite polarity for any values given.

Procedure 1. Select Gain/Delta-K for Cal Type.

Stand-Alone— Path: Setup > Disp > Calibration > Cal Type >
Gain/Delta-K

Automated— Select Gain/Delta-K for Cal Type on the
Calibration tab of the Inputs panel.

2. Apply a retraction command that is 80% of the full scale range.
Stand-Alone:
A. Enable the front panel Dial.

B. Use the Dial to adjust the Setpoint for 80% of the full scale
range.

C.  Verify that your LVDT displacement signal equals 80% of the
full scale range.

Automated:

A.  Open the Manual Command window, and then click on the
Enable Manual Command.

B. Adjust the Manual Cmd slider on the Manual Command
window for 80% of the full scale range.

C. Use the Station Signals panel to verify that your LVDT
displacement signal equals 80% of the full scale range.

During the initial calibration and tuning of your system, it may
take repeated adjustment for the two values to match.

Note [f the actuator response is sluggish andy/or the signal value does not
match the command, you will need to adjust the tuning of this
control mode. Increase the proportional gain (P Gain on the Tuning
menu) to correct sluggish actuator movement. Increase the reset
integration value (I Gain) to help the feedback match the command.
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At this point, unless the conditioner is already in calibration, the
actuator’s physical retraction will not equal your commanded
value. You will adjust gain in the next step so that the actuator’s
physical retraction and your commanded retraction match.

Example: Suppose your actuator has a 100% retraction of -10 cm.
In this step you would apply a -8 cm command, and even though
the station signals would read -8 cm of feedback, the actuator may
retract only -4 cm. This shows the conditioner/sensor pair are out
of calibration.

3. Adjust gain to retract the actuator until it equals your retraction
command.

Adjust Post-Amp Gain until your dial indicator or other readout
device shows that the actuator’s physical retraction equals your
retraction command.

Note This procedure assumes a positive command extends the actuator
and a negative command retracts the actuator. If not, use the
opposite polarity for any values given.

Calibrate actuator 4. Apply an extension command that is 80% of the full scale range
extension
Stand-Alone:
A. Enable the front panel Dial.

B. Use the Dial to adjust the Setpoint for 80% of the full scale
range.

C.  Verify that your LVDT displacement signal equals 80% of the
full scale range.

Automated:

A.  Open the Manual Command window, and then click on the
Enable Manual Command.

B. Adjust the Manual Cmd slider on the Manual Command
window for 80% of the full scale range.

C. Use the Station Signals panel to verify that your LVDT
displacement signal equals 80% of the full scale range.

During the initial calibration and tuning of your system, it may
take a while for the two values to match.

Note [f the actuator response is sluggish and/or the signal value does not
match the command, you will need to adjust the tuning of this
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control mode. Increase the proportional gain (P Gain on the Tuning
menu) to correct sluggish actuator movement. Increase the reset
integration value (I Gain) to help the feedback match the command.

At this point, unless the conditioner is already calibrated, the
actuator’s physical extension will not equal your commanded
value. You will adjust Delta K in the next step so that the
actuator’s physical extension and your commanded extension
match.

Example: Suppose your actuator has a 100% extension of 10 cm.
In this step you would apply a 8 cm command, and even though
the station signals would read 8 cm of feedback, the actuator may
extend only 4 cm. This shows the conditioner/sensor pair are out
of calibration.

5. Adjust Delta K to extend the actuator until it equals your
extension command.

Adjust Delta K until the dial indicator or other readout device
shows that the actuator’s physical extension equals your extension
command.

Record data points The accuracy tolerance of your data depends on the manufacturer of
your sensor. Your sensor should include a calibration data sheet that
shows the data point tolerance. Sensors from MTS include a sensor
calibration data sheet that shows the data points as it was calibrated.

1. Record the data points for LVDT extension.
Stand-Alone:
A. Adjust the Setpoint to achieve zero command.
B. Adjust the dial indicator for a zero reference.

C. Adjust the Setpoint to 20% extension and record the dial
indicator reading. Repeat this step for 40%, 60%, 80%, and
100% actuator extension.

Automated:
A. Adjust the Manual Cmd slider to achieve zero command.
B. Adjust the dial indicator for a zero reference.

C. Adjust the Manual Cmd slider to 20% extension and record
the dial indicator reading. Repeat this step for 40%, 60%, 80%,
and 100% actuator extension.
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2. Record the data points for LVDT retraction.
Stand-Alone:
A. Adjust the Setpoint to achieve zero command.
B. Adjust the dial indicator for a zero reference.

C. Adjust the Setpoint to 20% retraction and record the dial
indicator reading. Repeat this step for 40%, 60%, 80%, and
100% actuator retraction.

Automated:
A. Adjust the Manual Cmd slider to achieve zero command.
B. Adjust the dial indicator for a zero reference.

C. Adjust the Manual Cmd slider to 20% retraction and record
the dial indicator reading. Repeat this step for 40%, 60%, 80%,
and 100% actuator retraction.
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Task 7 Gain/Linearization Calibration

If you are using Gain/Linearization for your calibration type,
complete the following procedure. If not, complete Task 6 Gain/Delta
K Calibration on page 114.

Important  Using linearization data requires specific conditioner zeroing
practices. Ensure that Electrical Zero Lock on the Offset/
Zero menu is set to Locked. Adjusting electrical zero after
calibration may invalidate linearization data.

Initial LVDT For initial calibration of an LVDT complete the following procedure:

calibration
1. Select Gain/Linearization for Cal Type.

Stand-Alone— Path: Setup > Disp. > Calibration > Cal Type >
Gain/Linearization

Automated— Select Gain/Linearization for Cal Type on the
Calibration tab of the Inputs panel.

2. Apply a retraction command that is 80% of the full scale range.
Stand-Alone:
A. Enable the front panel Dial.

B. Use the Dial to adjust the Setpoint for 80% of the full scale
range.

C.  Verify that your LVDT displacement signal equals 80% of the
full scale range.

Automated:

A. Open the Manual Command window, and then click on the
Enable Manual Command.

B. Adjust the Manual Cmd slider on the Manual Command
window for 80% of the full scale range.

C. Use the Station Signals panel to verify that your LVDT
displacement signal equals 80% of the full scale range.

During the initial calibration and tuning of your system, it may
take repeated adjustment for the two values to match.
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Note [If the actuator response is sluggish and/or the signal value does not
match the command, you will need to adjust the tuning of this
control mode. Increase the proportional gain (P Gain on the
Calibration submenu or tab) to correct sluggish actuator
movement. Increase the reset integration value (I Gain) to help the
feedback match the command.

At this point, unless the conditioner is already in calibration, the
actuator’s physical retraction will not equal your commanded
value. You will adjust gain in the next step so that the actuator’s
physical retraction and your commanded retraction match.

Example: Suppose your actuator has a 100% retraction of -10 cm.
In this step you would apply a -8 cm command, and even though
the station signals would read -8 cm of feedback, the actuator may
retract only -4 cm. This shows the conditioner/sensor pair are out
of calibration.

3. Adjust gain to retract the actuator until it equals your retraction
command.

Path: Setup > Disp. > Calibration > Cal Type > Gain/
Linearization > Post-Amp Gain

Adjust Post-Amp Gain on the Calibration submenu or tab until
your dial indicator or other readout device shows that the
actuator’s physical retraction equals your retraction command.

4. Record dial indicator and conditioner feedback readings at
predetermined retraction command points.

Note  After shutting down system hydraulics, you will enter these
recorded readings on the Linearization Data window.

Stand-Alone:

Use the Dial to adjust the Setpoint for a 0% command.

B. Record the dial indicator value for the 0% command.
C. Enter the corresponding conditioner feedback reading.
D. Use the Dial to adjust the Setpoint for a -2% retraction

command.

E. Record the dial indicator value and conditioner feedback at
the -2% row of your record sheet.
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Calibrating an LVDT

F.  Repeat steps D and E for other retraction commands
(typically at -4, -6, -8, -10, -20, -40, -70, and -100 percent of
full scale).

Automated:

A.  Adjust the Manual Cmd slider for a 0% command.

B. Record the dial indicator value for the 0% command.

C. Enter the corresponding conditioner feedback reading in the
Conditioner column at the appropriate row in the window.

D. Adjust the Manual Cmd slider for a -2% retraction command.
Record dial indicator value and conditioner feedback at the -
2% row of your record sheet.

F. Repeat steps D and E for other retraction commands

(typically at -4, -6, -8, -10, -20, -40, -70, and -100 percent of
full scale).

. Record dial indicator and conditioner feedback readings at

predetermined extension command points.

Stand-Alone:

A.

Use the Dial to adjust the Setpoint for a +2% extension
command.

B. Record the dial indicator and conditioner feedback values at
the +2% row of your record sheet.

C. Repeat steps A and B for other extension commands
(typically at +4, +6, +8, +10, +20, +40, +70, and +100 percent
of full scale).

Automated:

A. Adjust the Manual Cmd slider for a +2% extension
command.

B. Record the dial indicator value and conditioner feedback at
the +2% row of your record sheet.

C. Repeat steps A and B for other extension commands

6. Turn off system hydraulics.

(typically at +4, +6, +8, +10, +20, +40, +70, and +100 percent
of full scale)
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7. On the Linearization Data window, enter the dial indicator and
conditioner feedback readings for all command points previously

recorded.

Stand-Alone— Path: Setup > Disp > Calibration > Cal Type >
Gain/Linearization > Linearization Data

ization D'ata
tandard Conditioner
-10.000:
=T0.0000|  9.9900 i
-8.0000:
=5.0000  F.9900 mm
-6.0000:
=6.0000 59800 mm
-4.0000:
=.0000  3.9900 mm
-2.0000:
20000  7.9900 rm
0.00000;
0.0000  0.0000 rom
2.0000:
20000 19900 |

Automated— Click Linearization Data on the Calibration tab
to open the Linearization Data window.

[ Linearization Data

~Fullzzale Mindda
| -1.DDDD| 'I.DDDD|cm

—DataRange——
Fram: To I‘IDD"/e 'l Reset I

Recommended Standard Caonditioner
RLENY  0.08000 | 0.08000 cm [
-0,060000;
0040000
-0.020000:
XS 00000 [ 0.00000 o R
0,020000:
0040000
0,060000;
0080000 =

8. Turn on system hydraulics.
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LVDT recalibration If the LVDT has been previously calibrated, use the following

procedure:

1. Locate the calibration data sheet for the appropriate conditioner.

2. Ensure that system hydraulics is off.

3. Open the Linearization Data window.

Stand-Alone—Path: Setup > Disp > Calibration > Cal Type >
Gain/Linearization > Linearization Data

Automated— Click Linearization Data on the Calibration tab
to open the Linearization Data window.

4. Transfer Standard and Conditioner data from the conditioner’s
calibration data sheet to corresponding data entries on the
Linearization Data window.

5. Turn on system hydraulics.

6. Verify the linearization data.

Model 493.02 Controller Service

Stand-Alone:

A. Using the front panel Dial, adjust the Setpoint for each
retraction and extension command point on the Linearization
Data window.

B. At each command point, verify both the dial indicator value
(Standard) and its corresponding conditioner feedback value
(Conditioner) with the corresponding values on the
Calibration Data sheet.

Automated:

A. Adjust the Manual Cmd slider for each retraction and
extension command point on the Linearization Data window.

B. At each command point, verify both the dial indicator value
(Standard) and its corresponding conditioner feedback value
(Conditioner) with the corresponding values on the
Calibration Data sheet

If the data is valid: Stop this procedure.
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If the data is not valid: Proceed to the next step.
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7. Reset Linearization Data window to default values.

Stand-Alone—Path: Setup > Disp > Calibration > Cal Type >
Gain/Linearization > <<Reset>>

Automated— Click Reset on the Linearization Data window.
8. Apply a retraction command that is 80% of the full scale range.

Stand-Alone:

A. Use the front panel Dial to adjust the Setpoint for 80% of the
full scale range. Path: Status > Setpoint

B. Verify that your LVDT displacement signal equals 80% of the
full scale range.

Automated:

A.  Adjust the Manual Cmd slider on the Manual Command
window for 80% of the full scale range.

B. Use the Station Signals panel to verify that your LVDT
displacement signal equals 80% of the full scale range.

During the initial calibration and tuning of your system, it may
take repeated adjustment for the two values to match.

Note [f the actuator response is sluggish andy/or the signal value does not
match the command, you will need to adjust the tuning of this
control mode. Increase the proportional gain (P Gain on the Tuning
menu) to correct sluggish actuator movement. Increase the reset
integration value (I Gain) to help the feedback match the command.

At this point, unless the conditioner is already in calibration, the
actuator’s physical retraction will not equal your commanded
value. You will adjust gain in the next step so that the actuator’s
physical retraction and your commanded retraction match.

Example: Suppose your actuator has a 100% retraction of -10 cm.
In this step you would apply a -8 cm command, and even though
the station signals would read -8 cm of feedback, the actuator may
retract only -4 cm. This shows the conditioner/sensor pair are out
of calibration.
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9.

10.

Calibrating an LVDT

Adjust gain to retract the actuator until it equals your retraction
command.

Stand-Alone— Path: Setup > Disp > Calibration > Cal Type >
Gain/Linearization > Post-Amp Gain

Automated— Adjust the Post-Amp Gain slider control on the
Calibration tab

Adjust Post-Amp Gain until your dial indicator or other readout
device shows that the actuator’s physical retraction equals your
retraction command.

Record dial indicator and conditioner feedback readings at
predetermined retraction command points.

Note  After shutting down system hydraulics, you will enter these

Model 493.02 Controller Service

recorded readings on the Linearization Data window.

Stand-Alone:

A. Use the front panel Dial to adjust the Setpoint for a 0%
command.

B. Record the dial indicator value at 0% command.

C. Record the corresponding conditioner feedback reading on
your record sheet.

D. Use the Dial to adjust the Setpoint for a -2% retraction
command.

E. Record the dial indicator value and conditioner feedback at
the -2% row of your sheet.

F. Repeat steps D and E for other retraction commands
(typically at -4, -6, -8, -10, -20, -40, -70, and -100 percent of
full scale).

Automated:
A.  Adjust the Manual Cmd slider for a 0% command.
B. Record the dial indicator value at 0% command.

C. Record the corresponding conditioner feedback reading at
the 0% row of your record sheet.

D. Adjust the Manual Cmd slider for a -2% retraction command.
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E. Record the dial indicator and conditioner feedback values at
the -2% row of your record sheet.

F. Repeat steps D and E for other retraction commands
(typically at -4, -6, -8, -10, -20, -40, -70, and -100 percent of
full scale).

11. Record dial indicator and conditioner feedback readings at
predetermined extension command points.

Stand-Alone:

A. Use the front panel Dial to adjust the Setpoint for a +2%
extension command.

B. Record the dial indicator value and conditioner feedback at
the +2% row of your record sheet.

C. Repeat steps A and B for other extension commands
(typically at +4, +6, +8, +10, +20, +40, +70, and +100 percent
of full scale).

Automated:

A. Adjust the Manual Cmd slider for a +2% extension
command.

B. Record the dial indicator value and conditioner feedback at
the -2% row of your record sheet

C. Repeat steps A and B for other extension commands
(typically at +4, +6, +8, +10, +20, +40, +70, and +100 percent
of full scale).

12. Turn off system hydraulics.
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13. On the Linearization Data window, enter the dial indicator and
conditioner feedback readings for all command points previously
recorded on a separate sheet.

14. Turn on system hydraulics.
15. Verify linearization data.
Stand-Alone:

A. Using the front panel Dial, adjust the Setpoint for each
retraction and extension command point on the Linearization
Data window.

B. At each command point, verify both the dial indicator value
(Standard) and its corresponding conditioner feedback value
(Conditioner).

C. Check validity before entering each pair of values on a new
Calibration Data Sheet.

Automated:

A. Adjust the Manual Cmd slider for each retraction and
extension command point on the Linearization Data window.

B. At each command point, verify both the dial indicator value
(Standard) and its corresponding conditioner feedback value
(Conditioner).

C. Check validity before entering each pair of values on a new
Calibration Data Sheet.

Task 8 Save the calibration

It is important that you save your sensor calibration values.
Stand-Alone— Path: Setup > Open/Save Parameters > <<Save>>

Automated— Click Save on the Calibration tab to save the current
calibration values to the sensor calibration file.
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Calibrating a Force Sensor

Calibrating a Force Sensor

A force sensor (also called a load cell) is calibrated with a load
standard. It is calibrated such that the maximum compression and
tension represent £100% of the full-scale capacity of the force sensor,
with zero force set at midcapacity.

Prerequisites Be sure the items described in “Before You Begin” on page 97 are true.
A force sensor requires a Digital Universal Conditioner (DUC)
configured for the DC mode that processes a DC feedback signal. You
must know which conditioner is connected to the sensor.

Initial calibration  If you are calibrating a sensor for the first time, you may find it
necessary to:

e  Perform an initial tuning of the sensor channel before calibration.
e  Perform the procedure twice.

Recalibration  If you are recalibrating a sensor, use the existing calibration values as a
starting point.

What you will need You will need the following items to calibrate a a force sensor. All
calibration tools should also be calibrated to an industry standard.

e A load standard can be a calibrated force sensor with its own
electronics or it can be a calibrated set of dead weights.

Note This calibration procedure calibrates the DC conditioner for a force
sensor of £10 kN. You will need to adjust the procedure to
accommodate your force sensor.

e A DVM to monitor the output of the load standard.

Calibration Types The FlexTest SE controller’s full-range conditioner allows you to
choose Gain/Delta K, Gain/Linearization, mV/V Positive Tension, or
mV/V Positive Compression calibration.

Important note  Procedures for “Automated Controllers” assumes the FlexTest SE
Controller is equipped with the PC-Supervision option, and that
Exclusive Control is assigned to Station Manager. For more information
about Station Manager, see the Model 793.00 System Software manual
that accompanies your system.
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Abbreviated Procedure

Online Readers All procedure entries are hypertext links.
Click on any entry to jump to the corresponding page.

The following abbreviated procedure outlines a force sensor (load cell)
calibration process. More detailed calibration information is available
on the pages listed.

Task 1, “Get things ready,” on page 130

Task 2, “Turn on hydraulic pressure,” on page 132

Task 3, “Verify the conditioner polarity,” on page 133

Task 4, “Set the zero and offset,” on page 134

Task 5, “Gain/Delta K Calibration,” on page 135

Task 6, “Gain/Linearization Calibration,” on page 142

Task 7, “Millivolt/Volt Calibration,” on page 153

Task 8, “Establish the shunt calibration reference,” on page 157

Task 9, “Save the calibration,” on page 160
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Task1 Get things ready

Perform the following before you start sensor calibration.

1. Locate relevant documentation (e.g., sensor information,
conditioner serial number, and calibration tool ID numbers)

2. Set up to monitor load standard output.
3. Select the Calibration access level.
Stand-Alone— Path: Config > Access Level > Calibration

Automated— In the Station Manager window toolbar, select
Calibration

4. Set up a signal monitor.

You will be monitoring the sensor output when making
adjustments throughout this procedure. You can monitor the
sensor output in the same units that you are using for the
calibration.

You can use an external DVM to monitor sensor output from a
BNC connector located on the FT SE Controller front panel.

You can also use the Meters window to monitor sensor output.

For Automated systems, you can also use the Station Signals
panel to monitor sensor output. On the Station Manager Display
menu, select Station Setup. In the navigation pane, select Station
Signals to display the Station Signals panel to monitor current
values for user-defined signals.

For more information on using the Station Signals panel, refer to
“About the Station Signals Panel” in Chapter 3, Station Manager of
the Model 793.00 System Software manual.
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5. Mount the force standard.

The illustration shows a load
standard in-line with the force @ = @

train coupled with the force ) °
sensor.

. o o
The load standard reacts like a °
stiff specimen. Be sure the — o

: - T T
gain settings (PID) for the <«—— Force Transducer
control mode are appropriate.

If the control mode has not N <— Load Standard

been tuned yet, use some
default values. Then recalibrate
the sensor after the initial
tuning.

6. If you using the Gain/Delta K or Gain/Linearization for calibration,
set the following initial conditioner calibration values on the
Calibration submenu.

Control Setting
Polarity Normal
Pre-amp Gain 480
Post-amp Gain 1
Total Gain 500
Excitation 10 volts
Fine Zero 0
Zero/Balance 0

Delta K (Gain/Delta K 1
calibration only)
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Task2  Turn on hydraulic pressure

A WARNING Do not place any part of your body in the path of a moving actuator.

A crush zone exists between the actuator and any equipment in the
path of its movement. Imnmediate and unexpected actuator response is
possible when you apply hydraulic pressure to your system.

Stay clear of the actuators when applying hydraulic pressure.

See “Turn on hydraulic pressure” on page 108 for a detailed
procedure.
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Task3  Verify the conditioner polarity

This task checks the polarity of the conditioner. Different types of test
systems are configured with different conditioner polarities. The
polarity of the conditioner, the polarity of the valve driver, and the
connection positions of system cabling all play a role in controlling the
actuator and determining how signals are displayed.

This procedure assumes the servovalve polarity is set to Normal on
the Station Setup Drive panel Valve tab.

1. Check the sensor connection.

Be sure the force sensor is properly connected to the rear panel of
the controller.

2. Apply a load to the force sensor.

Push on the force sensor (with your hand) and note the signal
value on the DVM, front panel meter (stand-alone), or Station
Signals (automated).

If the signal value is positive for actuator compression, the
conditioner polarity is correct. If desired, you can change the
conditioner polarity to make the signal value negative for actuator
compression.
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Task4 Set the zero and offset

This task records the load standard readout as the zero reference.

Using a load standard ~ Stand-Alone — Adjust the Setpoint for 0 kN. Then zero the load
standard readout. Path: Status > Setpoint

Automated — Adjust the Manual Cmd slider on the Manual
Command window for 0 kN. Then zero the load standard readout.

Using dead weights ~ Stand-Alone— Remove all dead weights, and then click Auto Offset
on the Offset/Zero menu. Path: Setup > Force > Offset/Zero >
<<Auto Offset>>

Automated— Remove all dead weights, and then click Auto Offset
on the Offset/Zero tab (Inputs panel).
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Task5 Gain/Delta K Calibration

Calibrate tension

Gain controls

Model 493.02 Controller Service 135

If you using Gain/Delta-K for your calibration type, complete the
following procedure. If not, complete Task 6 Gain/Linearization
Calibration on page 142 or Task 7 Millivolt/Volt Calibration on
page 153

Force sensors can be calibrated so that a positive output represents
actuator compression and a negative output represents actuator
tension, and vice versa.

You calibrate the 4
negative side of the AK > 1
output with gain and Indicated output [ TTTTTTTTTTTTUALY '
the positive side of
the output with Delta
K.

Delta K compensates
for differences in .
symmetry between ' mechanical input g
positive and negative
outputs.

Calibrate
compression at 80%
full scale for each
range.

Note  This procedure assumes a positive command extends the actuator
and a negative command retracts the actuator. If not, use the
opposite polarity for any values given.

Pre-Amp gain is a selectable gain amplifier with predefined values.
Since changes in Pre-Amp gain can cause spikes in the feedback
signal, Pre-Amp gain can only be adjusted when hydraulics are off.

Post-Amp gain is a finer, operator-defined gain control that can be
adjusted when hydraulics are on.

The Total gain value is calculated by multiplying the Pre-Amp and
Post-Amp gain values. If the total desired gain amount is known (from
a calibration sheet), you can enter the amount in the Total gain box
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and the software will calculate the Pre-Amp and Post-Amp gain
values automatically.

When you are calibrating an DC conditioner, use the Post-Amp gain
control to increase gain. If more gain is needed, you must disable
hydraulics and increase the Pre-Amp gain. You can then turn on
hydraulics and continue to adjust the Post-Amp gain.

1. Select Gain/Delta-K for Cal Type.

Stand-alone— Path: Setup > Force > Calibration > Cal Type >
Gain/Delta-K

Automated— Select Gain/Delta-K for Cal Type on the
Calibration tab of the Inputs panel.

2. Exercise the force standard.

Stand-Alone— After enabling the front panel Dial, adjust the
Setpoint to cycle the load standard readout between zero and full
tension three times. This removes sensor hysteresis. Path: Status >
Setpoint

Automated— Use the Manual Cmd slider on the Manual
Command window to cycle the load standard readout between
zero and full tension three times. This removes sensor hysteresis.

Example: When calibrating a £10 kN range, exercise the actuator
between 0 and -10 volts.

3. Apply a tensile force command that is 80% of the full scale range.
Stand-Alone:

A. Using the Dial, adjust the Setpoint for a tensile force
command that is 80% of the full scale range.

B. Verify that your force transducer feedback signal is 80% of the
full scale range.

Automated:

A.  Open the Manual Command window, and then click on the
Enable Manual Command.

B. Adjust the Manual Cmd slider on the Manual Command
window for 80% of the full scale range.

C. Use the Station Signals panel to verify that your force
transducer signal equals 80% of the full scale range.

Model 493.02 Controller Service



Calibrating a Force Sensor

During the initial calibration and tuning of your system, it may
require repeated adjustment for the tensile force command and
feedback values to match.

Note [f the actuator response is sluggish and/or the signal value does not
match the command, you will need to adjust the tuning of this
control mode. Increase the proportional gain (P Gain on the Tuning
menu) to correct sluggish actuator movement. Increase the reset
integration value (I Gain) to help the feedback match the command.

At this point, unless the conditioner is already in calibration, the
tensile force applied to the force transducer will not equal your
commanded value. You will adjust gain in the next step so that the
actual tensile force (as measured by the load standard) and your
commanded tensile force match.

Example: Suppose your actuator has a 100% tensile force rating
of -10 kN. In this step you would apply -8 kN of command, and
even though the station signals would read -8 kN of feedback, the
force standard may only read -4 kN. This shows the conditioner/
sensor pair are out of calibration.

4. Adjust Post-amp Gain on the Calibration submenu or tab to
increase the tensile force reading on the load standard until it
equals your tensile force command.

Calibrate  Note  This procedure assumes a positive command extends the actuator
compression and a negative command retracts the actuator. If not, use the
opposite polarity for any values given.

1. Exercise the force sensor.

Stand-Alone— After enabling the front panel Dial, adjust the
Setpoint to cycle the load standard readout between zero and full
tension three times. This removes sensor hysteresis. Path: Status >
Setpoint

Automated— Use the Manual Cmd slider on the Manual
Command window to cycle the load standard readout between
zero and full tension three times. This removes sensor hysteresis.

Example: When calibrating a £10 kN range, exercise the load
standard between 0 and 10 kN.
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2. Apply a compressive force command that is 80% of the range’s full
scale.

Stand-Alone:
A. Enable the front panel Dial.

B. Using the Dial, adjust the Setpoint for a compressive force
command that is 80% of the full scale range.

C.  Verify that your force transducer feedback signal is 80% of the
full scale range.

Automated:

A.  Open the Manual Command window, and then click on the
Enable Manual Command.

B. Adjust the Manual Cmd slider on the Manual Command
window for a compressive force command that is 80% of the
full scale range.

C. Use the Station Signals panel to verify that your force
transducer signal equals 80% of the full scale range.

During the initial calibration and tuning of your system, it may
require repeated adjustment for the compressive force command
and feedback values to match.

Note [f the actuator response is sluggish and/or the signal value does not
match the command, you will need to adjust the tuning of this
control mode. Increase the proportional gain (P Gain on the Tuning
menu) to correct sluggish actuator movement. Increase the reset
integration value (I Gain) to help the feedback match the command.

At this point, unless the conditioner is already in calibration, the
compressive force applied to the force transducer will not equal
your commanded value. You will adjust Delta K in the next step
so that the actual compressive force and your commanded
compressive force match.

Example: Suppose your actuator has a 100% compressive force
rating of 10 kN. In this step you would apply 8 kN of command,
and even though the station signals would read 8 kN of feedback,
the force standard may only read 4 kN. This shows the
conditioner/sensor pair are out of calibration.
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3. Adjust Delta K until the actual compressive force equals your
compressive force command.

Adjust DeltaK on the Calibration submenu or tab to increase the
compressive force reading on the load standard until it equals
your compressive force command.

Record data points The accuracy tolerance of your data depends on the manufacturer of
your sensor. Your sensor should include a calibration data sheet that
shows the data point tolerance. Sensors from MTS include a sensor
calibration data sheet that shows the data points as it was calibrated.

Using a load standard

Using dead weights

Model 493.02 Controller Service

1. Record the data points for compression.

Stand-Alone:

A.

Automated:

A.

Adjust the Setpoint to achieve a load standard readout of
Zero.

Adjust the Setpoint between zero and full compression three
times. This exercises the force sensor to remove hysteresis.

Establish the zero reference.

e Adjust Setpoint for 0 kN. Then zero the load standard
readout.

e  Remove all dead weights.

e Adjust the Manual Offset for a signal value of 0 kN on
the DVM or other monitoring device.

Path: Setup > Force > Offset/Zero > Manual Offset

Adjust the Setpoint to achieve a load standard reading of
20% compression and record the meter reading. Repeat this
step for 40%, 60%, 80%, and 100% compression.

Adjust the Manual Cmd slider on the Manual Command
window to achieve a load standard readout of zero.

Adjust the Manual Cmd slider between zero and full
compression three times. This exercises the force sensor to
remove hysteresis.

Establish the zero reference.
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Using a load standard

Using dead weights

Using a load standard

Using dead weights
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e Adjust Manual Cmd slider for 0 kN. Then zero the load
standard readout.

e Remove all dead weights. On the Inputs panel, click on
the Offset/Zero tab, and then adjust Manual Offset for
a signal value of 0 kN on the DVM or Station Signals
panel.

Adjust the Manual Cmd slider to achieve a load standard
reading of 20% compression and record the meter reading.
Repeat this step for 40%, 60%, 80%, and 100% compression.

2. Record the data points for the tension.

Stand-Alone:

A.

Adjust the Setpoint to achieve a load standard readout of
zero.

B. Adjust the Setpoint between zero and full tension three
times. This exercises the force sensor to remove hysteresis.

C. Establish the zero reference.

e Adjust the Setpoint for 0 kN. Then zero the load
standard readout.

e  Remove all dead weights.

e Adjust Manual Offset for a signal value of 0 kN on the
DVM or other monitoring device.
Path: Setup > Force > Offset/Zero > Manual Offset

D. Adjust the Setpoint to achieve a force standard reading of
20% tension and record the meter reading. Repeat this step
for 40%, 60%, 80%, and 100% compression.

Automated:

A. Adjust the Manual Cmd slider to achieve a load standard
readout of zero.

B. Adjust the Manual Cmd slider between zero and full tension
three times. This exercises the force sensor to remove
hysteresis.

C. Establish the zero reference.
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Using a load standard e Adjust the Manual Cmd slider for 0 kN. Then zero the
load standard readout.
Using dead weights e Remove all dead weights. Then adjust the Offset control
for a Signal Value of 0 kN on the Input Signals
window.

D. Adjust the Manual Cmd slider to achieve a force standard
reading of 20% tension and record the meter reading. Repeat
this step for 40%, 60%, 80%, and 100% compression.
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Task 6 Gain/Linearization Calibration

If you are using Gain/Linearization for your calibration type,
complete the following procedure. If not, complete Task 5 Gain/Delta
K Calibration on page 135 or Task 7 Millivolt/Volt Calibration on

page 153.

Important  Using linearization data requires specific conditioner zeroing
practices. Ensure that Electrical Zero Lock on the Offset/
Zero menu is set to Locked. Adjusting electrical zero after
calibration may invalidate linearization data.

Initial force sensor For initial calibration of a force sensor, complete the following
calibration  procedure:

1. Select Gain/Linearization for Cal Type.

Stand-Alone— Path: Setup > Force > Calibration > Cal Type >
Gain/Linearization

Automated— Select Gain/Linearization for Cal Type on the
Calibration tab of the Inputs panel.

2. Exercise the force standard.

Stand-Alone— Enable the front panel Dial, then adjust the
Setpoint to cycle the load standard readout between zero and full
tension three times. This removes sensor hysteresis. Path: Status >
Setpoint

Automated— Use the Manual Cmd slider on the Manual
Command window to cycle the load standard readout between
zero and full tension three times. This removes sensor hysteresis.

Example: When calibrating a £10 kN range, exercise the actuator
between 0 and -10 volts. To calibrate the same force sensor for a
different range such as +5 kN, exercise the load standard between
0 and -5 volts.

3. Apply a tensile force command that is 80% of the range’s full
scale.

Stand-Alone:

A. Enable the front panel Dial.
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B. Using the Dial, adjust the Setpoint for a tensile force
command that is 80% of the full scale range.

C.  Verify that your force transducer feedback signal is 80% of the
full scale range.

Automated:

A.  Open the Manual Command window, and then click on the
Enable Manual Command.

B. Adjust the Manual Cmd slider on the Manual Command
window for a tensile force command that is 80% of the full
scale range.

C. Use the Station Signals panel to verify that your force
transducer signal equals 80% of the full scale range.

During the initial calibration and tuning of your system, it may
require repeated adjustment for the tensile force command and
feedback values to match.

Note [f the actuator response is sluggish andy/or the signal value does not
match the command, you will need to adjust the tuning of this
control mode. Increase the proportional gain (P Gain on the Tuning
menu) to correct sluggish actuator movement. Increase the reset
integration value (I Gain) to help the feedback match the command.

At this point, unless the conditioner is already in calibration, the
tensile force applied to the force transducer will not equal your
commanded value. You will adjust gain in the next step so that the
actual tensile force and your commanded tensile force match.

Example: Suppose your actuator has a 100% tensile force rating
of -10 kN. In this step you would apply -8 kN of command, and
even though the station signals would read -8 kN of feedback, the
force standard may only read -4 kN. This shows the conditioner/
sensor pair are out of calibration.

4. Adjust the Post-amp Gain control to increase the tensile force
reading on the load standard until it equals your tensile force
command.

Stand-Alone— Path: Setup > Force > Calibration > Cal Type >
Gain/Linearization < Post-Amp Gain

Automated— Adjust the Post-amp Gain control on the
Calibration tab of the Inputs panel.
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5. Apply a compressive force command that is 80% of the full scale
range.

Stand-Alone:

A. Using the front panel Dial, adjust the Setpoint for a
compressive force command that is 80% of the full scale
range.

B. Verify that your force transducer feedback signal is 80% of the
full scale range.

Automated:

A.  Adjust the Manual Command slider for a compressive force
command that is 80% of the full scale range.

B. Use the Station Signals panel to verify that the compressive
force signal is approximately equal to 80% of the full scale
range.

6. Record force standard and conditioner feedback readings at
predetermined tensile force command points.

Note  After shutting down system hydraulics, you will enter these
recorded readings on the Linearization Data window.

Stand-Alone:
A. Use the Dial to adjust the Setpoint for a 0% command.

B. Record the force standard’s readout value in the 0% row of
your record sheet.

Enter the corresponding conditioner feedback reading.

D. Use the Dial to adjust the Setpoint for a -2% tensile force
command.

E. Record the force standard’s readout value and its
corresponding conditioner feedback reading in the -2% row
of your record sheet.

F. Repeat steps D and E for other tensile force commands
(typically at -4, -6, -8, -10, -20, -40, -70, and -100 percent of
full scale).
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Automated:

A. Adjust the Manual Cmd slider for a 0% command.

B. Record the force standard’s readout value and corresponding
conditioner feedback reading at 0% command.

C. Adjust the Manual Cmd slider for a -2% tensile force
command.

D. Record the force standard’s readout value and its
corresponding conditioner feedback reading in the -2% row
of your record sheet.

E. Repeat steps E-G for other tensile force commands (typically

at -4, -6, -8, -10, -20, -40, -70, and -100 percent of full scale).

. Record conditioner feedback readings at predetermined

compressive force command points.

Stand-Alone:

A.

Use the Dial to adjust the Setpoint for a +2% compressive
force command.

B. Record the force standard’s readout value in the +2% row of
your record sheet.

Enter the corresponding conditioner feedback reading.

D. Repeat steps A-C for other compressive force commands
(typically at +4, +6, +8, +10, +20, +40, +70, and +100 percent
of full scale).

Automated:

A. Adjust the Manual Cmd slider for a +2% compressive force
command.

B. Record the standard’s readout signal and corresponding
conditioner feedback reading in the +2% row of your record
sheet.

C. Repeat steps A and B for other compressive force commands

8. Turn off system hydraulics

(typically at +4, +6, +8, +10, +20, +40, +70, and +100 percent
of full scale).
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9. On the Linearization Data window, enter the force standard values
and corresponding conditioner feedback readings for all
command points previously recorded on a separate sheet.

Stand-Alone— Path: Setup > Force > Calibration > Cal Type >
Gain/Linearization > Linearization Data

Linearization 0 ata
Standard Conditioner
-50.000:
=60.0000 -60.0000 D ak
-40.000:
=40.0000 -40.0000 D ak|
-20.000:
=20.0000 -20.0000 Dak
0.00000:
00000  0.0000 Dak
20.000:;
20,0000 20.0000 Dak
40.000;
40,0000 40,0000 D2k
B0.000;
60.0000 60.0000 Dak) 4

Automated— Click Linearization Data on the Calibration tab
to open the Linearization Data window.

= Linearization Data [ x|

~Fullzcale Minstda

| -1000.0 | 1000.0 |DaN
—DataRange————
Frarm: i Ta |1EID°/O "I Fieset I

Recommended standard Conditioner

W 0000|0000 Dan [
0.0
S0 00000 [ 0.00000 Dan [
20000
B0.000

10. Turn on system hydraulics.

=
(=]
=
©
T
=
©
Q

146 Model 493.02 Controller Service




Calibrating a Force Sensor

Force transducer If the force transducer has been previously calibrated, use the
recalibration following procedure:

Model 493.02 Controller Service

1.

2.

Locate the calibration data sheet for the appropriate conditioner.
Turn off system hydraulics.
Click Linearization Data to open the Linearization Data window.

Stand-Alone— Path: Setup > Force > Calibration > Cal Type >
Gain/Linearization > Linearization Data

Automated— Click Linearization Data on the Calibration tab
of the Inputs panel.

Transfer Standard and Conditioner data from the conditioner’s
calibration data sheet to corresponding data entries on the
Linearization Data window.

Turn on system hydraulics.
Verify linearization data.
Stand-Alone:

A. Using the Dial, adjust the Setpoint for each tensile and
compressive force command point on the Linearization Data
window.

B. At each command point, verify both the dial indicator value
(Standard) and its corresponding conditioner feedback value
(Conditioner) by comparing them with the corresponding
values on the Calibration Data sheet.

Automated:

A.  Adjust the Manual Cmd slider for each tensile and
compressive force command point on the Linearization Data
window.

B. At each command point, verify both the dial indicator value
(Standard) and its corresponding conditioner feedback value
(Conditioner) by comparing them with the corresponding
values on the Calibration Data sheet

If the data is valid: Stop this procedure.

If the data is not valid: Proceed to the next step.
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7. Reset Linearization Data window to default values.

Stand-Alone— Path: Setup > Force > Calibration > Cal Type >
Gain/Linearization > <<Reset>>

Automated— Click Reset on the Linearization Data window to
return to default values.

8. Exercise the force standard.

Stand-Alone— Enable the front panel Dial, then adjust the
Setpoint to cycle the load standard readout between zero and full
tension three times. This removes sensor hysteresis. Path: Status >
Setpoint

Automated— Use the Manual Cmd slider on the Manual
Command window to cycle the load standard readout between
zero and full tension three times. This removes sensor hysteresis.

Example: When calibrating a £10 kN range, exercise the actuator
between 0 and -10 volts. To calibrate the same force sensor for a
different range such as +5 kN, exercise the load standard between
0 and -5 volts.

9. Apply a tensile force command that is 80% of the range’s full
scale.

Stand-Alone:

A. Using the Dial, adjust the Setpoint for a tensile force
command that is 80% of the full scale range.

B. Verify that your force transducer feedback signal is 80% of the
full scale range.

Automated:

A. Adjust the Manual Cmd slider for a tensile force command
that is 80% of the full scale range.

B. Verify that your force transducer feedback signal is 80% of the
full scale range.

During the initial calibration and tuning of your system, it may
require repeated adjustment for the tensile force command and
feedback values to match.
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Note [If the actuator response is sluggish and/or the signal value does not

10.

11.

Model 493.02 Controller Service

match the command, you will need to adjust the tuning of this
control mode. Increase the proportional gain (P Gain on the Tuning
menu) to correct sluggish actuator movement. Increase the reset
integration value (I Gain) to help the feedback match the command.

At this point, unless the conditioner is already in calibration, the
tensile force applied to the force transducer will not equal your
commanded value. You will adjust gain in the next step so that the
actual tensile force and your commanded tensile force match.

Example: Suppose your actuator has a 100% tensile force rating
of -10 kN. In this step you would apply -8 kN of command, and
even though the station signals would read -8 kN of feedback, the
force standard may only read -4 kN. This shows the conditioner/
sensor pair are out of calibration.

Adjust the Post-amp Gain control to increase the tensile force
reading on the load standard until it equals your tensile force
command.

Stand-Alone— Path: Setup > Force > Calibration > Cal Type >
Gain/Linearization > Post-Amp Gain

Automated— Adjust the Post-amp Gain control on the
Calibration tab of the Inputs panel.

Apply a compressive force command that is 80% of the full scale
range.

Stand-Alone:

A. Using the Dial, adjust the Setpoint for a compressive force
command that is 80% of the full scale range.

B. Verify that your force transducer feedback signal is 80% of the
full scale range.

Automated:

A. Adjust the Manual Command slider for a compressive force
command that is 80% of the full scale range.

B. Use the Station Signals panel to verify that the compressive
force signal is approximately equal to 80% of the full scale
range.
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12. Record conditioner feedback readings at predetermined tensile
force command points.

Note  After shutting down system hydraulics, you will enter these
recorded readings on the Linearization Data window.

Stand-Alone:
A. Use the Dial to adjust the Setpoint for a 0% command.

B. Record the force standard’s readout value and corresponding
conditioner feedback reading in the 0% row of your record
sheet.

C. Use the Dial to adjust the Setpoint for a -2% tensile force
command.

D. Record the force standard’s readout signal and corresponding
conditioner feedback reading in the -2% row of your record
sheet.

E. Repeat steps C and D for other tensile force commands
(typically at -4, -6, -8, -10, -20, -40, -70, and -100 percent of
full scale).

Automated:
A. Adjust the Manual Cmd slider for a 0% command.

B. Record the force standard readout signal and corresponding
conditioner feedback reading at the 0% command line of your
record sheet.

C. Adjust the Manual Cmd slider for a -2% tensile force
command.

D. Record the force standard readout signal and corresponding
conditioner feedback reading at the -2% command line of
your record sheet.

E. Repeat steps C and D for other tensile force commands
(typically at -4, -6, -8, -10, -20, -40, -70, and -100 percent of
full scale).
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13.

14.

16.

17.

Model 493.02 Controller Service
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Record conditioner feedback readings at predetermined
compressive force command points.

Stand-Alone:

A. Use the Dial to adjust the Setpoint for a +2% compressive
force command.

B. Record the force standard’s readout value and corresponding
conditioner feedback reading in the +2% row of your record
sheet.

C. Repeat steps A and B for other compressive force commands
(typically at +4, +6, +8, +10, +20, +40, +70, and +100 percent
of full scale).

Automated:

A. Adjust the Manual Cmd slider for a +2% compressive force
command.

B. Record the force standard readout signal and corresponding
conditioner feedback reading at the +2% command line of
your record sheet.

C. Repeat steps A and B for other compressive force commands
(typically at +4, +6, +8, +10, +20, +40, +70, and +100 percent
of full scale).

Turn off system hydraulics.

On the Linearization Data window, enter the force standard values
and corresponding conditioner feedback readings for all
command points previously recorded on a separate sheet.

Turn on system hydraulics.
Verify linearization data.
Stand-Alone:

A. Using the Dial, adjust the Setpoint for each tensile and
compressive force command point on the Linearization Data
window.

B. At each command point, verify both the force standard value
(Standard) and its corresponding conditioner feedback value
(Conditioner).
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C. Check validity before entering each pair of values on a new
Calibration Data Sheet.

Automated:

A.  Adjust the Manual Cmd slider for each retraction and
extension command point on the Linearization Data window.

B. At each command point, verify both the force standard value
(Standard) and its corresponding conditioner feedback value
(Conditioner).

C. Check validity before entering each pair of values on a new
Calibration Data Sheet.
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Task7  Millivolt/Volt Calibration

If you are using mV/V Calibration for your calibration type, complete
the following procedure. If not, complete Task 5 Gain/Delta K
Calibration on page 135 or Task 6 Gain/Linearization Calibration

on page 142.

Millivolt/volt calibration is used for transducers that have two different
slopes (positive and negative).

Positive Tension
Slope (mv/V)

Negative Compression
Slope (mV/V)

In this calibration process, system software calculates conditioner Delta
K Gain and Gain values from previously measured mV/V values under
both tension and compression.

The slope and gain values are derived from, and are relative to, the
output of the load cell transducer as follows:

Compression mV/V
Tension mV/N

Delta K Gain =

Where:

Compression is specified using the Neg Compression or Pos
Compressive entry box on the Calibration submenu or tab.

Tension is specified using the Neg Tension or Pos Tension
entry box on the Calibration submenu or tab.
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Conditioner Output Voltage
Excitation Voltage x Compression mV/V

Gain =

Where:

Conditioner Output Voltage is typically 10 Vdc.

Excitation Voltage is specified using the Excitation entry box on
the Calibration submenu or tab.

Compression is specified using the Negative Compression or
Positive Compressive entry box on the Calibration submenu or
tab.

mv/v Positive Tension Use the following procedure if your force transducer is set up so that a
Calibration positive output represents actuator retraction (tension).

1. Select mv/v Pos Tension for your calibration type.

Stand-Alone— Path: Setup > Force > Calibration > Cal Type >
mv/v Pos Tension

Automated—Select mv/v Pos Tension for Cal Type on the
Calibration tab of the Inputs panel.

2. From the Calibration Data sheet for your force transducer enter
the following values on the Calibration submenu or tab:

Stand-Alone:

A. Enter the full scale force values in the Minimum and
Maximum entry boxes.

B. Enter the tension sensitivity value (+mV/v) in the Pos
Tension entry box.

C. Enter the compression sensitivity value (-mv/V) in the Neg
Compression entry box.

D. Enter the calibration excitation value (Vdc) in the Excitation
entry box.
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Automated:

A.  On the Inputs panel, enter the full scale force values in the
Fullscale Min/Max entry boxes.

B. Adjust Pos Tension for the required tension sensitivity value
(+mv/v).

C. Adjust Neg Compression for the required compression
sensitivity value (-mv/V).

D. Adjust Excitation for the required calibration excitation value
(Vdo).

mv/v Positive  Use the following procedure if your force transducer is set up so that a
Compression Calibration positive output represents actuator extension (compression).

1. Select mv/v Pos Comp for your calibration type.

Stand-Alone— Path: Setup > Force > Calibration > Cal Type >
mv/v Pos Comp

Automated— Select mv/v Pos Compression for Cal Type on
the Calibration tab of the Inputs panel

2. From the Calibration Data sheet for your force transducer enter
the following values on the Calibration submenu or tab:

Stand-Alone:

A. Enter the full scale force values in the Minimum and
Maximum entry boxes.

B. Enter the tension sensitivity value (-mV/v) in the Neg
Tension entry box.

C. Enter the compression sensitivity value (+mv/V) in the Pos
Compression entry box.

D. Enter the calibration excitation value (Vdc) in the Excitation
entry box.
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Calibrating a Force Sensor

Automated:

A. Enter the full scale force values in the Fullscale Min/Max
entry boxes.

B. Adjust Neg Tension for the required tension sensitivity value
(+mv/v).

C. Adjust Pos Compression for the required compression
sensitivity value (-mv/V).

D. Adjust Excitation for the required calibration excitation value
(Vdo).
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Calibrating a Force Sensor

Task 8 Establish the shunt calibration reference

Each resistive bridge type transducer (DC sensor) uses a shunt resistor
to check the calibration accuracy of the sensor/conditioner
combination. Each DC conditioner supports a shunt resistor.

1.

2.

Model 493.02 Controller Service

Turn off hydraulic power.
Remove the load standard.
Turn on hydraulic power.
Zero the force sensor output.
Stand-Alone:

Adjust the Setpoint for a 0 kN output. The sensor output must be
0.000 kN for a proper shunt calibration. If not, return to “Set the
zero and offset” on page 134.

Automated:

Adjust the Manual Cmd slider on the Manual Command
window for a 0 kN output. The sensor output must be 0.000 kN
for a proper shunt calibration. If not, return to “Set the zero and
offset” on page 134.

Change the control mode to displacement.
Stand-Alone— Path: Status > Control Mode > Disp.

Automated— On the Manual Command window, change
Control Mode to Displacement.

Shunt calibration cannot be performed on a sensor when it is in
control of the servo loop.
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Calibrating a Force Sensor

6. Determine the shunt calibration resistor from the following table:

BRIDGE SENSITIVITY RANGE RESISTOR
RESISTANCE (% FuLL ScALE) VALUE
350 Q 2mV/V 100% 499 k
50% 100 k
20% 249 k
10% 499 k
350 Q 1mV/V 100% 100 k
50% 200 k
20% 499 k
10% 1000 k
700 Q 2mV/V 100% 100 k
50% 200 k
20% 499 k
10% 1000 k
700 Q 1mV/V 100% 200 k
50% 402 k
20% 1000 k
10% 2000 k

7. If you have sensor cables with optional transducer ID modules,
complete the following procedure. If not, proceed to Step 8.

Install the shunt calibration resistor into the R9 location of the
sensor ID module. The sensor identification cartridge is molded
into the sensor cable.

Solder the shunt cal
resistor here

[ 1]
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B
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Calibrating a Force Sensor

8. If you do not have transducer ID modules on your sensor cables,
install the shunt calibration resistor as follows:

A. Select the appropriate shunt calibration resistor.
Bend the resistor leads 90° for a 0.3 inch separation.
Cut the resistor leads 0.12 inch from the bend.

Insert the resistor into the connector solder cups and solder.

m g O W

Complete and attach a shunt calibration label as specified on
the 493.40/41 Carrier I/O Shunt Calibration Kit (MTS PN 100-
028-185).

F.  Install the shunt cal resistor/connector assembly into the
appropriate slot of the SHUNT CAL connector on the front
panel of the appropriate I/O Carrier Module.

/\_/

SHUNT CAL
1 —NA— | — o Opticn Slot 1 Shunt Cal. Resistor Location

2| —AAS— | 4—1 10 Option Slot 2 Shunt Cal. Resistor Location

3| —AMy— | #— 10D Option Slot 3 Shunt Cal. Resistor Location

4 | —\ \/\— | #—— /O Option Slot 4 Shunt Cal. Resistor Location

/\_/

9. Verify that force is still zero.

While it is unlikely, it is possible for the force signal to change
when the control mode changes. If it does:

Stand-Alone— Click Auto Offset on the Offset/Zero submenu
to zero the force output. Path: Setup > Force > Offset/Zero >
Auto Offset

Automated— Click Auto Offset on the Offset/Zero tab (Inputs
panel) to zero the force output.
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Calibrating a Force Sensor

10. Perform shunt calibration.
Stand-Alone:
Path: Setup > Force > Calibration > Select Cal Type
A.  Select required Shunt Display units.

B. Ensure that Shunt State (+) is set to On. Polarity is always
positive.

Note the Shunt Ref (+) value, it should be 60%-90% (80% is
ideal) of the calibrated range of the sensor.

C. Click Update to copy the current shunt reference value into
the Shunt Reference box.

D. Set Shunt State (+) to Off.
Automated:

A. In Station Setup select the appropriate force channel on the
navigation panel., click the Channel Input Signals icon, and
then click the Shunt tab.

B. Select the shunt type. Use (+) polarity if you are not sure
what to select.

C. In the Current Shunt Value box, click the On button. Note
the Current Shunt Value, it should be 60%—90% (80% is
ideal) of the calibrated range of the sensor.

D. Click Update to copy the Current Shunt Value into the
Shunt Reference Value box, and then click Off.

Task9 Save the calibration

It is important that you save your sensor calibration values.
Stand-Alone— Path: Setup > Open/Save Parameters > <<Save>>

Automated— On the Station Setup window Inputs panel, click the
Calibration tab, and then Save. This saves current calibration values
on the Calibration, Sensor, and Shunt tabs to the sensor calibration
file.
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Calibrating Encoders

Calibrating Encoders

Determine installed
location

Defining an input

Zeroing

Important note

Encoders are connected to the controller through a 493.40 Carrier I/O
board. The encoder requires the Model 493.47 Encoder Interface
daughter board to be installed in a Model 493.40 Carrier I/O board.
The Carrier I/O connector you use is based on the installed location of
the Model 493.47 Encoder Interface daughter board on the board of
the Carrier I/O module.

For automated FT SE Controllers, determine the installed location of
the Model 493.47 Encoder Interface daughter board by using the
Hardware tab on the Station Signals window. Access Station
Signals on the Station Setup window navigation pane.

Defining an encoder sensor input signal is no different from any other
input signal. However, specific resources must be available to define
either input signal.

For automated FT SE Controllers, use the Station Builder program to
allocate an encoder to the station configuration file and assign units to
the signal.

Feedback resources labeled “Encoder Input #” or “Heidenhain 417/425
Input #” indicate that an optional encoder daughter board is installed
in the Model 493.40 Carrier I/O board.

The encoder signal is defined in the Station Setup Inputs panel. Signal
definition is handled the same way as any other input signal.

Note Keep in mind that you cannot zero an encoder if it is selected for the
active control mode.

Note The most common use for these controls is to establish a zero
position after a specimen has been installed.

Procedures for “Automated Controllers” assumes the FlexTest SE
Controller is equipped with the PC-Supervision option, and that
Exclusive Control is assigned to Station Manager. For more information
about Station Manager, see the Model 793.00 System Software manual
that accompanies your system.
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Calibrating Encoders

Abbreviated Procedure

Online readers All procedure entries are hypertext links.
Click on any entry to jump to the corresponding page.

The following abbreviated procedure outlines an encoder calibration
process. More detailed calibration information is available on the pages
listed.

Task 1, “Get things ready,” on page 163

Task 2, “Create a calibration file,” on page 164
Task 4, “Turn on hydraulic pressure,” on page 165
Task 5, “Set the zero position,” on page 165

Task 6, “Save the calibration,” on page 166
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Calibrating Encoders

Task1 Get things ready

Perform the following before you start encoder calibration.

1. Locate relevant documentation.

When calibrating an encoder, you will need information about the
encoder such as the serial number, model number, and a
specification called measuring step (resolution).

2. Open a station configuration file.

You need a station configuration file that includes a control
channel and a control mode that uses the encoder you intend to
calibrate.

Stand-Alone— Path: Config > Edit Config > Configuration File

Automated— On the File menu, select Open Station to open
the appropriate configuration file.

3. Select the Calibration access level.

You must access the Calibration user access level before you can
perform any of the calibration procedures. You may need to enter
a password.

Stand-Alone— Path: Config > Access Level > Calibration

Automated— In the Station Manager window toolbar, select
Calibration

4. Set up a signal monitor.

Note You cannot monitor the output of a new sensor until a sensor
calibration file has been created and the sensor assigned to an input
signal.

You will be monitoring encoder output when making adjustments
throughout this procedure. You can monitor the encoder output in
the same units that you are using for the calibration.

You can use an external DVM to monitor sensor output from a
BNC connector located on the FT SE Controller front panel.

You can also use the Meters window to monitor sensor output.
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Calibrating Encoders

For Automated systems, you can also use the Station Signals
panel to monitor sensor output. On the Station Manager Display
menu, select Station Setup. In the navigation pane, select Station
Signals to display the Station Signals panel to monitor current
values for user-defined signals.

For more information on using the Station Signals panel, refer to
“About the Station Signals Panel” in Chapter 3, Station Manager of
the Model 793.00 System Software manual.

Task2 Create a calibration file

Note If you already have a sensor calibration file, skip this task.
Note This task applies to automated FT SE controllers only

This task creates a sensor calibration file and sets up any ranges you
may want. An encoder does not require ranges, its resolution is always
the same.

See “How to Create a Sensor File” in Chapter 3, Station Manager of the
Model 793.00 System Software manual for a detailed procedure.

Setting encoder  In the Resolution box, enter the encoder resolution supplied in the
resolution encoder documentation.

Note If want to use units different than those supplied in the sensor
documentation, enter the full scale and resolution in the supplied
units first, and then switch to the desired full-scale units. The units
conversion will be calculated automatically.

Task3 Assign a calibration file

Note This task applies to automated FT SE controllers only

This task links a sensor calibration file (created in Task 2) to a
hardware resource. The purpose for this is to select one of the sensor
ranges for the input signal definition.

See “How to Assign a Sensor File” in Chapter 3, Station Manager of the
Model 793.00 System Software manual for a detailed procedure.
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Calibrating Encoders

Task4  Turn on hydraulic pressure

This task sets up the Control Panel so you can turn on the hydraulic
pressure.

____________________________________________________________________________________________|
Do not place any part of your body in the path of a moving actuator.

A crush zone exists between the actuator and any equipment in the
path of its movement. Inmediate and unexpected actuator response is
possible when you apply hydraulic pressure to your system.

Stay clear of the actuators when applying hydraulic pressure.
. ________________________________________________________________________________________]

See “Turn on hydraulic pressure” on page 108 for a detailed
procedure.

Task5 Set the zero position

The zero position can be set anywhere within the full-scale range of
the encoder.

Stand-Alone:

A. Using the front panel Dial, adjust the Setpoint to move the
actuator to the position you want to assign as zero.

B. Select any control mode that does not use the encoder.
Path: Status > Control Mode

Note [If the actuator should move after making the change in control
modes, you will need to reposition the actuator, then change to a
more stable control mode.

C. With the actuator in the desired zero position, click <<Auto
Zero>> button on the Offset/Zero submenu.

Path: Setup > Disp. > Offset/Zero > <<Auto Zero>>
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Calibrating Encoders

Automated:

A. Adjust the Manual Cmd slider on the Manual Command
window to move the actuator to the position you want to

assign as zero.

B. Use Control Mode on the Change control modes on the
Control Panel. Select any control mode that does not use
the encoder.

Note [If the actuator should move after making the change in control
modes, you will need to reposition the actuator, then change to a

more stable control mode.

C. With the actuator in the desired zero position, click the Auto
Zero button on the Offset/Zero tab (Inputs panel).

Note  When you change the encoder resolution on the Calibration tab, it
immediately changes the resolution of signal values displayed on
the Station Signals, Meters, and Scope windows.

Task 6 Save the calibration

It is important that you save your sensor calibration values.
Stand-Alone— Path: Setup > Open/Save Parameters > <<Save>>

Automated— On the Station Setup window Inputs panel, click the
Calibration tab, and then Save. This saves current calibration values
on the Calibration, Sensor, and Shunt tabs to the sensor calibration

file.
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Calibrating Temposonics Sensors

Calibrating Temposonics Sensors

Determine installed
location

Defining an input

Important note

Temposonics sensors require a Model 493.47 Encoder Interface
daughter board to be installed in a Model 493.40 Carrier I/O board.
The Carrier I/O connector used depends on the installed location of
the daughter board on the board of the Carrier I/O module.

For automated FT SE controllers, determine the installed location of the
Model 493.47 Encoder Interface by using the Hardware tab on the
Station Signals window. Access Station Signals on the Station
Setup window navigation panel.

Defining a Temposonics sensor input signal is no different from any
other input signal. For automated FT SE controllers, use the Station
Builder application to allocate a Temposonics sensor to the station
configuration file. The Station Builder application also assigns units to
the signal.

Feedback Resources labeled “Temposonics Input #” or “Temposonics
I Input #” indicate that the optional Temposonics daughter board
(Model 493.47 Encoder Interface) is installed in the Model 493.40
Carrier I/O board.

Procedures for “Automated Controllers” assumes the FlexTest SE
Controller is equipped with the PC-Supervision option, and that
Exclusive Control is assigned to Station Manager. For more information
about Station Manager, see the Model 793.00 System Software manual
that accompanies your system.
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Calibrating Temposonics Sensors

Abbreviated Procedure

Online readers All procedure entries are hypertext links.
Click on any entry to jump to the corresponding page.

The following abbreviated procedure outlines a Temposonics sensor
calibration process. More detailed calibration information is available
on the pages listed.

Task 1, “Get things ready,” on page 169

Task 2, “Create a calibration file,” on page 170
Task 4, “Turn on hydraulic pressure,” on page 171
Task 5, “Set the zero position,” on page 172

Task 6, “Save the calibration,” on page 173
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Calibrating Temposonics Sensors

Task1 Get things ready

5.

Review “Before You Begin” on page 97
Locate relevant documentation.

When calibrating a Temposonics sensor, you will need
information about the sensor such as the serial number, model
number, and a specification called measuring step (resolution).

Open a station configuration file.

You need a station configuration file that includes a control
channel and a control mode that uses the encoder you intend to
calibrate.

Stand-Alone— Path: Config > Edit Config > Configuration File

Automated— On the File menu, select Open Station to open
the appropriate configuration file.

Select the Calibration access level.

You must access the Calibration user access level before you can
perform any of the calibration procedures. You may need to enter
a password.

Stand-Alone— Path: Config > Access Level > Calibration

Automated— In the Station Manager window toolbar, select
Calibration

Set up a signal monitor.

Note You cannot monitor the output of a new sensor until a sensor

Model 493.02 Controller Service

calibration file has been created and the sensor assigned to an input
signal.

You will be monitoring temposonics sensor output when making
adjustments throughout this procedure. You can monitor the
temposonics sensor output in the same units that you are using for
the calibration.

You can use an external DVM to monitor sensor output from a
BNC connector located on the FT SE Controller front panel.

You can also use the Meters window to monitor sensor output.

169
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Calibrating Temposonics Sensors

For Automated systems, you can also use the Station Signals
panel to monitor sensor output. On the Station Manager Display
menu, select Station Setup. In the navigation pane, select Station
Signals to display the Station Signals panel to monitor current
values for user-defined signals.

For more information on using the Station Signals panel, refer to
“About the Station Signals Panel” in Chapter 3, Station Manager of
the Model 793.00 System Software manual.

Task2 Create a calibration file

Note This task applies to automated FT SE controllers only.

This task creates a sensor calibration file and sets up any ranges you
may want. A Temposonics sensor does not require ranges, its
resolution is always the same.

See “How to Create a Sensor File” in Chapter 3, Station Manager of the
Model 793.00 System Software manual for a detailed procedure.

Setting Temposonics  In the Resolution box, enter the Temposonics resolution supplied in
resolution the Temposonics documentation.

Note If want to use units different than those supplied in the sensor
documentation, enter the full scale and resolution in the supplied
units first, and then switch to the desired full-scale units. The units
conversion will be calculated automatically.
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Calibrating Temposonics Sensors

Task3  Assign the calibration file

Note This task applies to automated FT SE controllers only.

This task links a sensor calibration file (created in Task 2) to a
hardware resource; effectively selecting one of the sensor ranges for
the input signal definition.

See “How to Assign a Sensor File” in Chapter 3, Station Manager of the
Model 793.00 System Software manual for a detailed procedure.

Task4  Turn on hydraulic pressure

A\ WARNING

This task sets up the Control Panel so you can turn on the hydraulic
pressure.

. ________________________________________________________________________________________]
Do not place any part of your body in the path of a moving actuator.

A crush zone exists between the actuator and any equipment in the
path of its movement. Inmediate and unexpected actuator response is
possible when you apply hydraulic pressure to your system.

Stay clear of the actuators when applying hydraulic pressure.
|

See “Turn on hydraulic pressure” on page 108 for a detailed
procedure.
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Calibrating Temposonics Sensors

Task5 Set the zero position

The zero position can be set anywhere within the full-scale range of
the Temposonics sensor.

Stand-Alone:

A. Using the front panel Dial, adjust the Setpoint to move the
actuator to the position you want to assign as zero.

B. Select any control mode that does not use the encoder.

Path: Status > Control Mode

Note [If the actuator should move after making the change in control
modes, you will need to reposition the actuator, then change to a

more stable control mode.

C. With the actuator in the desired zero position, click <<Auto
Zero>> button on the Offset/Zero submenu.

Path: Setup > Disp. > Offset/Zero > <<Auto Zero>>

Automated:

1. Adjust the Manual Cmd slider on the Manual Command
window to move the actuator to the position you want to assign

as zero.

2. Use Control Mode on the Control Panel to select any control
mode that does not use the Temposonics sensor.

Note [If the actuator should move after making the change in control
modes, you will need to reposition the actuator, then change to a

more stable control mode.

3. With the actuator in the desired zero position, click the Auto Zero
button on the Offset/Zero tab (Inputs panel).

Note  When you change the encoder resolution on the Calibration tab, it
immediately changes the resolution of signal values displayed on
the Station Signals, Meters, and Scope windows.
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Calibrating Temposonics Sensors

Task 6 Save the calibration

It is important that you save your sensor calibration values.

Stand-Alone— Path: Setup > Open/Save Parameters > <<Save>>

Automated— On the Station Setup window Inputs panel, click the
Calibration tab, and then Save. This saves current calibration values
on the Calibration, Sensor, and Shunt tabs to the sensor calibration

file.
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Calibrating an Extensometer

Calibrating an Extensometer

Extensometers are usually calibrated such that the maximum strain
represents +100% of the full-scale capacity of the extensometer.

To calibrate you extensometer you will need:

e  An extensometer calibrator
e A digital voltmeter (DVM)

Important note  Procedures for “Automated Controllers” assumes the FlexTest SE
Controller is equipped with the PC-Supervision option, and that
Exclusive Control is assigned to Station Manager. For more information
about Station Manager, see the Model 793.00 System Software manual
that accompanies your system.

How To Calibrate an Extensometer

Online readers All procedure entries are hypertext links.
Click on any entry to jump to the corresponding page.

Task 1, “Get things ready,” on page 175.

Task 2, “Turn on hydraulic pressure,” on page 176.

Task 3, “Adjust offset,” on page 177.

Task 4, “Gain/Delta K Calibration,” on page 178.

Task 5, “Gain/Linearization Calibration,” on page 180.

Task 6, “Establish the shunt calibration reference,” on page 188.

Task 7, “Save the calibration settings,” on page 190.
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Calibrating an Extensometer

Task1 Get things ready

Model 493.02 Controller Service

1. Review “Before You Begin” on page 97.

2. Locate all relevant documentation including information about the

extensometer such as the serial number, model number, etc.
Select Calibration for Access Level.

Path: Config > Access Level > Calibration

Set up to monitor strain feedback.

You will be monitoring strain feedback when making adjustments
throughout this procedure. You can monitor strain feedback in the
same units that you are using for the calibration.

You can use an external DVM to monitor strain feedback from a
BNC connector located on the FT SE Controller front panel.

You can also use the Meters window to monitor strain feedback.

For Automated systems, you can also use the Station Signals
panel to monitor strain feedback. On the Station Manager Display
menu, select Station Setup. In the navigation pane, select Station
Signals to display the Station Signals panel to monitor current
values for user-defined signals.

For more information on using the Station Signals panel, refer to
“About the Station Signals Panel” in Chapter 3, Station Manager of
the Model 793.00 System Software manual.

. Mount the extensometer to the calibrator.

Review the extensometer product manual for mounting
information and calibrator requirements.
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Calibrating an Extensometer

Task2  Turn on hydraulic pressure

This task activates the hydraulic pressure and ensures you have control
of your actuator.

. ________________________________________________________________________________________]
4\ WARNING Do not place any part of your body in the path of a moving actuator.

A crush zone exists between the actuator and any equipment in the path of
its movement. Immediate and unexpected actuator response is possible
when you apply hydraulic pressure to your system. Stay clear of the
actuators when applying hydraulic pressure.

. ____________________________________________________________________________________________________|

1. Ensure that the extensometer signal you are calibrating has strain
selected for its active control mode.

2. If the Hydraulic Interlock or Program Interlock indicator is lit,
determine the cause, correct it, and then click Reset.

If either interlock indicator lights again, you will need to
determine the cause of the interlock and correct it before
proceeding.

3. In the Power selection box, click the Low button, and then High
for the HPU. If an HPU is not listed, start the HPU at the pump.

Note The HPU can be configured for “first on” If this is the case, start the
appropriate HSM.

4. If an HSM is present, click the HSM Low button, and then HSM
High for the appropriate HSM.

5. Apply a positive strain command, and observe the strain feedback
value on your meter.

If you have control of the actuator, proceed to Task 3 on page
177.

If you do not have control of the actuator (for example, the
actuator is hunting or moving in the wrong direction), disable
hydraulics, change the conditioner polarity, and then perform
Task 2 again.

For more detailed information on applying hydraulic pressure and
clearing interlocks, refer to FlexTest SE User’s manual.
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Calibrating an Extensometer

Task3  Adjust offset

This task verifies the sensor’s zero position and offsets any imbalance
due to specimen size, forces from test components, cable length, and
so forth. The zero position can be set anywhere within the full-scale
range of the strain sensor.

Note The arms of the extensometer must be in the zero reference
position. Depending on the extensometer, this can be accomplished
using the zero pin, stop block, or a special fixture.

Stand-Alone:

1. Adjust the Setpoint for 0 cm/cm.

2. Monitor the current strain output to ensure that it is zero. If it is
not zero, click Auto Offset.

Path: Setup > Strain > Offset/Zero > <<Auto Offset>>

Automated:

1. Adjust the Manual Cmd slider for 0 cm/cm.

2. Click Auto Offset icon on the Station Controls panel to display
the Signal Auto Offset window.

3. If the current strain output is not zero, click the Auto Offset icon
next to the signal value to offset it. automatically.
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Calibrating an Extensometer

Task4 Gain/Delta K Calibration

If you are using Gain/Delta K for your calibration type, complete the
following procedure. If not, complete Task 5 Gain/Linearization
Calibration on page 180.

Calibrate the negative  This task calibrates the extensometer negative output using the
output (tension)  calibration Gain controls. Since the Gain setting will affect your Delta
K setting, you should always calibrate the negative side first.

A

Indicated output MK <1

mechanical input

To calibrate the negative extensometer output:

1. Use the Setpoint (Stand-Alone) or Manual Cmd slider
(Automated) to adjust the calibrator between zero and 100% of the
extensometer’s full-scale range three times. This exercises the
extensometer to remove any hysteresis

2. Apply a negative command equal to 80% of the negative full scale
value (-8 V DC, or in this example, a calculated output of -8 cm/
cm).

3. Note the strain signal value on your meter.

4. 1If the signal value is does not match the commanded level,
increase Post-Amp Gain on the Calibration submenu or tab to
achieve an 80% value (-8 cm/cm). Record your final strain signal
value from the meter for the 80% output.
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Calibrating an Extensometer

Note If you cannot apply enough Post-amp gain to achieve an 80%
value, you will need to disable hydraulics, change the Excitation
voltage, enable hydraulics, and then repeat this task.

D. Repeat steps 1-4 for a 20%, 40%, 60%, and 100% negative
output.

Calibrate the positive  To calibrate the positive extensometer output:

output (compression)
1. Use the Setpoint (Stand-Alone) or Manual Cmd slider

(Automated) to adjust the calibrator between zero and 100% of the
extensometer’s full-scale range three times. This exercises the
extensometer to remove any hysteresis

2. Apply a positive command equal to 80% of the positive full scale
value (+8 V DC, or in this example, a calculated output of
+8 cm/cm).

3. Monitor the strain signal value on your meter.

4. If the extensometer signal value is above +8 cm/cm, adjust the
DeltaK control on the Calibration submenu or tab to achieve an
80% value (+8 cm/cm). Record your final strain signal value from
the meter for the 80% output.

If the extensometer signal is below +8 cm/cm, DeltaK adjustment
cannot be made. Return the DeltaK adjustment to its original
setting. Use the Post-amp gain control to increase the calculated
output to a value halfway between its present value and +8 cm/
cm (this splits the difference between compression and tension).

5. Repeat steps 1- 4 for a 20%, 40%, 60%, and 100% positive output.

Compare recorded  Your sensor should include a calibration data sheet that shows the data
data pointsto  point tolerance.

calibration sheet
1. Compare your recorded output values to the calibration data sheet

that accompanied your sensor.
2. Make sure your current values fall with the permissible variation.

If they do not, you must go back to Task 5 on page 135, and
recalibrate the extensometer negative and positive outputs.
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Calibrating an Extensometer

Task5 Gain/Linearization Calibration

If you are using Gain/Linearization for your calibration type,
complete the following procedure. If not, complete Task 4 Gain/Delta
K Calibration on page 178.

Important  Using linearization data requires specific conditioner zeroing
practices. Ensure that Electrical Zero Lock on the Offset/
Zero menu is set to Locked. Adjusting electrical zero after
calibration may invalidate linearization data.

Initial extensometer  For initial calibration of an extensometer, complete the following
calibration  procedure:

1. Select Gain/Linearization for Cal Type.

Stand-Alone— Path: Setup > Strain > Calibration > Cal Type >
Gain/Linearization

Automated— Select Gain/Linearization for Cal Type on the
Calibration tab of the Inputs panel.

2. Exercise the extensometer.

Stand-Alone— Enable the front panel Dial, use Setpoint to
adjust the calibrator between zero and 100% of the extensometer’s
full-scale range three times. This exercises the extensometer to
remove any hysteresis. Path: Status > Setpoint

Automated— Use the Manual Cmd slider on the Manual
Command window to adjust the calibrator between zero and
100% of the extensometer’s full-scale range three times. This
exercises the extensometer to remove any hysteresis.

3. Apply a negative strain command that is 80% of the negative full
scale range.

Stand-Alone: Using the Dial, adjust the Setpoint for a negative
strain command that is 80% of the full scale range.

Automated: Adjust the Manual Cmd slider for a negative strain
command that is 80% of the full scale range.

Verify that your extensometer feedback signal is 80% of the full
scale range.
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Calibrating an Extensometer

During the initial calibration and tuning of your system, it may
require repeated adjustment for the negative strain command and
feedback values to match.

At this point, unless the conditioner is already in calibration, the
negative strain applied to the extensometer will not equal your
commanded value. You will adjust gain in the next step so that the
actual strain and your commanded strain match.

. Adjust gain until the actual strain equals your strain command.

Adjust the Post-amp Gain control to increase the negative strain
reading on the calibrator until it equals your negative strain
command.

. Apply a positive strain command that is 80% of the positive full

scale range.

A. Using the Dial, adjust the Setpoint (Stand-Alone) or the
Manual Cmd slider (Automated) for a positive strain
command that is 80% of the full scale range.

B. Verify that your extensometer feedback signal is 80% of the
full scale range.

6. Record conditioner feedback readings at predetermined negative

strain command points.

Note  After shutting down system hydraulics, you will enter these

Model 493.02 Controller Service

recorded readings on the Linearization Data window.

Stand-Alone:
A. Use the Dial to adjust the Setpoint for a 0% command.

B. Record the calibrator’s readout value and the corresponding
conditioner feedback reading in the 0% row of your record
sheet.

Use the Dial to adjust the Setpoint for a -2% strain command.

D. Record the calibrator’s readout value and corresponding
conditioner feedback reading in the -2% row of your record
sheet.

E. Repeat steps C and D for other negative strain commands
(typically at -4, -6, -8, -10, -20, -40, -70, and -100 percent of
full scale).
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Automated:

A. Adjust the Manual Cmd slider on the Manual Command
window for a 0% command.

B. Record the calibrator’s readout value and the corresponding
conditioner feedback reading in the 0% row of your record
sheet.

Adjust the Manual Cmd slider for a -2% strain command.

D. Record the calibrator’s readout value and corresponding
conditioner feedback reading in the -2% row of your record
sheet.

E. Repeat steps C and D for other negative strain commands
(typically at -4, -6, -8, -10, -20, -40, -70, and -100 percent of
full scale).

7. Record conditioner feedback readings at predetermined positive
strain command points.

Stand-Alone:

A. Use the Dial to adjust the Setpoint for a +2% positive strain
command.

B. Record the calibrator’s readout value and corresponding
conditioner feedback reading in the +2% row of your record
sheet.

C. Repeat steps A and B for other positive strain commands
(typically at +4, +6, +8, +10, +20, +40, +70, and +100 percent
of full scale).

Automated:

A. Adjust the Manual Cmd slider for a +2% positive strain
command.

B. Record the calibrator’s readout value and corresponding
conditioner feedback reading in the +2% row of your record
sheet.

C. Repeat steps A and B for other positive strain commands
(typically at +4, +6, +8, +10, +20, +40, +70, and +100 percent
of full scale).

8. Turn off system hydraulics.
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9. On the Linearization Data window, enter the calibrator readout
values and corresponding conditioner feedback readings for all
command points previously recorded on a separate sheet.

Stand-Alone— Path: Setup > Strain > Calibration > Cal Type >
Gain/Linearization > Linearization Data

on D1ata
Standard Conditioner
-0.50000:
-0.6000  -0.6000 i
-0.40000:
-0.4000  -0.4000 crdc
-0.20000:
-0.2000  -0.2000 crdc
0.00000:;
0.0000  0.0000 cri/c|
0.20000:
02000 02000 crdc
0.40000:
04000 04000 crds
0.60000:
0.6000  0.6000 crc,

Automated— Click Linearization Data on the Calibration tab.

[ Linearization Data | x|

"Fullscale Iin./h 2 ‘

-10.000 10,000 |cm/cm

[ ata Range

Recormrmended Standard Conditianer
SR 0.60000 ] 080000 cm/cifEl
g 0.60000| 0.60000 cmicrf
QX 0.10000 | 0.40000 cmicrf
el 0.20000 | 0.20000 cmicrf
0.0000: I
020000
040000
060000
0.50000:
e 1ooo0] 1.0000 cmicifid

10. Turn on system hydraulics.

(xd
2
=3
-
<V]
=
o
-

Model 493.02 Controller Service 183




Calibrating an Extensometer

Extensometer If the extensometer has been previously calibrated, use the following
recalibration  procedure:

1. Locate the calibration data sheet for the appropriate conditioner.
2. Turn off system hydraulics.
3. Click Linearization Data to open the Linearization Data window.

4. Transfer Standard and Conditioner data from the conditioner’s
calibration data sheet to corresponding data entries on the
Linearization Data window.

5. Turn on system hydraulics.
6. Verify linearization data.

A. Adjust the Setpoint (Stand-Alone) or Manual Cmd slider
(Automated) for each strain command point on the
Linearization Data window.

B. At each command point, verify both the calibrator readout
value (Standard) and its corresponding conditioner feedback
value (Conditioner) by comparing them with the
corresponding values on the Calibration Data sheet

If the data is valid: Stop this procedure.
If the data is not valid: Proceed to the next step.
7. Reset Linearization Data window to default values.

Stand-Alone— Path: Setup > Strain > Calibration > Cal
Type > Gain/Linearization > <<Reset>>

Automated— Click Reset on the Linearization Data window
to return to default values.

8. Use the Setpoint (Stand-Alone) or Manual Cmd slider
(Automated) to adjust the calibrator between zero and 100% of the
extensometer’s full-scale range three times. This exercises the
extensometer to remove any hysteresis.
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9.

10.

11.
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Apply a negative strain command that is 80% of the negative full
scale range.

A. Adjust the Setpoint (Stand-Alone) or Manual Cmd slider
(Automated) for a negative strain command that is 80% of the
full scale range.

B. Verify that your extensometer feedback signal is 80% of the
full scale range.

During the initial calibration and tuning of your system, it may
require repeated adjustment for the negative strain command and
feedback values to match.

At this point, unless the conditioner is already in calibration, the
negative strain applied to the extensometer will not equal your
commanded value. You will adjust gain in the next step so that the
actual strain and your commanded strain match.

Adjust gain until the actual strain equals your strain command.
Stand-Alone:

Adjust the Post-amp Gain control on the Calibration submenu
to increase the negative strain reading on the calibrator until it
equals your negative strain command. Path: Setup > Strain >
Calibration > Cal Type > Gain/Linearization > Post-Amp Gain

Automated:

Adjust the Post-amp Gain control on the Calibration tab to
increase the negative strain reading on the calibrator until it equals
your negative strain command.

Apply a positive strain command that is 80% of the positive full
scale range.

A. Adjust the Setpoint (Stand-Alone) or Manual Cmd slider
(Automated) for a positive strain command that is 80% of the
full scale range.

B. Verify that your extensometer feedback signal is 80% of the
full scale range.
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Calibrating an Extensometer

12. Record conditioner feedback readings at predetermined negative
strain command points.

Note  After shutting down system hydraulics, you will enter these
recorded readings on the Linearization Data window.

Stand-Alone:
A. Use the Dial to adjust the Setpoint for a 0% command.

B. Record the calibrator’s readout value and the corresponding
conditioner feedback in the 0% row of your record sheet.

Use the Dial to adjust the Setpoint for a -2% strain command.

D. Record the calibrator’s readout value and the conditioner
feedback reading in the -2% row of your record sheet.

E. Repeat steps C and D for other negative strain commands
(typically at -4, -6, -8, -10, -20, -40, -70, and -100 percent of
full scale).

Automated:
A. Adjust the Manual Cmd slider for a 0% command.

B. Record the calibrator’s readout value and the corresponding
conditioner feedback in the 0% row of your record sheet.

Adjust the Manual Cmd slider for a -2% strain command.

D. Record the calibrator’s readout value and the conditioner
feedback reading in the -2% row of your record sheet.

E. Repeat steps C and D for other negative strain commands
(typically at -4, -6, -8, -10, -20, -40, -70, and -100 percent of
full scale).
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Calibrating an Extensometer

13. Record conditioner feedback readings at predetermined positive
strain command points.

14.
15.

Stand-Alone:

A.

Use the Dial to adjust the Setpoint for a +2% positive strain
command.

B. Record the calibrator’s readout value and the conditioner
feedback reading at the +2% row of your record sheet.

C. Repeat steps A and B for other positive strain commands
(typically at +4, +6, +8, +10, +20, +40, +70, and +100 percent
of full scale).

Automated:

A. Adjust the Manual Cmd slider for a +2% positive strain
command.

B. Record the standard’s readout value and the conditioner
feedback reading at the +2% row of your record sheet.

C. Repeat steps A and B for other positive strain commands

(typically at +4, +6, +8, +10, +20, +40, +70, and +100 percent
of full scale).

Turn off system hydraulics.

On the Linearization Data window, enter the calibrator values
((Standard) and its corresponding conditioner feedback readings
(Conditioner) for all command points previously recorded on a
separate sheet.

16. Verify linearization data.

Model 493.02 Controller Service

A.

Adjust the Setpoint (Stand-Alone) or Manual Cmd slider
(Automated) for each strain command point on the
Linearization Data window.

At each command point, verify both the calibrator readout
value (Standard) and its corresponding conditioner feedback
value (Conditioner).

Check validity before entering each pair of values on a new
Calibration Data sheet.
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Calibrating an Extensometer

Task 6 Establish the shunt calibration reference

Each DC conditioner supports a shunt resistor. To establish the shunt
reference value, perform the following tasks.

1. Disable hydraulic pressure and remove the calibrator.
2. Activate hydraulic pressure and zero the strain sensor output.

Adjust the Setpoint (Stand-Alone) or Manual Cmd slider
(Automated) for a 0 cm/cm output. The sensor output must be
0.000 cm/cm for a proper shunt calibration. If not, review Task 3,
“Adjust offset,” on page 177.

3. Change the control mode to displacement.
Stand-Alone— Path: Status > Control Mode > Disp.

Automated— On the Manual Command window, change your
control mode to Disp.

Shunt calibration cannot be performed on a sensor when it is in
control of the servo loop.

4. Determine the shunt calibration resistor from the following table:

BRIDGE RANGE RESISTOR
RESISTANCE SENSITIVITY (% FULL ScCALE) VALUE
350 Q 2 mVNV 100% 49.9 k
50% 100 k
20% 249 k
10% 499 k
350 Q 1T mV/V 100% 100 k
50% 200 k
20% 499 k
10% 1000 k
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BRIDGE RANGE RESISTOR
RESISTANCE SENSITIVITY (% FULL SCALE) VALUE
700 Q 2 mV/NV 100% 100 k
50% 200 k
20% 499 k
10% 1000 k
700 Q 1 mV/NV 100% 200 k
50% 402 k
20% 1000 k
10% 2000 k

5. Install the shunt calibration resistor as follows:

Select the appropriate shunt calibration resistor.
Bend the resistor leads 90° for a 0.3 inch separation.
Cut the resistor leads 0.12 inch from the bend.

Insert the resistor into the connector solder cups and solder.

m o 0w

Complete and attach a shunt calibration label as specified on
the 493.40/41 Carrier I/O Shunt Calibration Kit (MTS PN 100-
028-185).

F. Install the shunt cal resistor/connector assembly into the
appropriate slot of the SHUNT CAL connector on the front
panel of the appropriate I/O Carrier Module.

/\_/

SHUNT CAL
1 —NA— | — o Opticn Slot 1 Shunt Cal. Resistor Location

2| —AAS— | 4—1 10 Option Slot 2 Shunt Cal. Resistor Location

3| —AMy— | #— 10D Option Slot 3 Shunt Cal. Resistor Location

4 | —\AS— | #— 110 Option St 4 Shunt Cal. Resistor Location

/\_/
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6. Perform shunt calibration.
Stand-Alone:
Path: Setup > Strain > Calibration > Select Cal Type >
A.  Select required Shunt Display units.

B. Ensure that Shunt State (+) is set to On. Polarity is always
positive.

Note the Shunt Reference (+) value, it should be 60%—90%
(80% is ideal) of the calibrated range of the sensor.

C. Click Update to copy the current shunt reference value into
the Shunt Reference box.

D. Set Shunt State (+) to Off.
Automated:

A. In Station Setup select the appropriate strain channel on the
navigation panel., click the Channel Input Signals icon, and
then click the Shunt tab.

B. Select the shunt type. Use (+) polarity if you are not sure
what to select.

C. In the Current Shunt Value box, click the On button. Note
the Current Shunt Value, it should be 60%—90% (80% is
ideal) of the calibrated range of the sensor.

D. Click Update to copy the Current Shunt Value into the
Shunt Reference Value box, and then click Off.

Task 7  Save the calibration settings

It is important that you save your sensor calibration values.

Path: Setup > Open/Save Parameters > <<Save>>
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Chapter7

Tuning

Tuning affects the response and stability of the servo-control loop.
Proper tuning improves the performance of the system.

Note Precise tuning is not necessary. A good tuning adjustment is one
that produces nearoptimal behavior over a wide variety of
conditions.

e Each control mode uses a different sensor feedback signal for
servo-loop control. Each control mode must be tuned.

e  Tuning optimizes test performance by minimizing the system error
in the selected control mode.

Contents  About Tuning 192
If You've Never Tuned Before 193
When to Tune 194
Control Mode Characteristics 196
How the Tuning Controls Work 199
Creating a Tuning Program 207
Other Considerations 210
Monitoring Waveforms 211
Tuning Displacement 215
Tuning Force 216
Auto tuning 217
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About Tuning

About Tuning

Proper tuning reduces

error and phase lag.

When you tune, you are setting the stability and response of the servo
control loop. Proper tuning improves the performance of the test
system.

j Time Lag
Error (phase shift)

Program Command
Feedback (higher Proportlonal gain)
Feedback (lower Proportional gain)

Inaccurate tuning increases the error and phase lag between the
program command and the sensor feedback. Large error reduces
control accuracy and repeatability, and keeps the full program
command from being applied to the specimen.

Compensating for ~ Optimal system operation may require a level of detuning to
specimen changes  compensate for specimen changes during a test.

192

A highly tuned system provides the greatest level of response, but
this places the system near the point of oscillation or instability.

As a specimen changes characteristics during testing, the response
of the system also changes. This can cause unstable operation.

You may need to retune the system response when the
characteristics of the specimen change during a test.

For the greatest control accuracy, use a compensator.
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If You've Never Tuned Before

What if you adjust
something wrong?

Saving the tuning
parameters

If you are unfamiliar with the tuning controls, review the following
guidelines. Before you start tuning you should:

e Define upper and lower limits for the displacement and force
sensor before you start tuning.

e Tune the displacement control mode first since no specimen is
needed.

e Note the value of the tuning control before adjusting it so you can
return it to that value if necessary.

e Make small initial tuning adjustments. If the feedback waveform
does not appear to change, increase the adjustments.

Auto tuning provides a moderate level of tuning for PIDF control
modes automatically. For more information, see “Auto tuning” on page
217.

If you make an inappropriate adjustment, the system will go unstable
or shut down. An unstable system produces humming or screeching
sound. A system shutdown displays an error.

e If an adjustment causes the system to go unstable, quickly readjust
the control until the noise stops. If you cannot eliminate the
sound, shut down the system by pressing the Emergency Stop
switch.

Important  In multi-channel configurations, pressing Emergency Stop
will shut down the HPU and all channels in the interlock
chain.

e If an adjustment causes the system to shut down, readjust the
control to the level where the system was last stable. Then reset
the system and continue tuning.

The tuning values are saved as part of the controller parameter set. The
parameter set can save one set of tuning values for each control mode.
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When to Tune

Tuning is needed whenever any of the following events occurs:

e A gross change in the compliance or size of the test specimen. For
example, you were testing steel and change to rubber.

e  The servohydraulic configuration has changed. For example, a
servovalve is replaced or changed to a different capacity.

e The system is sluggish (slow to react or not reaching the desired
peaks). However, this is not always a tuning problem; it could be
insufficient velocity capability such as a low-capacity servovalve.

e If a control channel or sensor is recalibrated.

e The system is unstable (indicated by a humming or screeching
sound).

e When you observe a degradation in controlled accuracy.

e When you create a new control mode, or, if the sensor for a
control mode is changed.

e The end levels or frequencies are significantly different from those
observed earlier in the test. For example, you notice that the
specimen characteristics change during the test (this could also
mean the specimen is failing).

Checklist Use this checklist when you tune a system. You need to determine the
following:

e What type of control mode do you wish to tune?
Read “Control Mode Characteristics” on page 196.

e What controls should you use?
Read “How the Tuning Controls Work” on page 199.

e What kind of a tuning program should you use?
Read “Creating a Tuning Program” on page 207.

e Do you have a dummy specimen?
Read “Other Considerations” on page 210.

e  Where do you connect the oscilloscope and what signal do you
monitor? Read “Monitoring Waveforms” on page 211.
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What to do first  The following are tasks that should be completed before you tune. It is
not necessary to perform every task each time you tune. The condition
of your system dictates which of the following tasks you must perform.

For example, a new system or a system under complete recalibration
requires all of the following to be completed. If you are performing
periodic or fine-tuning, review the following and determine which
tasks you need to complete.

e  Connect an oscilloscope to your system or use the controller
scope. You need to monitor the sensor signal or error signal for
the control mode you intend to tune. Go to “Monitoring
Waveforms” on page 211 for help.

e Balance the servovalve. The electrical valve balance adjustment
compensates for minor mechanical imbalance—it is an
intermediate adjustment. Go to “Adjusting Valve Balance” on page
75 and perform the electrical valve balance adjustment procedure.

e  Calibrate each sensor used for a control mode or data acquisition.
Perform the appropriate calibration procedure.

e If your sensor calibration schedule does not require calibration at
this time, perform a shunt calibration check to determine if your
DC sensor/DC conditioner is within tolerance. See “Shunt
Calibration” on page 89.

e If you have a three-stage (Series 256 or 257) servovalve, tune the
inner loop (gain and rate) before tuning the outer loop. The rules
for inner loop tuning are similar to those of the outer loop. Go to
“Tuning the Inner loop” on page 77 for help.

Getting started  When you set out to tune your system, it is best to run auto-tuning
first. Auto-tuning establishes reasonable tuning levels that will be
adequate for most control modes. See “Auto tuning” on page 217 for
more information

If the results from auto-tuning are not satisfactory, you should create a
tuning function, and then manually tune each control mode.

Automated  The “Automated” paths and procedures described in this manual

procedures  assume the FlexTest SE Controller is equipped with the PC-Supervision
option, and that Exclusive Control is assigned to Station Manager. For
more information about Station Manager, see the Model 793.00 System
Software manual that accompanies your system.
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Control Mode Characteristics

A control mode uses a program command and sensor feedback to
control the servovalve. The controller uses a group of gain controls—
proportional, integral, derivative, and feed forward gain. These
controls are called PIDF. The PIDF controller can also incorporate
stabilization gain and an adjustable forward loop filter.

sl oo

N . Valve
P dt | Gain + Driver
P FL Filter' >Q—]—>

Compensated —*

e

Command y
Stab Filter? S Gain
Active
Feedback
Stabilization
Feedback

1 FL Filter on the Tuning Menu
Sets filter frequency and select filter type.

2 Stabilization Filter on the Tuning Menu
Sets filter frequency and select filter type.

Each control mode has different tuning characteristics. This section
describes the characteristics of the following control modes:

e Displacement control
e  Force control

e  Strain control

e CLC control

e Dual Compensation control
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Command sources

Displacement control

Force control

Strain control

About Tuning

The program command source can come from an internal source (such
as the Function Generator application) or from an external device
(such as an external profiler or function generator).

Displacement control mode uses the LVDT sensor in the actuator as
the controlling feedback source.

e Displacement control mode only needs to be tuned once.
e Does not need a specimen installed for tuning.

e Displacement control uses a square wave when tuning an LVDT
but not when tuning a displacement gage.

e If gain is too low, there may not be any actuator movement.
e If gain is too high, the actuator will move quickly and noisily.

Force control uses a force sensor (also called a load cell) as the
controlling feedback source.

e Tune for each type of specimen or any changes in the force train.
e  Force control requires a specimen to be installed.

e Force control uses a ramp waveform for the initial tuning. If the
required results cannot be achieved, change to a square
waveform.

e If gain is too low, the system may be sluggish or unresponsive
with large static offsets.

Strain control uses an extensometer or strain gage bonded to the
specimen as the controlling feedback source.

e  Tune for each type of specimen or any changes in the force train.

e  Strain control requires a specimen to be installed (you may choose
to use a broken specimen).

e  Use a ramp waveform for the initial tuning.

e Do not use a square waveform for tuning. A square wave can
cause the extensometer to move or fall off the specimen, which
can cause the system to go unstable.

e If gain is too low, the system may be sluggish or unresponsive
with large static offsets. Or, it may be uncontrollable.
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CLC control mode

Dual Compensation

198

control mode

Channel limited channel (CLC) control modes are used for specimen
installation and removal. Channel limited channels require two
feedback signals. See “Tuning a CLC Control Mode” on page 219

Refer to “Tuning” in Chapter 3, Menus Descriptions of the FlexTest SE
Users Manual for more information about CLC tuning controls and
guidelines.

Select a dual compensation control mode for a channel when the
feedback for the desired control mode is unsuitable for maintaining
closed-loop control.

A dual compensation mode requires a primary and a secondary feedback
signal:

e  The more stable primary feedback signal is used by the PIDF
controller to maintain closed-loop control.

e The less stable secondary feedback signal is used for command
compensation in command programs provided by the Function
Generator and other applications.

Refer to “Tuning” in Chapter 3, Menus Descriptions of the FlexTest SE
Users Manual for more information about dual compensation tuning
controls and guidelines.
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How the Tuning Controls Work

The controller system software includes five tuning controls. You do
not need to use all of the controls to properly tune your system. /n
Jfact, most testing can be accomplished with just the proportional gain
adjustment. The other adjustments introduce a signal to the command
to compensate for specific situations.

Note  Throughout this chapter the terms gain, reset, and rate represent
proportional gain, reset integration, and rate derivative respectively.

The five available gain controls have the following functions:
e Proportional gain (P Gain) increases system response.

e Integral gain (I Gain) increases system accuracy during static or
low-frequency operation and maintains the mean level at high
frequency operation.

e Derivative gain (D Gain) improves the dynamic stability when
high proportional gain is applied.

e Feed forward gain (F Gain) increases system accuracy during
high-frequency operation.

Changing adjustment  For automated systems, It is possible that the amount of adjustment for
ranges  a control is too coarse or inadequate. Click the adjustment button
(such as P Gain) and use the Range Select window to change the
range of the adjustment. Reducing the range produces smaller steps
between values (higher resolution) while increasing the range
produces larger steps between values.

Example: Suppose the default range for the Proportional Gain
adjustment is 50. Assume you are adjusting the gain and you reach the
maximum adjustment (50). Clicking the P Gain slider label displays the
P Gain range window where you can change the range of the
adjustment. Change the range by typing a new value in the maximum
entry field.
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~Tuning: Cl 1 1 Displac t i P Gain <]
Adi"s""emsl Fitter | Range hin: 1.0e-012
PIDF hax: 100000000
Resaolution hin: 0.0000
F Gain: 0.1000 Minimum:
] B " |—
- ! ! ! ! ! ! ! LT b aximum: 100.0000
| Gair: 0.0100 Slider Hes:l 0.0001
A | | | | | | | | | Formatting:E Feset
0.0000 1.0000
Dizplay Unit: | [none] -

Proportional gain (P)  Proportional gain is used for all tuning situations. It introduces a
control factor that is proportional to the error signal. Proportional gain
increases system response by boosting the effect of the error signal on
the servovalve.

The tuning command is

shown as a gray square
waveform, and the black
waveform is the sensor

feedback
Gain Too Low Optimum Gain Gain Too High
Keep in mind:

e As proportional gain increases, the error decreases and the
feedback signal tracks the command signal more closely.

e Higher gain settings increase the speed of the system response.

e Too much proportional gain can cause the system to become
unstable.

e Too little proportional gain can cause the system to become
sluggish.

e Gain settings for different control modes may vary greatly. For
example, the gain for force may be as low as 1 while the gain for
strain may be as high as 10,000.

Note The rule of thumb is—adjust gain as high as it will go without going
unstable.
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Integral gain (I) Integral gain introduces “an integral of the error signal” that gradually,
over time, boosts the low-frequency response of the servovalve
command.

Integral gain increases system response during static or low-frequency
operation and maintains the mean level at high-frequency operation. It
can offset a DC or steady-state error, such as that caused by valve
imbalance.

The following ramp and hold waveforms illustrate different levels of
reset. The I Gain adjustment determines how much time it takes to
improve the mean level accuracy.

Overshoot Hunting

Droop / /

| Gain Too Low Optimum | Gain | Gain Too High Excessive | Gain
Integral gain:

e Improves mean level response during dynamic operation

e  Corrects feedback droop caused by the spring characteristic of the
servovalve in static and very low-frequency test programs

e  Minimizes the amount of time the system needs to recover from
transitions or transients

Keep in mind:
e Higher integral gain settings increase system response.
e Too much integral gain can cause a slow oscillation (hunting).

e You may want to use the max/min display to monitor the mean
level, reset the display, and check it again.
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Derivative gain (D) Derivative gain is used with dynamic test programs. It introduces a
“derivative of the feedback signal.” This means it anticipates the rate of
change of the feedback and slows the system response at high rates of

change.
Overshoot
Ve
Ringing JV\’ , J{\I\N\/\A
Needs Rate Optimum Rate Too Much Rate Excessive Rate

Derivative gain:
e  Reduces ringing

e  Provides stability and reduces noise at higher proportional gain
settings

e Tends to amplify noise from sensors
e Tends to decrease system response when set too high
Keep in mind:

e Too much derivative gain can create instability at high
frequencies, and too much proportional gain may cause a ringing
or screeching sound.

e Too little derivative gain can make a rumbling sound. The correct
amount of derivative gain results in the system running quietly.

Note  Series 256 and 257 Servovalves may require derivative gain applied
to both the inner control loop and outer control loop.

Note  Excessive negative (-) D Gain can cause your system to become
unstable.
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Feed forward gain (F) Feed forward gain is like derivative gain except that it introduces a
derivative of the command signal. It anticipates how much valve
opening is needed to reach the required response and adds that to the
valve command—Ilike compensating for phase lag.

Adjusting feed forward causes
the command to begin sooner
so the feedback may track the
original command more
closely

About Tuning

Original Command

Feed Forward Command Original Feedback

Feed forward gain:

Does not compensate for normal changes during testing (such as
temperature changes, servovalve droop, and so forth).

May be used to minimize phase lag.

Should be used in a way similar to derivative gain. However, it is
applied to the test command signal instead of the feedback signal.
Feed forward gain helps the servo-control loop react quickly to an
abrupt change in the command.

Is needed when testing a soft specimen in force control.

Stabilization Stabilization gain allows a second signal to be integrated into the
gain (S) composite command signal as a stabilizing factor. It enhances stability
for systems that move large masses at high speeds. The second signal
is generated by a special transducer such as AP (differential pressure)
or accelerometer.

Stabilization controls will be available only if a stabilization resource
was added to the control channel in the Station Builder program.
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Delta P (AP)

Delta P is a differential pressure sensor that measures the difference in
pressure at each end of the actuator. It compensates for hydraulic
compliance (compressed hydraulic fluid acts like a spring). Delta P
improves displacement control of heavy mass loaded systems.

Delta P is typically used on systems with large hydraulic fluid flow
rates. This adjustment is usually needed when the natural frequency of
the actuator is less than the 90° phase lag frequency of the servovalve.
The servovalve 90° phase lag frequency can be found in the servovalve
product literature.

The natural frequency can be approximated with the following
formula:

CA
Actuator Frequency = —
equency WV
Where: C = constant for English (2500) or metric units (1060)
A = actuator piston area expressed as in? (cm?)

W = any directly coupled mass including the actuator piston
mass expressed in Ibs (kg)

V' = hydraulic fluid volume contained inside the actuator and

manifold expressed as in® (cm3)

e If the system response deteriorates when adding delta P, then
change the polarity of the signal. If changing polarity does not
improve system response, try adjusting the stabilization filter. See
“Stabilization Filter” on page 206

e Check all amplitudes for overshoot. Do not allow more than 10%
overshoot (preferably none) at any amplitude of a square wave
response.

e Delta P will not compensate for additional compliance from
swivels, linkages, test tables, and so forth. In this case, a mass
accelerometer signal from an accelerometer may be used in place
of a delta P signal for stabilization. See “Acceleration stabilization'
below.
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Acceleration Test systems with specimens affected by acceleration resonances can

stabilization use a mass accelerometer signal for stabilization. Acceleration
stabilization dampens the resonances (vibrations) affecting the
specimen.

Typical systems that benefit from acceleration stabilization include:

e  Load units that operate at high frequencies with massive grips

e Test systems that employ swivels, linkages, and test tables

Sensor feedback is provided by an accelerometer attached to (or near)
the specimen. The controller converts this feedback into a stabilization
signal which is combined with the composite command signal (post-
PIDF correction). The “stabilized” command signal is then sent to the
valve driver.

Note  Acceleration stabilization works to minimize compliances from
swivels, linkages, and test tables. Acceleration compensation is
used to correct the signal from a moving load cell. The system
software does not support acceleration compensation.

Forward loop FL filter adjustments compensate for noise in the servoloop—which
filter (FL) usually comes from sensor feedback. FL filter adjustments establish a
frequency bandwidth for the servo-loop command signal.

Noisy Feedback D Gain Amplifies Noise Not All Noise
is Removed
Keep in mind:
e By default, the FL filter is set to one-half the system rate.
e  The minimum FL filter frequency setting is 0.01.

e Be sure the forward loop filter frequency is higher than any
frequency in the test program. (Most testing occurs below 50 Hz.)

e  Systems with moving load cells or heavy grips can produce a
noisy force signal.
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e If you observe a noisy sensor feedback signal, reduce the FL filter
setting to about 100 (providing your test does not reach 100 Hz).
If additional adjustment is needed, reduce the setting by 5 - 10 Hz
at a time.

Stabilization Filter  Use this feature to define the characteristics of the stabilization filter,
which works with the S Gain to integrate a second signal in the control
mode as a stabilizing factor. Some systems with a higher actuator
frequency may benefit from changing the filter setting for the
stabilization signal.

Stabilization filters are only available for control modes equipped with
stabilization resources and include:

e A 1Hz High-pass filter that attenuates signals below 1 Hz.

e A Band-pass filter that attenuates signals outside of a user-
definable band.

Stand-Alone Systems  To select a Stabilization filter, select, and set up the desired filter type
of 1 Hz High-pass or Band-pass.

Path: Tuning > Manual > Stabilization Filter > Filter Type

—  For Band-pass filters, use Filter Min and Filter Max to set
the frequency band.

Note Some systems with a higher actuator frequency may benefit by
selecting the following frequency limits: a low cut-off frequency
(Filter Min) that is approximately the actuator frequency and
a bigh cut-off frequency (Filter Max) approximately 5-10
times the actuator frequency.

Refer to “Tuning” in Chapter 3, Menus Descriptions of the FlexTest SE
Users Manual for more information about the stabilization filter settings.

Automated Systems  See “How to Enable a Tuning Filter” in Chapter 5, Tuning of the Model
793.00 System Software manual for a detailed procedure for changing
the stabilization filter setting.
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Creating a Tuning Program

The purpose of a tuning program is to produce a command that
reflects the most demanding system response expected from a test.

Note The Function Generator is very useful for quickly setting up a
tuning program.

Initial tuning is best done with a waveform that has abrupt changes.
This excites the system at frequencies likely to be unstable with
excessive gain. Square and ramp waveforms are preferred. Final tuning
can be done with the actual program command for the test.

Note  Always monitor the sensor feedback or error signal to evaluate the
control accuracy. See “Monitoring Waveforms” on page 211.

A typical tuning program is a low-amplitude (5% to 10% of full-scale),
low-frequency (1 Hz to 2 Hz) square waveform.

This section describes how the amplitude, frequency, and waveform
type of a tuning program can be selected to reflect the capabilities of
the testing system or the testing requirements.

Auto tuning Auto tuning provides a moderate level of tuning for PIDF control
modes.

Auto tuning exercises the actuator (with a sweep function) while
monitoring the feedback of the control mode being tuned. The
response of the control mode is determined and the appropriate tuning
parameters are calculated.

For more information, refer to “Auto tuning” on page 217.

Command waveforms A tuning program produces a cyclic program command to exercise the
system while you make the initial tuning adjustments. A square wave is
best because it demands the maximum response of the servo hydraulic
system. The square wave tuning program may not be suitable for all
systems. The following describe the different waveform characteristics:
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Square/Tapered Square

Ramp/Tapered Ramp

Sine/Tapered Sine

208

A square waveform requires the servovalve to open rapidly to a large
opening. It is the most demanding waveform because it requires the
maximum response from the servoloop system. It also places a large
acceleration on the test system and specimen.

Tapered square waves taper from 0% to 100% amplitude at the
beginning of execution, and from 100% to 0% at the end of execution.

e A square waveform is most useful for tuning displacement.
e A square waveform has an infinite velocity command.

e Do not use a square waveform when tuning a control mode that
uses an extensometer. The large accelerations can cause the
extensometer to move or fall off the specimen, which can cause
the system to go unstable.

e Monitor the feedback or error signal to evaluate the system
stability.

A ramp waveform (also called a triangle waveform) requires the
actuator to move at a constant rate. This requires the servovalve to
move quickly between two discrete openings. Cycling a ramp
waveform produces a triangle waveform.

Tapered ramp waves taper from 0% to 100% amplitude at the
beginning of execution, and from 100% to 0% at the end of execution.

e A ramp waveform is useful for all levels of tuning.

e Use a ramp waveform if a square waveform creates excessive
velocities or acceleration for the type of specimen being tested.

e  Monitor the feedback or error signal to evaluate the system
stability.

A sine waveform (also called sinusoidal or haversine) requires the
servovalve to move at a variety of rates.

Tapered sine waves taper from 0% to 100% amplitude at the beginning
of execution, and from 100% to 0% at the end of execution.

e Monitor the feedback or error signal to evaluate the system
stability.
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Random function When tuning AIC compensator configurations, it is necessary to
generator  generate random functions to properly simulate typical test conditions.

Random functions employ a pre-emphasis filter to make the
convergence rate constant over all frequencies. The random function
options include:

e Random - 1/F?
e Random - 1/F

e Random - Flat (none)

e Random - F
e Random - F?

Frequency A low-frequency waveform is adequate for most testing. Tests at higher
frequencies cause a frequency shift that cannot be completely
corrected with the PIDF adjustments.

e Do your initial tuning at a low frequency, and then fine tune at the
highest frequency in your test program. Common values are
1-2 Hz.

e Servo adjustments that do not improve performance at high
frequencies generally indicate that the servovalve is running at
100% capacity or the HPS is running at 100% capacity.

This characteristic can easily be seen when tuning with a sine
waveform. The feedback waveform appears to be more like a ramp
waveform when running at 100% capacity.

Amplitude A system tuned at a low amplitude may become unstable at high
amplitudes. Tuning should be accomplished under conditions similar
to the anticipated usage.

e  Use a moderate amplitude (5% to 10% full scale) for initial tuning.

e Be sure the maximum velocity of the tuning command is 10% to
50% of the maximum velocity of the system.

e Increase the amplitude for fine tuning.

e You may find it helpful to check tuning over a variety of
amplitudes by creating a test that cycles once at each of the target
amplitudes.
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Other Considerations

Servovalves

Using specimens

Tuning without dummy
specimens

210

Most of the servovalve adjustments are performed during the system
installation and do not require periodic adjustment. There are two
types of servovalves:

e Three-stage servovalves, such as the MTS Series 256 and 257
Servovalves, have an inner loop control system which must be
tuned before the outer loop can be tuned.

e Two-stage servovalves, such as the MTS Series 252 Servovalves,
do not have inner loop tuning requirements.

After initial system tuning and before final tuning, the valve balance
should be checked and adjusted if necessary.

Specimens can be very expensive. A dummy specimen is an
inexpensive material that has similar characteristics to the specimen
selected for testing. The most important specimen characteristic is its
spring rate.

The advantage of a dummy specimen is that it can simulate how your
testing system reacts to real specimen. You can establish a more
precise level of tuning with a dummy specimen.

If you do not have a dummy specimen or if a dummy specimen is not
practical, review the following recommendations if you must use a real
specimen:

e  Start your PIDF controls at minimum settings.

e Do not use a square waveform for a massive specimen or a
specimen prone to vibrations.

e Adjust rate to minimize any oscillation, overshoot, or ringing in
the waveform.

e Be very conservative by beginning with a ramp waveform to
establish initial control. Then use a waveform that resembles the
test waveform to provide a precise level of control.
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Tuning without a A specimen is required to tune force and strain control modes. Initial
specimen force tuning may be accomplished with the actuator up against the
force sensor. The actuator acts as a specimen reacting against the force
Sensor.

1. If you are using a load frame, adjust the load unit crosshead so the
actuator can reach the force sensor.

2. Carefully adjust the actuator using a tuned length control mode so
it contacts the force sensor.

3. You can now switch to force control and proceed with initial
tuning.

Monitoring Waveforms

When you tune the servoloop you need to monitor the results of your
adjustments. There are two ways to monitor a waveform during tuning.

e An oscilloscope is preferred.

e The controller scope is adequate if you do not have an
oscilloscope.

Note  Set up your scope to monitor the area of the waveform that shows
characteristics useful for tuning. You can monitor the sensor
feedback or the error signal of the control mode.

What to monitor  The accuracy of the waveform represents how well it reaches the
amplitude of the command or how repeatable the end levels are. The
peaks and valleys of triangle and sine waveforms should be consistent.
Use the area of the square wave after the ringing settles to monitor the
end levels.

These are the areas of
interest on these
You do not need to monitor waveforms

the entire waveform. J \

Instead, zoom in on the
area of interest.
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If the amplitude of the feedback cannot be achieved without going
unstable, and the end levels are repeatable, simply increase the
command to achieve the desired end levels.

Monitoring the  The error signal shows similar characteristics as a feedback signal. The
error signal  error signal represents the difference between the command and
sensor feedback. The following diagrams show the error signal
characteristics for each type of waveform.

A square waveform is best suited to view the overshoot and ringing
characteristics that occur when tuning a system. Review the following
waveforms to determine the kind of characteristics that can be found
in an error signal.
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The error signal from a square
wave should show the
feedback ringing centered on
the zero reference.

A static accuracy difference in
the error signal can be
corrected with reset.

The square wave shape of the
error signal represents the
phase lag of the feedback
signal.

The error signal from a sine
should be a small amplitude
sine waveform that looks like a
rounded square waveform.

Using the
controller scope

Model 493.02 Controller Service
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Command

Feedback
Static
Zero _ % Accuracy
/ Difference
Error
Signal
Command / Feedback
N I Following Error
Zero 7 Difference
Error
Signal
Command

\ / Feedback
Actuator
/ Friction
N\
- al \\_//
Error

Signal

If you do not have an oscilloscope, use the controller scope feature for
tuning control modes. Review the following:

Select Scope on the FlexTest SE front panel (Stand-Alone) or
Scope on the Station Manager Display menu (Automated).

Select a continuous sweep.

Enter the minimum and maximum ranges on the Y axis to zoom
into the area of interest.
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Using an oscilloscope

214

For more information on the controller scope, refer to the FlexTest SE
Users manual.

An oscilloscope has a higher resolution and is faster than the software
controller scope. Review the following:

You must have a Readout defined.

Set up the Readout to monitor the sensor signal of the control
mode you intend to tune.

Or, you could monitor the error signal. You can tune using either
signal.

Connect the oscilloscope to the appropriate BNC connector on the
Model 493.40 I/O Carrier module located at the rear panel of the
Model 493.02 Chassis.

Note You can also connect an oscilloscope to one of the BNC connectors

on the FT SE Controller front panel (Monitor 1/Monitor 2).
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Tuning Displacement

When to tune

Prerequisites

Tuning procedure

A displacement control mode uses the feedback signal from an LVDT
(linear variable differential transformer). You do not need a specimen
to tune a displacement control mode.

A displacement control mode usually only needs to be tuned once.

However, you may want to retune a displacement control mode if:

e The fixtures attached to the actuator have changed (such as grips).
The main tuning factor is a change in the mass attached to the
actuator.

e Any time hydraulic system potential has changed, such as after
servovalve, hose, or pump replacement.

e You want to fine tune the control mode.
e The LVDT ranges are changed.

e You deem it necessary as a result of scheduled system calibration
or you feel system response should be improved or reduced.

Be sure the following items are completed before you begin tuning the
displacement control mode:

e Hydraulic pressure is off.

e The specimen is not installed.

e You have created a station configuration file.
e  You have created a station parameter set.

Refer to “How to manually tune the displacement control mode” in
Chapter 2, Common Tasks of the FlexTest SE Users manual for a
detailed tuning procedure.
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Tuning Force

To complete this task, you will make sure the force tuning values
established in your station parameter set are appropriate for the test
you are about to run. To do this, you will:

e Create and apply a simple tuning program.

e  Evaluate the current force tuning values by comparing command
and feedback signals.

The displacement tuning values established in the station parameter set
are unlikely to require adjustment. Optimal force tuning values,
however, are a function of your specimen’s compliance, which may
change over time, or from test-to-test. You should also tune force
whenever you make any change to the force train (such as changing
fixtures).

Prerequisites Be sure the following items are done before you begin tuning the force
control mode:

e Hydraulic pressure is off.

e  The specimen is not installed.

e You have created a station configuration file.
e  You have created a station parameter set.

Tuning procedure  Refer to “How to manually tune the force control mode” in Chapter 2,
Common Tasks of the FlexTest SE Users manual for a detailed tuning
procedure.
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Auto tuning

Purpose

How auto tuning
works

Accepting the auto
tuning values

The auto tuning feature automatically calculates tuning values for PIDF
control modes.

Note  Auto tuning is only available for PIDF control modes.

The auto tuner disregards your current PIDF gain settings. It applies
the minimum required drive signal to ramp the feedback to 80% of the
auto tuning limits. It then measures the relationship between the
feedback velocity and the valve opening, and derives the minimum
PIDF gains required to track the command.

The majority of tests will run adequately with the settings calculated
through basic auto tuning, however, advanced auto tuning may be
used to optimize the results obtained through basic auto tuning.

The Current column displays your current PIDF gain values. When
auto tuning completes successfully, the calculated tuning parameters
are loaded into the New Values column on the Auto-Tuning control
panel.

You can click Accept to transfer the auto-tuned values (New Values)
to the Current column and the tuning Adjustments tab.
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How to Auto-Tune Control Modes

Auto-tune the
displacement control
mode

Auto-tune the force
control mode

218

First, auto-tune the displacement control mode. Then install a dummy
specimen and auto-tune the force control mode.

See “How to auto-tune” in Chapter 2, Common Tasks of the FlextTest
SE User’s manual for a detailed procedure.

See “How to auto-tune” in Chapter 2, Common Tasks of the FlextTest
SE User’s manual for a detailed procedure.
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Tuning a CLC Control Mode

CLC control modes are used for specimen installation and removal.
Channel limited channels require two feedback signals. The first one is
used as the master feedback (it is normally displacement) and the
second one is used as the limiting feedback (it is normally force).
When you command the actuator over a channel limited channel, the
controller will not allow the actuator to exceed limits specified on
either the master or limiting channels.

If force feedback = upper limit
And displacement error is positive

Then use upper limit error

Upper Limit

Limit Error

el [ =]

Feedback

If force feedback < lower limit

And displacement error is negative
Then use lower limit error

Lower Limit

Lower
Limit

Manual Displacement . )
@ P Otherwise use displacement error
Command X= Error
Displacement 10.0
Servovalve
Feedback el [ [>]

. . Command
Proportional Gain

The CLC control mode uses one of three error signals. The Limiting P Gain
adjustment acts as a conversion factor to scale the limit feedback to similar
units as the active P feedback.

Refer to “Tuning” in Chapter 3, Menus Descriptions of the FlexTest SE
Users Manual for more information about CLC tuning controls and
guidelines.
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Appendix A

Hydraulic Configurations

This section describes how to connect the Model 493.02 Chassis to a
variety of MTS hydraulic configurations.

You will use the following connectors and cables to connect the Model
493.02 Chassis to your HPU or HPS:

493 Chassis to
493.07 HPS Converter

493.07 HPS Converter
to HPS

15 contact type D female EMI connector at J25 of the 493.42
System I/O module in the rear panel of the Model 493.02 Chassis.
Backshell-EMI metallized plastic.

14 contact type CPC male connector at J1 of the 493.07 HPS
Converter chassis.

Cable-24 AWG 10 conductor with overall foil shield, (Carol C0745
or equivalent) with drain wire connected to metallized plastic
backshell at the 493.02 chassis, and pin 14 at the 493.07 HPS
Converter chassis.

24 contact type CPC female connector at J25 of the 493.07 HPS
Converter chassis.

14 contact type MS connector at J1 of the HPS.

Cable-18 AWG 14 conductor with overall foil shield, (Alpha 2248C
or equivalent) with drain wire connected to pin 4 of connector J25
and pin A of the pump connector.

Hydraulic pump  The following diagrams show how to connect the chassis to a
configurations  hydraulic power supply.

Model 493.02 Controller Service

Single 493 chassis with a 24 V PLC (programmable logic
controller) pump or 505 pump

Single 493 chassis with a non-PLC pump
Multiple 493 chassis with a non-PLC pump

Compatible controllers controlling a pump
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Single 493 Chassis with a 24 V PLC pump (506.52-.92) or 505 pump

397137-XX

493.02
- HPU
Chassis DJZS

HPS

Note The following three configurations have cables to support both 24 V/
DC and 115 V AC control voltages. A 493.07 HPU Converter Box is
available for each voltage (not both). Be sure the cables and HPU
Converter box are rated for the same voltage.

Single 493 Chassis with a non-PLC pump
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397138-XX (24 V DC) 397107-XX (24 V DC)
397146-XX (1151 AC) 493.07 397108-XX (115 V AC)
éf?ags(s)lzs j HPU Converter j HPU
J25 J1 Box J25
HPS HPS HPS

Multiple 493 Chassis and 407 Controllers

397138-XX (24V DC)
397146-XX (115V AC) 397107-xx (24V DC)
397108-xx (115 AC)

493.02
Chassis D

493.07
HPU HPU
Converter J25
HPS HPS

493.02
Chassis D

.
’

HPs — low level Y cable 397135-01
/OR
- 7 501822-XX
407 Controller [ .; /' 519958-XX (CE)
125
HPS
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Compatible Controllers

397107-XX (24V DC) High-Level Y cable
397108-XX (115V AC) 054078-01 (24V DC)

397138-XX (24V DC) 054018-01 (115V AC)
397146-XX (1156 AC)

493.07

493.02 Pump ] [] \ HPS

Chassis Interface [ J25 L

HPS HPS HPS
L]

458* or . 397087-XX (24V DC)
490.01 * j_L 397088-XX (115 AC)
49705*

* For standard 493.07 jumper setting only. Alternate settings are required for 436.11 and 413.05 controllers.

You can mix 493.07, 458, 490. and 497.05 controllers directly on the
same HPU (without the use of an HPU isolation box).
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You cannot mix 493.07, 458, 490. and/or 497.05 controllers with 436,
413.05, or 413.8X controllers unless you use an isolation box.

You can jumper the 493.07 converter box so you can use it directly
with 436 and 413.05 controllers. However, if you do this you must use
an isolation box if you attempt to mix the 493.07 with 458, 490, and
497.05 controllers. See Appendix B, “Model 493.07 HPU Converter” on
page 229
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Multiple Controller Interconnections

FlexTest SE supports the following hydraulic interconnections for
multiple controller configurations:

7
=
S

-
©
T
=
>

=
=
S

()

2
=
©
T

=
>

==

Independent HSM control with no HPU
Independent HSM control with a shared HPU
Shared HSM with an HPU

Shared HSM without HPU

Independent HSM controlled with a shared HPU using first-on-
last-off

See“Multiple Controller Connections” on page 43 and the FlexTest SE
User’s Manual for more detailed information multiple controller
configurations.

Independent HSM (no HPU)

Power Type = HSM Only

Interlock/Hydraulics

563160-xx

>

561264-xx

J28 HSM J28 HSM

561264-xx

HSM 1 HSM 2

For this multiple controller configuration:

224

Each controller has an independent hydraulic service manifold
(HSMD.

No hydraulic power unit (HPU) is connected.
Select HSM Only for Power Type on each connected controller.

Path: Config > Edit Hardware > Power Options > Power Type
> HSM Only
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Independent HSM (shared HPU)

Power Type = HPU/HSM Power Type = HPU/HSM

Interlock/Hydraulics
563160-xx

BEEE
BOEEE

561264-xx 397138-xx

HSM 1 397135-xx HSM 2

HPU
Converter

397107-xx

HPU

For this multiple controller configuration:
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e  Fach controller has an independent hydraulic service manifold
(HSM).

e An HPU is shared by all connected controllers via Y-cables.
e Select HPU/HSM for Power Type on each connected controller.

Path: Config > Edit Hardware > Power Options > Power Type
> HPU/HSM
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Shared HSM (with HPU)

Power Type = HPU/HSM Power Type = Slave HSM

- REE
(ﬁ <Q> BEE
, E
& ©\Su

561264-xx

o \DEE)|

Interlock/Hydraulics ”
563160-xx k S0 E=ZE:

397137-xx

HSM HPU

For this multiple controller configuration:

e The HSM and HPU are connected to one controller only.
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e  Select HPU/HSM for Power Type on the controller to which the
HSM and HPU is connected.

Path: Config > Edit Hardware > Power Options > Power Type
> HPU/HSM

e Select Slave HSM for Power Type on controllers connected to the
"master" controller.
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Shared HSM (no HPU)

Power Type = HSM Only Power Type = Slave HSM

DO6|E i 65
[5]o)

Interlock/Hydraulics ‘ (=
563160-xx

561264-xx

HSM

For this multiple controller configuration:

Model 493.02 Controller Service

An HSM is connected to one controller only.

Select HSM Only for Power Type on the controller to which the
HSM is connected.
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Path: Config > Edit Hardware > Power Options > Power Type
> HSM Only

Select Slave HSM for Power Type on controllers connected to the
"master" controller.
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Independent HSM with HPU (FO-LO)

Note This interconnect option is only available for controllers on the same
interlock.

Power Type = HSM Only

Interlock/Hydraulics
563160-xx

561264-xx

397137-xx

HSM 1 HPU HSM 2

For this controller configuration:

7
=
S

-
©
T
=
>

=
=
S

()

2
=
©
T

=
>

==

e Two or more FlexTest SE controllers are connected.

e An HSM is connected to each controller only.

e Select Auto. HPU/HSM for Power Type on the controller to which
both a HSM and HPU is connected.

Path: Config > Edit Hardware > Power Options > Power Type
> Auto. HPU/HSM

e Select HSM Only for Power Type on controllers with an
independent HSM, but no HPU.

Note The HPU can be connected to any controller in the interconnected
group of controllers.
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Appendix B

Model 493.07 HPU Converter

A\ CAUTION

J25
To HPU H[

The 493.07 HPU Converter (PN 499694-xx) is designed to connect the
493.02 chassis to a hydraulic power unit (HPU) such as MTS Model 506
HPS or equivalent relay-operated pump. The HPU converter converts
logic-level signals to and from the 493.02 chassis to relay signals used
by the HPU pump.

For pumps that are 24V PLC compliant, the HPU converter is not
needed. This includes all Series 505 HPUs and 506.52-.92 HPUs.

. ________________________________________________________________________________________]
You must have the Model 493.07 HPU Converter designed for the correct
voltage before installation. Connecting a 24 V interface box to a 115 V
(AC) HPS causes improper operation.

Be sure the voltage marked on the cover of the 493.07 HPU Converter
matches the required voltage for the hydraulic power supply.

The following figure shows the main components of the 493.07 HPU
Converter, including connectors and jumpers.

(Shown with cover removed)
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4\ CAUTION

Jumper
configurations
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Disconnect all cables from the Model 493.07 HPU Converter before
removing the cover. Failure to do so could expose the operator to
dangerous voltages.

If the HPU Converter remains connected to a 120 volt HPS, this voltage will
be present. Always remove all cable before removing the cover.

As shipped, the HPU interface on the 493.07 HPU Converter is
compatible with 458.10/.20, 490.01 (TestStar 1), 493.xx, and 497.05
controllers.

The 493.07 HPU Converter may be connected to other controllers (as
shown in the following table) using a “Y” cable.

Note If the 493.02 chassis is the only device connected to the HPU, the
Jjumper settings do not matter.

COMPATIBLE WITH JUMPERS

Model 458.05/.10/ .20/.40 Standard jumper setting:
Model 490.01

Model 497.05 E10-E13 remove

E14-E17 remove
E10-E11 install
E12-E13install
E14-E15 install
E16-E17install

Model 413.05 Jumper change required:
Model 436.11
Model 407.05 E10-E11remove

E12-E13 remove
E14-E15remove
E16-E17remove
E10-E13install
E14-E17install

Note  The Model 493.07 HPU Converter can not be compatible with both
groups of controllers at the same time. If this functionality is
needed, use an HPS isolation box.
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Appendix C

Service Tools

A Service Tool application is provided with FlexTest SE systems to
perform the following tasks:

e Install or update new versions of 793 software for both stand-
alone and automated configurations, including multi-controller
systems

e Backup and restore test information files including hardware
configuration (.hwi), station configuration (.cfg), and *.txt files.

e  Set a controller box name and ID number

e  Configure a controller box to boot in automation or stand-alone
mode

e  Register, unregister, and enable a controller for automation mode

$|00] 89IAIaS
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FlexTest SE Service Tool Application

A Service Tool application is contained in the system software installed
on your FlexTest SE controller.

Upon launching this application the FlexTest SE Service Tool
Application window is displayed.

#+ 793.00 FlenTest SE Service Tool Application |

Select a FlenT est SE Controller to Service

Controller Mame | ID| IP Address | Enabled | Heg\stered| Connected |

Eiow_(E NGO 0 1431502038 e Yes Yes
Box_0EMGOOO3 Tes

Select a Mew Controller Boot Mode Current Boot Mode
Search for Controllers Standalane w/Netwark Mod-j |5tanda|one w/Netwark Mode

Select Service Operatior: Autamation Made Setup

Fegister Cantraller
Unregizster Controller
Enatle Cantraller

Imstall System Filss Ipdate Uszer Files Update System O ptions

Update System Files Backup ser Files

Controller found. Please change the mode of the chassis to SERVICE mode.

You can use this window to perform the following tasks:

e Verify that the correct software version is installed.

e Copy required system files to a specified controller.

e  Copy/restore required user files to a specified controller.

e Backup user files from the FlexTest SE controller to your PC.

e Modify system options stored in the registry.ini file that is specific
to a particular controller.

e  Retrieve a crash dump file from a specified controller.
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Service Tool Application (part 1 of 2)

ITEM

DESCRIPTION

Search for Controllers

Initiates search for all FlexTest SE controllers connected to your PC
network. Search results are displayed in the list at the top of the window

Connected controllers

This list displays each FlexTest SE controller connected to or registered
on your PC including its name, ID, and IP address. Select a controller to
service from this list

Select a New
Controller Boot Mode

Allows you to select another boot mode for the selected controller.

Current Boot Mode

Displays the current boot mode for a selected controller: automated,
stand-alone, stand-alone w/network, or service.

Select Service
Operation

Install System

Removes all files stored on the selected FlexTest SE controller, and then

Files copies all system software files to this controller.
Note  You should back up user files before selecting this option. A warning
message prompts you to back up these files.
Update Copies all system software files to the selected FlexTest SE controller.

System Files

You will not be prompted to verify overwriting any existing files.

Update User
Files

Copies all user files to the selected FlexTest SE controller. If the same file
exists on the controller, the user will be prompted to verify overwriting
the existing file.

Note The user is not allowed to select individual files to copy; only the
source root directory (e.q., a floppy disk).

Backup User

Copies all user files to a designated root directory destination.

Files

Update Allows you to configure the FlexTest SE registry.ini file. Dialogs prompt
System the user to enter required information including .hwi filename,
Options passwords, and system options.

Automation Mode
Setup

Register
Controller

Creates a controller-specific folder (e.g., box a) in the "Boxes" folder on
the disk. The .hwi file and config folder are then copied to this new
folder from the controller being registered for use when running
automation mode.

$|00] 89IAIaS
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Service Tool Application (part 2 of 2)

ITEM

DESCRIPTION

Unregister
Controller

Deletes a controller-specific folder from the "Boxes" folder on the disk.

Note  You have the option of not deleting this "Boxes" folder containing both
the .hwi and config files.

Enable
Controller

Enables a selected controller. In multi-controller configurations you must
enable each controller you are using in automation mode.
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Initializing a FlexTest SE Controller

To initialize a FlexTest SE controller, use the FlexTest SE Service Tool
application to perform the following functions:

e Locate all available controllers and display controller information
on the Service Tool window, including controller ID and IP
address

e  Required system and user files are copied to the selected
controller

e The selected controller can be registered and enabled for use in
automation mode.

Procedure The following procedure assumes that each FlexTest SE controller is
configured for service mode and connected to a PC.

1. Open the FlexTest SE Service Tool Application window
2. Search for all available controllers.

Select Search for Controllers on the FlexTest SE Service Tool
Application window. Select controller to service from the
displayed list of controllers.

3. Copy necessary system files to selected controller.
Select either Install System Files or Update System Files.

Note  Selecting Install System Files will delete all existing files before
copying system file to the controller. Be sure to back up user files to
the PC before making this selection.

4. Copy necessary user files to selected controller.

Select Update User Files to copy all user files. You will be
prompted to select a root directory on the PC which contains user
files to be copied.

If the automation package was purchased and the selected
controller is to be used in automation mode, complete steps 5
and 6. In not, the procedure is completed.

$|00] 89IAIaS
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5. Register the selected controller.

Select Register Controller to create a controller-specific folder
(e.g., box a) in the "Boxes" folder on your PC registry. The .hwi
file and config folder are then copied to this new folder from the
controller being registered.

6. Enable the selected controller.

Select Enable Controller on the FlexTest SE Service Tool
Application window.
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Updating System Options

Selecting Update System Options on the FlexTest SE Service Tool
Application window opens the System Options window which allows
you to configure the FlexTest SE registry.ini file

You can use the System Options window to change system options,
passwords, and chassis attributes. Hardware configuration file, station
configuration file, and unit assignment set file selections can also be
made here.

System Options Tab

The System Options tab allows you to install options for your FlexTest
SE controller. Check the appropriate option box, then enter the
corresponding option key provided by MTS Systems.

System Options il
Chazzis Attributes | Pazswords Uzer Filez
System Options | Unit &ssignment Set

Place a check in the box under Install nest to the options
you wizh toinzstall. Enter the options key provided to pou
by MTS Systems.

Inztall Optiot Key Description

™ Im Advanced Function Eeneration
i I? Auto-Tuning

I~ Im Scope

r I— PP Optimizer

ak I Cancel Apply Help

(7]
[2°]
-
=,
[x]
[5°]
3
=3
(]
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Unit Assignment Set Tab

Use the Unit Assignment Set tab to enter the file name for a default
Unit Assignment Set.

System Options il
Chazzis Attributes Pazswords | Uzer Filez |
Systern O ptions Uit Azsignment Set

Select a default Unit Azsignment Set file.

ak I Cancel Apply Help
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Chassis Attributes Tab
Use the Chassis Attributes to:

e  Enter a name for the controller selected on the FlexTest SE Service
Tool Application window.

e  Enter a unique ID number for the controller selected on the
FlexTest SE Service Tool Application window.

System Dptions x|
System Options I Unit Azzignment Set
Chassis Attribubes | Pazswords Llser Files

Enter a unique name for this controller chassis.

Enter an D [between 1 and 18] for this contraller chazsiz,

Mote: This chassiz D determines the netwark, TCRIF
address of the contraller on the netwark. Each
controller on the zame network, must have a unique 1D,

o -] [148.150.203.8

Chaszsiz IP address for selected 1D

0K, I Cancel Spply Help

(7]
[2°]
-
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[x]
[5°]
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(]

Model 493.02 Controller Service 239




Passwords Tab

Use the Passwords tab to enter passwords for tuning, calibration, and
configuration level access for the selected controller.

System Options il
System Options | Unit &zzignment Set
Chazsis Attributes Passwords | Iser Files

Enter a paseword for Tuning level access.

Enter a paseword for Calibration level access.

Enter a paseword for Configuration level access.

0K I Cancel Snply Help

Important  Passwords should only containing characters found on
the controller front panel’s numeric keypad. These are the
only keys available when entering passwords in stand-
alone mode.
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User Files Tab

The User Files tab allows you to select the name of both the hardware
configuration file and station configuration file for the controller
selected on the FlexTest SE Service Tool Application window.

System Options : |
System Optionsg I nit Azzignment Set I
Chassiz Attributes I Passwards Iser Files

Select the name of the hardware configuration file for thig chazsis,

Select the name of the station configuration file for this chaszis.

ftze.cfg j

0k I Cancel Spply Help
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Index

Numerics

252 servovalve
I/O carrier connection 49
256 servovalve
I/O carrier connection 50
257 servovalve
I/O carrier module connection 51
493.07 HPU Converter 229
493.42 System 1/O
auxiliary power connection (J43) 65
E-stop connection (J29) 62
HPU connection (J25) 59
HSM connection (J28) 61
Interlock connection (J43) 64
493.42 System 1/O module
description 58
793.00 System Software 23

A

AC conditioners

calibration 99

polarity 109, 133
AC power connections 34
acceleration, stabilizing with 205
accelerometer

I/O carrier connection 55
accessing the online manual 11
actuator

determine natural frequency 204
analog I/O

cable specifications 53

I/O carrier connections 52
auto tuning 207, 217

accepting values 217

basic 217

control panel 218

displacement 218

force 218
automated configuration 23
automated system cabling 42

back panel 21
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balance, adjust valve 75
Box In (J51) 66
Box Out (J52) 67
bridge completion
1I/O carrier module 93

C

cable specifications
analog I/O 53
digital inputs 68
digital output 69
J25 HPU 59
J28 HSM solenoid 61
J29 E-stop 63
J29 E-stop input 63
J43 interlock 64
J49 auxiliary power 65
J54 system I/O 59
servovalve 48
cables
CE ECM compliant 40
fabrication 40
HPU connector 59
part number list 45
sensor 86
system 45
cabling
automated system 42
E-stop 63
front panel 52
low-frequency ground loops 40
rear panel
J25 HPU 59
J28 HSM solenoid 61
J29 E-stop 62
J43 Interlock 64
J43 interlock

J43 interlock connection 64

J49 auxiliary power 65
J54 System 1I/O 59
stand-alone system 41
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calibration
AC conditioners (displacement) 99
DC conditioners (force) 128
encoders 161
gain controls 135
hydraulics turn on 108, 132, 165, 171
LVDT 99
phase adjustment 110
shunt 89
shunt, performing 89
Temposonics sensors 167
using full-range conditioner 98
calibration file
resource assignment 164
CE EMC compliance
cabling 40
chassis
grounding 32
installation options 30
power connections 32
power description 33
CLC control 198
command sources 197
conditioner
polarity 73
configurations
AC power 34
connecting
electrical power 32
connection
workstation 56
connections
AC power 34
chassis ground 32
encoders 161
multiple controllers 43
System I/O module 58
control modes
characteristics 196
CLC 198
displacement 197
dual compensation 198
force 197
strain 197
controller
automated configuration 23
back panel 21
basic functions 22
front panel 20
handle kit install 36
interlocks 22
mounting requirements 24
multiple connections 43
plug-in modules 21
stand alone configuration 20
controller scope
tuning use 213
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D

d gain. see derivative gain
daughter boards 28
DC conditioners

calibration 128

checking polarity 133
DC sensor calibration

shunt calibration 89

shunt resistor table 90
delta P sensors, stabilizing with 204
derivative gain 202
digital inputs

cable specification 68

J54 Dig In connector 68
digital outputs

cable specification 69

J55 Dig Out connector 69
displacement

calibrate actuator retraction 114

mounting dial indicator 111

sensor calibration 99
displacement control 197
displacement tuning 215

auto tune 218

prerequisites 215

procedure 215

when to tune 215
dither

about 76

adjusting dither amplitude 76
dual compensation control 198

E

emergency stop
cable specifications 63
E-stop out connector (J29) 62
HPU transition connectors 62
encoder calibration
calibration file 164
connections 161
defining an input 161
setting resolution 164
setting zero 161, 165
signal monitoring 163
error signal 212
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extensometer calibration
adjust offset 177
calibrate compression 179
calibrate tension 178
gain/delta K 178
gain/linearization 180
recalibration 184
record data 179
shunt calibration reference 188

F

feed forward gain 203
force control 197
force sensor calibration
about 128
calibration types 128
check conditioner polarity 133
compression calibration 137
gain/delta K 135
gain/linearization 142
initial values 131
millivolt/volt 153
prerequisites 128
recording data 139
setting offset 134
setting zero 134
shunt cal reference 157
shunt calibration 160, 190
shunt resistor table 158
tension calibration 135
what you need 128
force tuning
auto tune 218
prerequisites 216
procedure 216
force/strain sensor
I/O carrier connection 85
forward loop filter 205
front panel 20
function generation 22
function generator
random 209

G

gain
derivative (d gain) 202
feed forward (F gain) 203
forward loop filter (FL filter) 205
integral (I gain) 201
proportional (P gain) 200
stabilization (S gain) 203
gain/linearization calibration 98
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grounding
low-frequency ground loops 40
grounding chassis 32

H

HPU 59
HPU connector (J25) 59
HPU transition board
E-stop cable specifications 63
E-STOP connectors 62
HPU cable specifications 59
HSM
proportional output 61
hydraulic pressure control 22

I gain. See integral gain
I/O carrier module
252 servovalve connection 49
256 servovalve connection 50
257 servovalve connection 51
accelerometer connection 55
analog 1/O cable specifications 53
analog I/O connection 52
analog 1/0O connections 52
analog inputs 52
bridge completion circuits 93
connecting force/strain sensor 85
connecting LVDT 84
D/A connection 53
daughter boards 28
J3 Service connector 57
servovalve connections 48
shunt calibration connector 92
initialize controller 235
innerloop
signals 79
tuning 77
installing
handle kit 36
plug-in modules 26
VMEbus modules 27
integral gain 201
interlock 64
interlocks 22

J

J29 E-stop 62

245



J49 auxiliary power connector 65
J51 Box In connections 66
J52 Box Out connections 67
J54 Digital Input connections 68
J55 Dig Out connection 69
jumpers

HPU converter 230

J25 HPU 59

J29 E-stop input 63

J43 interlock 64

J52 Box Out 67

rear panel 67

L

low-frequency ground loops
correcting noise problem 40
LVDT
/O carrier connection 84
LVDT calibration
about 99
actuator retraction 114
calibration types 99
check conditioner polarity 109
gain/delta K 114
gain/linearization 119
initial values 107
mounting dial indicator 111
pre-calibration tuning 100
prerequisites 99
setting offset 111
setting zero 111
signal monitoring 106, 130
what you need 99

monitor, innerloop signals 79
monitoring waveforms 211
areas of interest 211
error signal 212
using controller scope 213
using oscilloscope 214
multiple controllers
connecting 43
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0

offset, setting

displacement sensor 177

force sensor 134
LVDT 111
options

system software 24

oscilloscope
tuning use 214

P

passwords, setting 240

plug-in modules 21
installing 26

polarity
conditioner 73

displacement sensors 109, 133

force sensors 133

servovalve 73
power cabling 32
pressure control 22

proportional gain 200

proportional output

61

random functions 209

S

save

tuning parameters 193

sensor
cables 86
connections 83
signals 82,97
sensor cables
part numbers 87
specifications 86

with ID module 88
without ID module 87

sensor calibration
shunt calibration

89

shunt resistor table 90

service connections

J3 Service(I/O carrier) 57
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service tools 231
application 232
initializing controller 235
setting passwords 240
updating system options 237
servovalve
adjust valve balance 75
adjusting dither amplitude 76
cable specifications 48
dither 72
I/O carrier connection 48
polarity check 103
valve balance 72
warmup 74
setting passwords 240
shunt calibration 89, 157
I/O carrier connector 92
procedure 89
shunt resistor connector 92
shunt resistor installation 158
shunt resistor table 90
when to use 89
signal polarity 97
specifications
sensor cables 86
servovalve cable 48
specimens 210
changing 192
tuning with 210
tuning without 211
spool position
zeroing
zero spool position 78
square wave shape 208
stabilizing

with acceleration feedback 205

with delta P feedback 204
stand alone configuration 20
strain control 197
system cables

analog I/O 53

part number list 45
system cables/jumpers 45
system cabling

automated 42

stand-alone 41

System I/O module connections 58

system options, updating 237
system software 23

options 24
system warm-up 97

T

Temposonics calibration
setting resolution 170
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temposonics calibration
signal monitoring 169
Temposonics sensor calibration
calibration file 170
connections 167
defining an input 167
setting zero 172
Temposonics sensors 167
transducer cables
part numbers 87
specifications 86
transducer connections 83
tuning
about 192
auto tuning 217
checklist 194
compensation 192
control modes 196
control range adjust 199
controls 199
creating a program 207
displacement 215
force control modes 216
guidelines 193
innerloop 77
monitoring waveforms 211
pre-calibration, LVDT 100
prerequisites 195
proportional gain 200
selecting amplitude 209
selecting frequency 209
specimens
changing 192
tuning with 210
tuning without 211
waveforms 207
when to tune 194

vV

valve balance adjustment 75
valves

polarity check 103
VMEbus modules

descriptions 28

installing 27

W

waveforms 207, 211
areas of interest 211
error signal 212
monitoring 211
workstation connection 56
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V4

Zero, setting
displacement sensor 177
encoders 161, 165
force sensor 134
LVDT 111
Temposonics sensor 172
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